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Using This User Reference

This User Reference provides detailed information about Verifone's point-
ofsale (POS) devices on a function key-by-function key basis.

Each of the topics are divided into the following sections:

- Overview - This section contains a brief description about each
topic.

- Using - This section explains how the particular topic or
function is used to process and manage sales transactions.

- Configuring - This section contains information on how to
configure the relevant parameters using Configuration Client.

- Reporting - This section contains sample reports with a detailed
report description.

- Troubleshooting - This section may contain some trouble
scenarios that may occur along with the steps needed to
correct them. In some cases the user may need to perform
procedures that are restricted to higher security levels (i.e.
manager level as opposed to cashier).

Note: Refer to the Feature Reference Documents for additional
information on features. The Feature Reference documents are
available on Premier Portal.

Note: Change the default configuration settings in Configuration Client
only if you are sure you have to edit the settings.
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POS Workstations Overview

Verifone Point of Sale (POS) devices typically use either Sapphire or Commander Site
Controller as the server.

Commander Site Controller Platform

The Commander™ Site Controller is a high-powered server that increases the capacity
and functionality of Verifone’s ethernet capable Point of Sale (POS) workstations by
extending the processing and communications bandwidth for managing peripherals.

Future needs are designed into the hardware to provide support for additional serial
ports and CPU boards along with additional fan and/or power connection that may be
needed as a result. Use of these expansion capabilities will be determined by
Verifone. System peripherals, such as fuel dispensers, dispenser card readers (DCRs),
and car wash controllers connect directly to the Commander Site Controller.

In addition to Configuration Client, Commander also has other site management
software: Report Navigator, Transaction Manager and Commander Console. Report
Navigator is used to view reporting data for the store. Reporting information such as
the close day report can be configured to include a multitude of report options.
Transaction Manager allows for site transaction logs and data to be accessed from the
Commander or archived locally. Commander Console enables multiple store reporting
data to be consolidated into one place for easy visibility to monitor and track sales
trends.

Workstation

Workstation

Commander Site Controller and Workstations
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The Commander Site Controller contains a built in V950, referred to as the V950SC.

When a router is installed in this configuration, it can be configured so that the
Commander Site Controller’s V950SC can:

o Receive software upgrades remotely using Verifone’s Remote Software
Download feature.

« Connect with the Verifone Helpdesk for remote troubleshooting and
diagnostics.

Configuration Client
The Commander Site Controller can receive configuration changes through the use of
Configuration Client. Configuration client is a web-based utility that allows store
personnel, Verifone Authorized Service Contractors, and Verifone Helpdesk to modify
site information. To utilize Configuration Client you must be using a supported web
browser. The supported Web Browsers are:

e Chrome versions 60 or higher

o Firefox versions 53 or higher

e Internet Explorer versions 8 or higher

1. Key in the URL https://192.168.31.11/ConfigClient.html into the Web Browser
and press [Enter].

& Petroleun C-Stare Control Center Lk

& B 1921683111 | bttps:[1192,168.31.11/Cor | [El- palae |

Petroleum/C-Store Control Center

Please Log In
Uszer Marne
Password

Login

?’m.Verilfone_

2. Enter User Name and Password.

3. Click Login.


https://192.168.31.11/ConfigClient.html
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One-Time Password (OTP) Prompt

In Base 47 and higher, there is an additional prompt for a one-time password (OTP)
implemented into Configuration Client. As part of PCI/DSS v3.2 Requirement 8.3.1,
this incorporates a multi-factor authentication for all non-console access into the
Cardholder Data Environment (CDE) for personnel with administrative access.

Menus that have this prompt include:

Security > Manage Users (Includes Roles)
Initial Setup

Date & Time

Local Area Network Config

VHQ Configuration

Payment Controller > POS Configuration

EPS Configuration > EPS Global Configuration
Full Service Attendant Configuration

InComm Configuration

LINQ3 Lottery Configuration

Payware Fleet and Loyalty Configuration
PCATS Loyalty Configuration

Proprietary Fleet Configuration

Punch Card Loyalty Configuration

Network Configuration (network references the name of the network
installed, such as Buypass)

e Loyalty Card Configuration

While the preceding is the current list of functions that include the OTP prompt
within Configuration Client, it may be expanded to other areas in future releases.

One-Time Password

A One-Time Password (OTP) is required to access this function

One-Time Password [:] Generate OTP

Ok | Cancel

Guidelines to generate an OTP |

Clicking on Guidelines to generate an OTP (see image above) will display the
3 different ways to obtain the OTP.

One-Time Password Generation Guidelines

An OTP can be generated using one of the following methods, where applicable:

» Select ‘Generate Config OTP' from the Verifone Register's Maintenance Menu.

» Select ‘Generate Config OTP' from the EPS Network Functions, under the Verifone Register's Network Menu.

+ Select ‘Generate OTP' from the One-Time Password prompt. Enter the OTP presented on the Commander Site Controller's status display.
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The OTP is 4 digits in length. When generated using any of the 3 methods above, it
will appear on the 7- Segment status display of the site controller (displaying 2
numbers at a time; the period indicates the first set of numbers). If generated from
the POS/register, it will also display on the POS screen.

The OTP is directly tied to the user’s Configuration Client login session. If the OTP is
generated and correctly entered, the OTP will be active until the user logs out or the
Configuration Client session times out for inactivity (15 minutes). The OTP does not
require re-entry after it has been saved for the session, meaning the user can go
between menus that require entry, without being prompted.

Note: The OTP requirement applies to backing up and restoring files to the
site controller using SMS Import/Export. Files that require an OTP may not be
restored to the site controller, and an error message (“One Time Password
Required”) appears when attempting to do so. Clicking OK on the error prompt
allows the rest of the import or export to proceed. Clicking Abort aborts the
remainder of the import or export. In newer versions of SMS Import/Export,
items that require OTP are removed from the backup and restore list.

Topaz

The Verifone® Topaz™ XL workstation is a high-performance, reliable, point-of-sale
terminal that supports peripherals such as scanners, cash drawers, PINpads, and
customer displays. The Topaz utilizes the Commander Site Controller to connect to
payment networks, fuel dispensers, car wash controllers, and loyalty providers. The
Topaz has the ability to accept all payment options, including cash, checks, credit
and debit cards, coupons, and various prepaid cards.

The Topaz has a 15-inch color touchscreen display and 120-key programmable
keyboard. A virtual receipt is displayed on the screen to display transactions
information as items are being rung up. The configuration of the Topaz is handled
through Configuration Client. The Topaz also has a built-in help menu to aid with
sales transactions.
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Ruby2

Ruby2 is the latest POS solution offering from Verifone. It is equipped with a 15 inch
LED-backlit touch-screen interface and a multicore processor to allow fast and
efficient store and customer management. Ruby2 does not have a keyboard interface
which gives the site more counter space. The touch screen is made of hardened
tempered glass making the screen incredibly durable. It also provides full work
station access to store operations such as price changes, store updates and software
program management. The Ruby2 only works with the Commander or RubyCi site
controllers.

RubyCi

The RubyCi is Verifone’s all in one POS and site controller solution. It combines a
Ruby2 POS with the functionality of the Commander Site Controller in one piece of
hardware to provide fast, efficient, and complete store management. It enables users
to have the ability to consolidate as well as upgrade their POS equipment with one
piece of hardware.

The RubyCi can interface with additional POS terminals such as the Ruby2 or the
Topaz XL to expand sales operating capabilities.



POS Workstations Overview

C18

C18 is Verifone’s most powerful, integrated POS for convenience stores with
unsurpassed functionality and versatility. C18’s user interface is made for cashiers
serving customers who want a frictionless experience. The brilliant, high definition
screen is easy on the eyes. At an impressive 18.5 inches, there is abundant real estate
for all sales needs.



Configuration Client Screens

This topic contains all the Commander Site Controller Config Client forms.The
configuration forms in this topic are described in the menu order displayed on the
Commander Configuration Client.

G & nhttpsy//192.168.31.11/ConfigClient htm £ ~ & centficate ermor G| (& petroleum C-Store Control ..

Security Initial Setup  Store Operations ~ Promos and Discounts ~ Forecourt Devices Payment Controller  Reporting  Tools  Help  Log Out

Security

Manage Users

Configure Users

Use Security > Manage Users > Configure Users to add, edit, or remove users who
have access to Configuration Client. The current users are listed on the left side of

the form.

User Administration

pSer——
Add Delete
Salact User Mame |manager Disallow Login
[EETE - ... |
= [
Roles
Fassword Settings
Min. Length |7 |= New Password
Max. Length [40 'T Confirm Password
& of Days 1o Expire |90 |~
Forca change on naxt login Password Guidaline
Secure User Settings
Secure UserID 1 | Secure Usar Administration
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Add Click to add a new user.

Select an existing user and click Delete to remove the
Delete .

user from the Users list.
Name Enter the name of the user (number of characters are

unlimited).

Select to disallow the selected user to login to

Disallow Login Configuration Client.

Select an employee type from the Employee drop-
down list.

Employee
The employee type with the security level is created
using Security > POS Security > Employees form.

Roles are set up on the Configure Roles tab. The
Roles roles assigned to the selected user are displayed in
this box.

Click to display the available roles. Select one or

Edit more roles for the user and click Done.

Password Settings

Enter a minimum length for the user’s password (7 -

Min Length 30).

Enter a maximum length for the user’s password (8 -

Max Length 30).

Enter the number of days until the password expires.

# of Days to Expire Note: The password should be changed before it

expires.
Force Change on Next Select to make the user change their password the
Login next time they log in.
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Enter the user’s new password. The new password
New Password should meet the requirements of the password
guideline.

Confirm New Password Enter the password again to confirm.

Password Guidelines Click to display password guidelines.

Secure User Settings

‘Secure user’ is a user who can access PA-DSS sensitive Card Holder Data (CHD)
in ‘EPS Secure Reports’ from POS via the Network Manager’ menu. POS prompts
for secure employee ID and secure user password prior to processing this menu

item.

To avoid having to type username on POS keyboard, this feature allows
associating a POS employee ID to a user. When POS prompts, secure user has to
enter their ‘secure employee ID’ and the PA-DSS compliant ‘user’ password. On
successful validation, PA-DSS sensitive Card Holder Data (CHD) is exposed in the
EPS reports. If validation fails, masked PAN is provided in the EPS Reports.

Secure Admin is a ‘secure user’ who can manage ‘secure user’ as well as ‘secure
admin’ accounts.

Note: The 'Secure User Administration’ section is displayed when you log in as
‘manager’ (the default secure user admin account) or any user that is configured
as a secure admin.

Secure User ID Enter the Secure User ID.

Secure User

. . Enable if the user has secure user administration
Administration

rights.

Configure Roles

Use Security > Manage Users > Configure Roles to assign permissions, add new roles,
edit and delete current roles, and add and delete functions from each role. These
roles are assigned to users.

The current roles are listed on the left side of the form.
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Addition, removal, or modification of the roles can only be performed by a secure
administrator. The “Secure Role” attribute allows secure administrators to specify
whether a role's access should be limited only to secure users. If this attribute is set,
the role can only be assigned to a secure user.

Configure Roles
Add Delete
Select Role
- seueroe
storemanager Functions
manager ~ | Edit

areamanager
cashier
helpdesk

To Edit a Role
1. Select the role from the Roles list.
2. Click Edit at the Functions box.
3. Change the name in the Role Name text box.

4. To edit the function assignment to the role, enable or disable the functions in
the Functions form.

5. Click Done in the Functions form.
6. Click Save.
To Add Role and Add Functions to Role
1. Click New.
2. Enter the name in the Role Name text box.

3. Click Edit at the Functions box to assign functions to the role.

10
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4. Select the function(s) for the role from the Functions form.

5. Click Done in the Functions form.

6. Click Save.

To Delete a Role

1. Select the role from the Roles list.

2. Select Delete.
3. Click Save.

Role Function Description

The following is the list of role functions and their descriptions:

allowAllCsrRpts Allow all cashier reports Allow user to view all
view cashier reports that are
available
allowOpenCsrRpts Allow open cashier reports | Allow user to view open
view cashier reports (current
and/or reports with MOP
amounts not yet filled)
allowRestricted Allow Restricted Access
bypassEmployeeld Bypass employee id Bypass employee id
validation validation in POS security
functions
cbeginupgrade Request Auto Upgrade
Engine to begin upgrade
ccarwashdisable Disable Car Wash
ccarwashenable Enable Car Wash
cclosedaynow Close Day Now

11
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ccwpaypointinit Initialize Carwash
Paypoint

ccwpdclose Carwash Paypoint Period Performs Period Close On
Close Carwash Paypoint

cdcrdriverinit Initialize DCR Driver

cdcrinit Initialize DCR Initialize DCRs

cdisablelogin Disable Helpdesk Login

cenablelogin Enable Helpdesk Login

cfeatureenablement Update a feature Update Licensed Features

cFPDinit Init FP Display Config

cfueldrvinit Initialize Fuel Driver

cfuelinit Initialize Fuel

cfuelprices Download Fuel Prices

changepasswd Change Password

cping Pings a given destination.

crefreshcfg Refresh Configuration

crefreshepsconfig Refresh Eps Config

cswupgradepkg Update software

diagdeleteclass

Delete Diagnostic Class

Delete a previously loaded
dynamic diagnostic
classfile

diagloadclass

Load Diagnostic Class

Load a classfile to be run
as dynamic diagnostic

12
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diagrunclass

Run Diagnostic Class

Execute a dynamic
diagnostic class

findfilename

View report period
filename

updates

getPLUsFromGempro Send plu.dat to NEWPRO Send plu.dat from GEMPRO
to NEWPRO
notifyamber Notify amber alert Notify Controller of amber

alert updates

releaseCredential

Release the credential

repeatEvent Repeat last event Notify specified event
listener of the last
occurrence of the
specified event

sendPLUsToGempro Send plu.dat to GEMPRO Send plu.dat from

NEWPRO to GEMPRO

uagevalidationcfg

Update age validation
config

ubannercfg Update banner config
ubluelawcfg Update blue law config
ucarwashcfg Update carwash config

ucashaccsite

Update cash acceptor
config

ucashierenddraweramts

Update Cashier End
Drawer Amounts

ucashierreportreviewstatus

Update Cashier Report
Review Status

13
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ucashiertrackingcfg Update cashier tracking
configuration
ucouponfamcfg Update coupon family
config
ucurrencycfg Update currency config Update currency dataset
config
ucwpaypointcfg Update carwash paypoint
config
udatetime Set Time and Date Set the internal clock on
Controller, including
timezone and daylight
savings time paramters
udcrheadercfg Update DCR header config
udcridlescreencfg Update DCR Idle Screen Update DCR Idle Screen
config dataset config
udcrmessagecfg Update DCR message
config
udcrtrailercfg Update DCR trailer config
udiscountdenomcfg Update discount denom
config
uecheckcfg Update Echeck Config
uemvcfg Update EMV Configuration | Update All EMV
Configuration Settings
uemvinit Update EMV Initialization | Update All EMV
Initialization Settings
uepsprepaidcfg Update EPS Prepaid Card

Config

14
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uesafecfg Update Esafe Config
ufeecfg Update fee config Update fee dataset config
ufepcardcfg Update Fep's card Update Fep's card
configuration parameters | configuration parameters
like various limits,
enable/disable card
ufepcardtypecfg Update Fep's card Update Fep's card
configuration parameters | configuration parameters
based on card Type based on card Type like
limits, enable/Disbale etc.
ufepcfg Update Fep's configuration | Update Fep's configuration
parameters parameters like network,
cashback etc
ufoodservicecfg Update Food Service
Config
uFPDcfg Update FP Display Config
ufuelcfg Update Fuel Site Update the fueling
Configuration dispensers, products,
mops, tanks, and prices
for the site
ufuelprices Update Fuel Prices Update the fueling prices
for the site
ufueltaxex Update Fuel Tax
Exemption Config
ufunctionlist Refresh function list
ugrouplist Update Group List Update available report
Configuration groups
uifsfcfg Update IFSF Network
Config

15
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uinhouseacctcfg Update in-house account Update in-house account
config dataset config

ukioskorder Commit kiosk order

ulogocfg Update logo config Update logo dataset config

uloyaltycardcfg

Update Loyalty Card
Configuration

uloyaltycardtypecfg

Update Loyalty Card Type
Configuration

uloyaltyglobalcfg

Update Global Loyalty
parameters

uMaintenance

Update NAXML
maintenance dataset

Update configuration
datasets as NAXML
maintenance documents

umaintfprht

Update maint fprht

umaintpostal

Update maint postal

umaintregistrationkey

Update maint registration
key

umainttelephone

Update maint telephone

umainttotalizers

Update maint totalizers

umanagedcfg

Update Managed
Configuration

umanagedmodulecfg

Update Configuration

Update Module
Configuration

umanageradjustment

Update Manager
Adjustments

16
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umanagercorrection Update Manager
Corrections
umenucfg Update menu config Update menu dataset
config
umobilecfg Update Mobile
Configuration
umopcfg Update MOP config Update MOP dataset config

umwscashmovementreport

Update MWS Cash
Movement Info

unetposcfg Update Network Update POS related
Configuration Network Configuration

unetworkcfg Update Network Settings Update Network
Settings(IP, route, etc..)

unetworkpartcfg Update network settings

upaymentcfg Update payment config Update payment dataset
config

upinpadmsgcfg Update Pinpad Idle and

Swipe messages

uPLUCachelist

Update PLU cache list

Update the list of PLUs
cached on POS

uplupromocfg

Update PLU Promo config

Update PLU Promo dataset
config

uPLUs Update PLU dataset
upolicycfg Update policy config
upopcfg Update pop config
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Configuration

uposcfg Update POS config Update POS dataset config
upospaymentconfig Update POS Payment
Configuration
upossecurity Update POS security Update POS security
config dataset config
uprepaidcfg Update Prepaid Card
Config
upscdcrcfg Update DCR config Update DCR dataset config
upscdcrkeycfg Update DCR Key config Update DCR Key dataset
config
uregistercfg Update register config Update register specific
dataset config
ureportcfg Update Report

ureportlist

Update Report List
Configuration

Update the order of
available reports

Configuration

ureportstatus Update Manager Review
Status
urestrictionscfg Update restriction config | Update restriction dataset
config
usalescfg Update sales config
usapphireprop Update Controller system
properties
uscreencfg Update POS Screen

usecuritylogservercfg

Update Security Log
Server IP Address
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uslogancfg Update slogan config Update slogan dataset
config
usoftkeycfg Update softkey config Update softkey dataset
config
utaxratecfg Update tax rate config Update tax rate dataset
config
utlssite Update TLS config
utriggerpullcfg Update Trigger Pull Update All Trigger Pull
Configuration Configuration Settings
uuseradmin User Administration User admin update
uvendingmachinecfg Update Vending Machine Update Vending Machine
config dataset config
uvipercfg Update Viper's site level Update Viper's site level
Config Config like various limits,
and pop configuration
vagevalidationcfg View age validation config
validate Validate the credential
vappcfg View App Specific Config
vAppinfo View App Info View App Version Info
vappmodules View App Module Names View the list of Application
noted module names.
vbannercfg View banner config
vbluelawcfg View blue law config
vcarwashcfg View carwash config
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vcashaccsite View cash acceptor config
vcashierpdlist View cashier report period | View list of cashier report
list periods available
vcashierrept Cashier Reports View the cashier period
reports
vcashiertrackingcfg View cashier tracking
configuration
vcashiertrackingrept View cashier tracking
report
vcouponfamcfg View coupon family config
vecurrencycfg View currency config View currency dataset
config
vcwpaypointcfg View carwash paypoint
config
vcwpaypointpdlist View cw paypoint period View list of cw paypoint
list periods available
vcwpaypointpdrept View cw paypoint period
report
vdatetime Get Time and Date View the Controller
internal time
vdcrheadercfg View DCR header config
vdcridlescreencfg View DCR Idle Screen View DCR Idle Screen
config dataset config
vdcrmessagecfg View DCR message config
vdcrtrailercfg View DCR trailer config
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vdiscountdenomcfg View discount denom
config
vecheckcfg View Echeck Config
vemvcfg View EMV Configuration View All EMV Configuration
Settings
vemvinit View EMV Initialization View All EMV Initialization
Settings
vepsprepaidcfg View EPS Prepaid Card
Config
vepssiteassetdata View Site Asset Data of
EPS
vesafecashierrept ESafe Cashier Reports View the cashier period
reports
vesafecfg View Esafe Config
veventset Register event listener Register {alias, url} pair as
event listener for a
specific event type
veventunset Unregister event listener | Unregister the specified
event listener for a
specific event type
vfeaturelist View feature list View list of installed
features
vfeecfg View fee config View fee dataset config
vfepcardcfg View Fep's card View Fep's card
configuration parameters | configuration parameters
like various limits,
enable/disable card
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vfepcardtypecfg View Fep's card View Fep's card
configuration parameters | configuration parameters
based on card Type based on card Type like
limits, enable/Disbale etc
vfepcfg View Fep's configuration View Fep's configuration
parameters parameters like network,
cashback etc
vfepdetails View Basic Fep Details View Basic Fep Details like
the available commands,
enabled, is primary etc
vfoodservicecfg View Food Service Config
vFPDcfg View FP Display Config
vfuelcfg Update Fuel Site Update the fueling
Configuration dispensers, products,
mops, tanks, and prices
for the site
vfuelposstat View fueling position
status
vfuelprices View In-effect Fuel Prices | View the in-effect fueling
prices for the site
vfuelrtcfg In-effect Fuel Site View the in-efectfueling
Configuration dispensers, products,
mops, tanks, and prices
for the site
vfuelrtprices View In-effect Fuel Prices | View the in-effect fueling
prices for the site
vfueltaxex View Fuel Tax Exemption
Config
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vfueltotals Fuel Totals Report View the electronic
dispenser report for a
given period
vfueltotalsz Compressed Fuel Totals View the electronic
Report dispenser report for a
given period (gzip)
vgrouplist View Group List Review available report
Configuration groups
vifsfcfg View IFSF Network Config
vinhouseacctcfg View in-house account View in-house account
config dataset config
vlogocfg View logo config View logo dataset config
vloyaltycardcfg View Loyalty Card
Configuration
vloyaltycardtypecfg View Loyalty Card Type
Configuration
vloyaltyglobalcfg View Global Loyalty
parameters
vMaintenance View NAXML maintenance | View configuration
datasets datasets as NAXML
maintenance documents
vmaintfprht View maint fueling point
running hose totals
vmaintpostal View maint postal code
vmaintregistration View maint registration
vmainttelephone View maint telephone
number
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vmainttotalizers

View maint totalizers

vmanagedcfgstatus

View Managed Update
Status

vmanagedmodulecfg

View Configuration

View Current Module
Configurations

vmenucfg

View menu config

View menu dataset config

vmobilecfg

View Mobile Configuration

vmobilehostlist

View Hosts List

View Mobile Hosts List

vmobilereport

View Mobile Report

vmobilereportlist

View Reports List

View Mobile Reports List

Configuration

vmoddescmap View Module/Descriptions | View mapping of module
map names to their
descriptions.
vmodulecfg View a Module View Configuration of a

given named module.

vmodulecfgref

View Module Referentials

vmopcfg

View MOP config

View MOP dataset config

vMovement

View NAXML movement
reports

View reports as NAXML
movement documents

vmwscashierdraweramts

View Cashier Drawer
Amounts

vmwscashmovementreport

View MWS Cash Movement
Report

vmwslog

Manager workstation
event logs

Report to indicate Manager
workstation event logs
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vmwsposjournal View manager work View manager workstation
station event in related posjournal reports
POSJournal reports
vnetposcfg View Network View POS related Network
Configuration Configuration
vnetworkcfg View Network Settings View Network Settings(IP,
route, etc..)
vnetworkmenu View Network Menu xml
vpaymentcfg View payment config View payment dataset
config
vpayrollpdlist View Ruby payroll period | View list of Ruby payroll
list periods available
vpayrollpdlist2 View payroll period list View list of payroll periods
available
vpayrollrept Payroll Reports View the payroll period
reports
vpayrollrept2 Payroll Reports (new View the payroll period
format) reports (new format)
vpendmdlcfg View Pending
Configurations
vperiodlist View period list View list of periods for
which reports are
available
vpinpadmsgcfg View Pinpad Idle and
Swipe messages
vPLUCachelList View PLU cache list View the list of PLUs

cached on POS
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vplupromocfg

View PLU Promo config

View PLU Promo dataset
config

VvPLUs View PLU dataset
vPLUUpdateStatus View PLU Update status View PLU Update status
info
vpolicycfg View policy config
vpopcfg View pop config
vposcfg View POS config View POS dataset config
vposjournal View NAXML POSJournal
reports
vpospaymentconfig View POS Payment
Configuration
vpossecurity View POS security config View POS security dataset
config
vprepaidcfg View Prepaid Card Config

vproprietarynetworkmenu

View Proprietary Network
Menu xml

vpscdcrcfg View DCR config View DCR dataset config

vpscdcrkeycfg View DCR Key config View DCR Key dataset
config

vpsinfo View process table - Text | View process table and
thread specific process
table - Text

vrefinteg View support doc View referential integrity

support document
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vregistercfg View register config View register specific
dataset config
vreportcfg View Report Configuration
vreportlist View Report List Review the available
Configuration reports
vreportpdlist View report period list View list of report periods
available
vreportstatus View Manager Review
Status
vrestrictionscfg View restriction config View restriction dataset
config
vrubyrept Ruby Reports View the processed reports
for the site organized by
period
vsalescfg View sales config
vsalesnetworkmenu View Sales Network Menu
xml
vsapphireprop View Controller system
properties
vscreencfg View POS Screen

Configuration

vsecuritylogservercfg

View Current Security Log
Server IP Address

vsiteassetdata View Site Asset Data
vslogancfg View slogan config View slogan dataset config
vsoftkeycfg View softkey config View softkey dataset

config
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vsyslog View system log - Text View system log (syslogd)-
Text
vsysresourcesmap View System Resource
Mappings
vtaxratecfg View tax rate config View tax rate dataset
config
vthemecfg View Screen Themes
vtilleventreport View Till Event Reports
vtlogpdlist View T-Log period list View list of periods for
which reports are
available
vtlssite View TLS config
vtransset Period Reports with fully Review reports for the site
masked card holder data - fully masked card holder
data
vtranssetz Compressed Period Review reports for the site
Reports with fully masked | (gzip) - fully masked card
card holder data holder data
vtriggerpullcfg View Trigger Pull View All Trigger Pull
Configuration Configuration Settings
vupgradesummary View Upgrade Summary
Report
vuseradmin View User configuration User admin view
vvendingmachinecfg View Vending Machine View Vending Machine
config dataset config
vvipercfg View Viper's site level View Viper's site level

Config

Config like various limits,
and pop configuration
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vviperpdlist Allow Viper period list View available periods on
view Viper
vviperrept Viper reports View network reports from
Viper

Manage Devices

The Manage Devices form is used to add and enable external POS devices like the
Attendant Payment Terminal and Carbon Commander Workstation.

Note: Refer to the Attendant Payment Terminal and Carbon Commander
Workstation Feature References for more information on this feature. The
Feature References are available on Premier Portal.

Manage Devices

@ Edits require a one-time password (OTP)

6 Guidelines to generate a toker

L Eins ‘ Name l Application Type \ Description 1P Address ‘ Port ‘ Status Joken ‘ Enable ‘ Serial Number
151 ccwt  [Carbon Commander Workstation| v cew 1921689111 1234 Registration failed - 77
152 APT ‘Attendant Payment Terminal APT 1921689112 1234 Not registered I~}
153 APT Attendant Payment Terminal | APT 1921689113 1234 Not registered 77
M4 130f3 > ¥
|Add | | Delete |
Aclicking on delete will delete all the configurations related to selected Terminal ID

1. In Commander Config Client, go to Security > Manage Devices.

2. Click on Guidelines to generate a token, to read the guidelines.

+On Cikcking "AK buthon, User 5ees 3 row

+ Laar pei 10 18 I ‘Teominal 10, Applcaticn Type', ' Adaresy’ and ‘Port’
« Click on Save buttcn

+ Onos save & mcomsstul

6 2. Uger a0 508 3 ‘CANnarane’ Buttod in “Token ACtion’ coumn of th fom
B, Uzer wil not bo akowed to modify the Terminal 1D of the zaved ontry

* On cicking ‘Ganeraly’ Bumon, tokan (% sunl 1o the devics which i configured

+ Device 15 eXPOCted 10 SCCOP! tha 10KEN aNa SeNnd the JEVIee Getailts K Senal AUMDAr, MO, version, ¢tc., 10 Commander

«Wiman , *Saral number’ and ‘Stati” colamn wil e updated on the ContigCllent form
 ON0E LNGN GUNGIABON B SUSCRIANIL, USGr Wil 01 D IWwed 10 MOARY e ASSHCalion Typa' of the Gavics antry

o]

3. Click Add to start adding the terminals.
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M a n age . Dew ces ............................................................................................................................................................

g Edits require a one-time password (OTF)

“rjuidelil:es 1o generale 8 loken
Tesminal — - p " Taken -
D Application Typs Description 1P Address Part Status Actian Emable  Serial Number
I 2=

1 ddgil r ¥

Add  Dolete

L ! BCICHIIQ o delete will delele all conliguralion fai the application

4. Enter the external POS ID in the Terminal ID field. The ID should be between
151 and 199. Each application type should have a unique ID. This terminal ID
should be entered as the POS ID for the terminal while configuring the
terminal from Devices > Attendant Payment Terminal > Terminal.

5. Select the application type from Application Type drop-down.

6. Add a description for the terminal to help identify the terminal.

7. Get the IP address and port for the terminal from the IT team.

8. Select Enable to enable the device.

9. Click Save. A one-time password (OTP) is required to save the configuration.

10.Click Generate OTP and enter the OTP generated on the Commander Site
Controller display.

Manage Devices
@) Eits requive 3 one-time password (OTP)

z D Application Type Descripton P Asdress Port Status T Enabide Sertal Namber

1 [.Nlﬁrdanl Paymant Terminal I~ APT 1 192168317 1254 Not registerad Generate

11001
Add Delete

A \ Clicking on delete will delete a1 the configurations retated to seected Temina! 10f

11. After save is successful,
a. User can see a ‘Generate’ button in ‘Token Action’ column of the form.
b. User will not be allowed to modify the ‘Terminal ID’ of the saved entry.

12. On clicking ‘Generate’ button, token is sent to the corresponding device that
is configured from Devices > Attendant Payment Terminal > Terminal.
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13.APT device is expected to accept the token and send the details like serial
number, model, version, etc. to Commander Site Controller.

14.When the Commander Site Controller receives a response from the device,
‘Serial number’ and ‘Status’ columns are updated on the Config Client form

15.0nce token generation is successful, user will not be allowed to modify the
‘Application Type’ of the device entry

POS Security

Employees

Use to edit, add, and delete employee records. In addition to logging in and out of
the register, this employee information is used for the Payroll Report, Summary by

Register Report, and Summary by Cashier Report. The current employees are listed on
the left side of the form.

POS Security Manager

Cpelete

01 - CORPORATE -~ Name |CORPORATE
03 - ASST MGR mployee Number

04 - GASHIER Security Level

8; Can Cashier

Assign a name for each employee. An employee
cannot clock in or out without having a name
Name assigned.

Alphanumeric, 1 - 30 characters.
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Assign a unique employee number, such as a social
security number or company assigned ID, to identify
the employee for internal and payroll purposes.
Alphanumeric, 1 - 15 characters.

Employee Number The Employee Number is used for security validation
when a cashier does not have a high enough security
level to complete a function such as applying a
discount.

Select the employee’s security level. The employee
has access to all functions that have a security level

Security Level less than or equal to the security level assigned.

Select to allow the employee to perform cashier
Can Cashier functions when in Sales mode.

Enter the password that the employee must use to
New Password clock in or out. Alphanumeric, 1 - 8 characters.

Confirm New Password Enter the password again to confirm.

Delete Select to delete the selected employee information.

Security Ctrls
Use to assign a security level to submenu items in the list. The Items in the list are

non-sales functions. These security levels correspond to the Security levels assigned
to each employee. Only the entries in the Security Level column can be changed.
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POS Security Manager

Mﬁ;]u :::u Description Sf::::]’
1D

o wx  DSYCECONTOLAMWST

FSH ACR AUTOCOLLECT REPORT
FSH BPR BLEND PRODUCT REPORT
FSH CAR CASH ACCEPTOR REPORT
FSH CTR CATEGORY REPORT
FSH CVR CONVERSION REPORT
FSH CWR CAR WASH REPORT
FSH DLR DEAL REPORT

— v
4« 4 1500f122 » M

Select a security level from the drop-down list.
Sales Functions Security
Use to assign a security level to the following sales functions in the list:
e Apply Updates (MUP)
e Safe Drop Correction (SDC)
e Refund (REF)
e Void Ticket (VTI)
e Void Line (VLI)
e Price Override (POR)
e Discount (MDC)
e Suspend (SUS)
e No Sale (NSA)
e Payout (POU)
e Error Correct

Only employees with the assigned security level can perform these functions.
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Sales Functions Security

E———

Sales Function Security Level
Apply Updates (MUP)
Discount (MDC)

Error Correct (ECR)

No Sale (NSA)

Pay Out (POU)

Price Override (POR)
Refund (REF)

SUSPEND (SUS)

Safe Drop Correction (SDC)

Void Line (VLI)

ol [o] [o] [e] [e] [e] [~] [e] [e] [e] [«
< < < < < < < < < < <

Void Ticket (VTI)

Configuration Client Screens

When the user clicks a security level and Apply All is selected, the value is applied to

all the sales functions.

The user can also configure any of the functions independently. Default value for
Payout is 7 and Default value for Apply Updates is 7. Default value for all the other
functions is 0, 0 indicates that the function does not require a security check and any
employee can perform the function.

Security Log Server

SECURITY INFO REQUIRED

User ID

Password

EEEE

ABC /

SHIFT Clear

CREAE
g

]
A
§I

Syslog is a way for network devices to send event messages to a logging server -
usually known as a Syslog server. The Syslog protocol is supported by a wide range of
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devices and can be used to log different types of events. For example, a router might
send messages about users logging on to console sessions or a web-server might log
access-denied events.

This form is used to report security and OS related events to the configured server.
Enter the log server’s IP address in this form.

A one-time password (OTP) is required to open and edit this form. Click Generate OTP
and enter the OTP generated on the Commander Site Controller display to the One-
Time Password form.

Security Log Server

ﬁ Edits require a one-time password (OTP)

Server 1: .. Clear
Server 2: lj”j“j“jl Clear
Server 3 Ij”j“j“jl Clear
Server 4: lj”j“j“jl Clear

The following is how the security logs appear on the server display:

Date Time Priority Hostname Message

D7-08-2019 16:17:54 SpstemWaming  192.168.31.11 1 2019-07-09T 06:45:52.920-04:00 commander_a COR - - -

P7-09-2019 16:17-54 System Warning 192.168.31.11 1 2019-07-09T 06:45:52 920-04:00 commander_a COR - - - WARN securil ity - USER: manager, SEC EMP ID# 1 - View Cunent Security Log Server 1P Address - PASSED - SECURITY LOG SERVER
CONFIGURATION - Register ID# 0

D7-09-2019 16:17:54 Systeml Waming  192.168.31.11 1 2019-07-09T 06:45-52 908-04:00 commander_a COR - -

p7-09-2019 16:17:54 System( Warning 1921683111 1 2019-07-09T 06:45:52 908-04:00 commander_a COR - - - WARN securil ity - USER: manager. SEC EMP IDB 1 - vsecuril itylogserverc :fg - PASSED - HTTP REQUEST - Register ID# 0 - REMOTE
1PH192.168.31.208 -

D7-08-2019 16:17:54 SpstemWaming  192.168.31.11 1 2019-07-09T 06:45:52.905-04:00 commander_a COR - - -

D7-092019 16:17:54 Systemd Waming  192.168.31.11 1 2019-07-09T 06:45:52 905-04:00 commander_a COR - - - WARN securit ty - USER: manager. SEC EMP ID# 1 - 0TP_Authentication - PASSED - UserAAA - Register IDE 0 - Application 0TP
authenticated - tiue

D7-09-2019 16:17:44 Systeml Waming  192.168.31.11 1 2019-07-09T06:45-42 961-04-00 commander_a COR -

D7-09-2019 16:17:44 System Waming  192.168.31.11 1 2019-07-09T 06:45:42.961-04:00 commander_a COR - - - WARN securi ty - cfdcposrequest - PASSED - HTTP REQUEST - Register IDH 0 - REMOTE IPH 192.168.31.101 -

D7-03-2019 16:16:45 Systemd Waming  192.168.31.11 1 2019-07-09T06:44:43.889-04:00 commander_a COR - - -

D7-03-2019 16:16:45 Systemd Waming  192.168.31.11 1 2019-07-09T05:44:43.889-04:00 commander_a COR - - - WARN  security - vsecuritylogserverclq - FAILED - HTTP REQUEST - Register IDH 0 - REMOTE IP# 152.168.31.208 - One Time
Passwor d required

D7-03-2019 16:16:45 Systemd Waming  192.168.31.11 1 2019-07-09T 06: 44:43 873-D4:00 commander_a COR - - -

D7-09-2019 16:16:45 SystemdWaming  192.168.31.11 1 2019-07-09T 06:44:43.873-04:00 commander_a COR - - - WARN security - USER: manager. SEC EMP IDE 1 - 0TP_Authentication - FAILED - UserAAA - Register ID8 0 - Application OTP
authenticated - false

P7-03-2019 16:14:41 Systemd Waming  192.168.31.11 1 2019-07-09T06:42:39.930-04:00 commander_a COR - - -

D7-03-2019 16:14:41 Systemd Waming  192.168.31.11 1 2015-07-097T05:42:39.930-04:00 commander_a COR - - - WARN  security - USER: manager, SEC EMP IDH 1 - viepdetails - PASSED - HTTP REQUEST - Register ID# 0 - REMOTE IP#
192.168.31.208 -

D7-09-2019 16:14:41 System Waming  192.168.31.11 1 2019-07-09T06:42:39.547-04:00 commander_a COR - - -

D7-09-2019 16:14:41 Systemd Waming  192.168.31.11 1 2019-07-09T 06:42:39.547-04:00 commander_a COR - - - WARN  security - vAppinfo - PASSED - HTTP REQUEST - Register ID3 0 - REMOTE P 192.168.31.208 -

My Profile

Using this menu, a Config Client user can reset their own password without calling the
Helpdesk. The primary benefit of this feature is to reduce the number of calls
generated to the Helpdesk.

Security Initial Setup  Store Operation My Profile

Manage Users

FOS Security
Change Password

Site Security

My Profile Setup Challenge Questions
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Adding or Modifying Challenge Questions

For the config client users to reset their own password, a set of challenge questions
and answers should be added. The questions are chosen from a drop-down list.
Challenge Question

To change your challenge questions, select a question from each dropdown and provide a response.
All dropdaowns must have a selection
— Question 1

‘ ‘What was your childhood nickname?

‘Emsr your answer here

\
—Question

‘ What is your grandmother's first name?

‘Entar your answer here

—Question 3

‘ ‘What was the last name of your favorite elementary school teacher?
‘Emer your answer here

—Question 4

| ‘What is the last name of your first boss?

‘Emer your answer here

Save  Cancel

Configuration Manager

6 Challenge guestions have been set successfully

Ok

If users do not setup the challenge questions, every time they login to Config Client,
they get the following reminder:

Configuration Manager

6 Challenge questions have not been setup for this account.
Would you like to set these up now?

Change Password

After logging in, a user can change password using the Change Password menu that
can be assessed from Security > My Profile.
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My Profile

Change Password

Setup Challenge Questions

Change Password

Change Password

User Name Imanager

Original Password || ‘

New Password | ‘

Confirm Password | ‘

Password Guidelines Ok Cancel

Forgot Password

“Forgot Password” link on login page of Config Client or Manager Workstation displays
a prompt where user must enter the username and click Submit to start the process of
resetting password.

Submit | | Cancel

If the user doesn’t already have challenge questions set or if the username doesn’t
exist, the server shows an error.

Manager Workstation

Sorry, invalid data. Please contact support for assistance

Ck

If the challenge questions are set, any two of the questions are shown for the user to
answer.
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Reset Password Request

In what city or town did you meat your first spouse/partner?
What was the name of your elementary schoal?

(s o

On answering the questions right, the user is prompted to enter a new password.

Change Password
Change Password

Configuration Manager

6 Password has been changed successfully

Initial Setup

Date Time

The Date & Time Configuration form is used to verify or edit the date, time, and time

zone on the Commander Site Controller.
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Date Time
Time Zone
Date
(3MT -05:00) US/Eastern =
« 2012 May » . >
w7 Retrieved Date Setfings
" 2 3 4 & Time Zone (GMT -05:00) US/Eastern
E T B8 & 1 11 12 Date 2012-05-07

13 14 15 16 17 18 19 UEE 12:67-03

W M 2P I M OIS Changes
27 28 7@ 3 M
Tirrul Zowvik

Dale
05 [=l[o7 [=][2012[+] Time

Time NTF Server

-12 - -5? [=] ||33 - Lsa NTP Sarver
NTP Server IP

Select the date, month and year from the drop-down list boxes.

The displayed time is the current time. To change the time, select the time from the
drop-down list boxes.

Time Zone

Use to select the time zone in which your site is located.

NTP Server

Enable to get the time from the Network Time Protocol (NTP) server instead of the
system clock. This section can be used to configure the IP address of the NTP server.
Registration

The Registration form presents information that must be supplied to the Verifone
Technical Support Center in order to obtain a Registration Key.

Call the Verifone Technical Support Center at (888) 777-3536. The Support Center will
process the registration while you are on the phone.

Note: Registration is only done once, at the time of installation.
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Maintenance - Registration

Registration Info

REGISTRATICN INFORMATION LISTING

Registration Status: NOT REGISTERED

(REF#)

(2586)

Registration Key

Print Registration Info

Registration

Enter the Registration Key supplied by the Verifone Technical Support Center.

View Feature Info

The Feature Information form displays the options installed on the system. To view
the entire list, select the last item and press the down arrow on your keyboard. Click
Print to print the entire list.

Feature Information

Feature Info

Feature : Car Wash
status * Installed
Version * v1300(0010)
Expiration :

Start Enable :

Feature : Fast Food
Status I Installed
Version : v1300(0020)
Expiration :

Start Enable :

Maintenance Configuration

Refer to Maintenance Configuration

System Properties

Use to select, update, and save System Properties.

Detailed descriptions of the system properties can be found in the respective

feature’s feature refe

rence manuals.
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System Properties

System Property allow.concument.scanner = 'yes' e
— DailyMsg.pell.interval = 0’
Name | Dailylsg serer (P | DallyMsg.scroll.intanval = 5
Value [192.168.31.1 | DailyMsg.server.IP = "192.168.31.1'

DailyMsg.server Port = ‘80207
DallyMsg sarver URL = Ymotd. e’
data.trans hst.days = 90’

database. plu.isgempromaster = ‘aule’
dvr.lecallPPort = 14000
dvr.multicastEnable = true'
dvr.multicastHost = '230.0.0.1
dvr.multicastPon = 4001

dvr.ttl =1

esafe. coin_denomination = '50.01,%0.05,50.10,%
esafe_note_denomination = 51,82 85 610,520, 8¢
esafe.retryAltempts = 4

esafe retrylnterval milliseconds = 500"
esafe socketTimeout seconds = 1200
extPOS. config depis = ™

fugl max, curr limit = ‘290558
fuelsys.tankmaonitor.tankcapacity = no’
include. cinit_activation.criteria = ‘yes’
jeurnalPrinter. enabled = ng’
journalPrinter.port = Ydewportd’
kp.svec.list ==

kp.sve.POS . CommiD = 0"
kp.sve. POS host = ‘NONE'

Inmakn dofanit — e 1S

System Property
Displays the property name.
Name
Value Displays the property value.
Save Click to save the selected Properties.

System Properties Description

The following is the list of system properties and their descriptions:

allow.concurrent.scanner Allows two scanners to work
apply.upgrade.forcefully Opt-in for forced auto-upgrade
auto.print.Pd.report Auto print reports
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Properties that control the daily message display

DailyMsg.poll.interval

The interval in which the system checks for daily
messages.

DailyMsg.scroll.interval

The interval the message pauses before adding
another line when the window must be scrolled
to display all messages.

DailyMsg.server.IP

IP address of server hosting daily message text.

DailyMsg.server.Port

IP port to use on the server hosting daily
message text.

DailyMsg.server.URL

URL to reach the daily message text files

data.trans.hst.days

Number of days to keep t-log

database.plu.isgempromaster

Ruby sales configuration

disable.pinpad.cardreader

Disable PIN pad card reader between
transactions.

Portal.

DVR UDP Multicast properties

Note: Refer to the Digital Video Recorder Feature Reference documentation for
more information on this feature. The Feature Reference is available on Premier

dvr.locallPPort

DVR local port

dvr.multicastEnable

Enable multicast

dvr.multicastHost

DVR multicast host

dvr.multicastPort

DVR multicast port

dvr.ttl
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eps.needs.immediate.declined.re
ceipt

EPS Needs Immediate Declined Receipt (Options
= yes,no)

available on Premier Portal.

E-Safe Properties

Note: Refer to the Tidel Sentinel E-Safe Interface Feature Reference
documentation for more information on this feature. The Feature Reference is

esafe.coin_denomination

E-Safe - Coin Denominations

esafe.note_denomination

E-Safe - Note Denominations

esafe.retryAttempts

E-Safe connection retry attempts

esafe.retrylnterval.milliseconds

E-Safe connection retry interval in milliseconds.

esafe.socketTimeout.seconds

E-Safe - Socket timeout in seconds

event.monitor.history.limit

How much event monitor history data is shown

extPOS.config.depts

External POS properties

fcc.dcrs.test

Test Gilbarco DCRs comma delimited

force.InHouse.PaylnOut

Force In_House for Pay IN and pay OUT

fuel.max.curr.limit

Set limit for the maximum currency at pump

fuelsys.tankmonitor.tankcapacity

Enable Fuel Tank Monitoring

include.cinit.activation.criteria

Show Auto Upgrade notification

journalPrinter.enabled

Enable journal printer

journalPrinter.port

Journal printer port
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Kitchen Printer Configuration

Note: Refer to the Kitchen Printer Feature Reference documentation for more
information on this feature. The Feature Reference is available on Premier
Portal.

kp.svc.list Kitchen printer service list

kp.svc.POS use the exact text

kp.svc.POS.CommiID Indicates which COM port of the POS terminal
the kitchen printer is on.

kp.svc.POS.host Indicates which POS terminal the printer is on.

loyalty.ppg.stack Enable Loyalty PPG stacking

mobile.feature.enabled Enable Mobile Feature

Note: Refer to the Mobile Payment Feature
Reference documentation for more
information on this feature. The Feature
Reference is available on Premier Portal.

Money Order Prompt

Note: Refer to the Money Order Feature Reference documentation for more
information on this feature. The Feature Reference is available on Premier
Portal.

mopayee.prompt Money order prompt

mopayee.swb

moptr.maxVendorPayment Maximum amount for Money Order Vendor
Payment.
mws.response.time Manager Work Station Response Time
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naxml.config.pluHasCheckDigit

NAXML input processing

Note: Refer to the VIP NAXML Mix & Match
Feature Reference documentation for more
information on this feature. The Feature
Reference is available on Premier Portal.

pdclose.forcelogout.time.inMins

AEOQOD force logout warning time in minutes

promotions.enableNaxmiDeal

Enable Naxml promotions.

receipt.enterprise.footer.alignme
nt

Receipt Footer Alignment (Options - LEFT,
RIGHT, CENTER)

receipt.enterprise.header.alighm
ent

Receipt Header Alignment (Options - LEFT,
RIGHT, CENTER)

receipt.print.programName

Print the promotion program name on receipt

remote.server.hostname

Remote Log Server properties

remote.server.hostname

Host where the logs are stored

remote.server.logBuffer.size

Log server buffer size

remote.server.openRetry

remote.server.port

remote.server.prefix

remote.server.socektTimeout.sec
ond

rsd.useTestHost

Use RSD test host
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ruby.fuelsys.driveOffAlert
ruby.fuelsys.driveOffRepeat
safeDrop.calculator Calculator appears on screen during safe drop
sales.foodorder.expire.minutes Expiry minutes for food order
sales.print.zerovalueitem Prints receipts for zero value items
standard.keybd.filename POS Keyboard file name

Amber Alert

sys.amber.alertCountUrl

sys.amber.alertDataUrl

sys.amber.compareUrl

sys.amber.enable Enable amber alert

sys.amber.pollFreqSecs

ticket.reprint.includeDCRTrans Include DCR transactions in ticket reprint

topaz.enablevirtualkeyboard.expr | Enable or disable virtual keyboard button on
esspanel express panel

topaz.safedrop.numbLines Number of blank lines on safe drop receipt

topaz.sales.allowDismissalOfGroup | Grouped item menu configuration
editemMenu

topaz.sales.allowDismissalOfModifi | Grouped item menu configuration
erMenu

topaz.sales.print.printTaxLines Print separate tax lines on receipt
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topaz.sales.showPluModifiers Enable or disable display of plu modifier list

upgrade.token.timeout Auto Upgrade - timeout value for token in
seconds

viper.custom.feecode Viper custom fee product codes

Local Area Network Configuration

Local Area Network Configuration provides Ul for configuring the LAN. Use to
configure Global Routes, Device Specific IP Configuration, Device specific Routes and
DNS.

Local Area Network Configuration

Global Routes

Route Type | Destination |  Gateway Netmask

Device Specific IP Configuration

NIC Deseription 1P Address Hipmls Y Default Route

Isolated payment NIC 192.168.32.11 a =

Verifone Zone 192.168.31.11

Device Specific Routes

Route Type Destinati |  cateway | Netmask

DNS

sl O R U

Domain Name (@ptional) |

DNS 1
'

wee [ ML I I
ovss L 1L I ]

VHQ Configuration

The customers can choose from the following VHQ options:
1. Sign a SOW - Verifone performs services to customer PIN pads through VHQ.
2. VHQ Administered - Verifone does the estate management for a fee.

3. VHQ Own Instance - Customers want to own their own instance and move all
their PIN pads to their own instance.

The objective of having all Petro PIN pads on VHQ is the ability to remediate and
resolve issues found in the field faster.
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Note: Refer to the VHQ User Reference documentation for more information on
this feature. The User Reference is available on Premier Portal.

POS sends following VHQ data to EPS:

e Enable/Disable (VHQ)
e VHQ Address

e Customer ID

e StorelD

e LanelD

e Service ID

e Customer Profile

e Pinpad ID

Enable/Disable VHQ, Customer ID and VHQ Address is configured through VHQ
Configuration form.

EPS sends the same information to PIN pad as part of the diagnostic message when the
POS logs in. VHQ extracts the information from PIN pad.

Inorder to view and update VHQ Configuration, new user role functions should be
created to view and update “VHQ Configuration”.

e vvhqconfiguration - View VHQ Configuration
e uvhqconfiguration - Update VHQ configuration

A person having the role “manager” have these (view and update) functions enabled
by default. All other roles have view function enabled by default.

Refer to Configure Roles for more information to configure roles.
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VHQ Configuration

& Edits require a one-time passward (OTP)

VHQ Detail

Enable VHQ [
Customer ID
Store ID [AB123
Service ID
Customer Profile |buypass

https:f! [vhq.verifone.com i eriMessagel asm:

—VFI POS-POP Mapping

—Secondary POP Mapping

Lane # PinPad ID Lane # PinPad ID
001 000 065

002 000 066
003 000 067
004 | 000 068
005 000 069
006 000 070

007 000 o7

@ o~ e o s w4

008 000 072

1-80f32 » M

After you enable VHQ, the form allows you to edit Customer ID and VHQ address.

—VHQ Details

Enable VHQ [
Customer 1D |

Store ID |AB123

Service ID

Customer Profile | buypass

https://  |vhq.verifone.com /MessagingServer/MessageHandler asmx

On save, the form validates customer ID and VHQ address. VHQ address can be a URL
or an IP address. Customer ID can be Alphanumerical characters up to 64 characters.
If validation is not successful, an error message is displayed.

Service and Maintenance (SAM)

Beginning with ViperPAY version 4.06.xx, an additional Service and Maintenance (SAM)
feature will be available for Mx9xx Series PIN pads. The objective of having all Petro
PIN pads connected with the Service and Maintenance feature is the ability to
remediate and resolve issues found in the field faster. The SAM feature is included as
part of ASM entitlement for Commander locations and includes improved Verifone
Helpdesk support functions, such as:

e Review general configuration of the device, including network and system
configuration.

e Review PIN pad diagnostic logs.
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e Correct some operating system and application issues.
e Perform diagnostics remotely on the PIN pad, such as screen calibrations.

The SAM feature can be enabled after each PIN pad has the ViperPAY application
loaded/upgraded. Enablement is performed by selecting "Accept” on the Terms &
Conditions prompt that appears after the PIN pad application is loaded/upgraded. The
SAM feature is PIN pad specific, therefore the prompt will appear on all PIN pads once
the application is loaded/upgraded.

Rejecting the Terms & Conditions will disable SAM functionality. Verifone strongly
encourages our customers to enable the Service and Maintenance feature.

Should a customer reject the agreement after updating the ViperPAY version and
want the Service and Maintenance feature later, they can enter into System Mode on
the PIN pad, navigate to “Enable VHQ default” and change the value to 1. They will
then need to run the application from the PIN pad home screen and accept the Terms
& Conditions prompt. This must be completed for each PIN pad.

Note: The above process is same when user changes from SAM to No SAM on PIN pad.

Note: Some PIN pads have Accept and Reject soft keys. Use these keys for SAM
enablement.

Note: SAM is only available for PIN pads that are not a part of a client managed
instance of VHQ.

Commander Console

The Commander Console is a cloud-based enterprise application on which the
Commander Site Controller transactions and reports can be viewed. In order for
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Commander Site Controller transactions and reports to be viewed on Commander
Console, the Commander Console needs to be configured in Configuration Client.

Commander Console Sy Cacel
Commander Console Configuration
Enable Cloud Agent

Commander Caonsole URL

Test URL

Site Identification

Site ID
Service ID

Postal Code

Enable Cloud Agent Select to enable Cloud Agent

E(%rlrlmander Console Enter the Commander Console URL.

Site ID The Site ID of the store

Service ID Verifone commander Service ID. 7 characters
Postal Code Enter the postal code of the site.

Cloud Configuration Manager

The Cloud Configuration Manager is a cloud-based enterprise application used to
manage Commander Site Controller configuration settings for a site or group of sites.
All Commander Site Controllers that are managed through Cloud Configuration
Manager must have the Cloud Configuration Manager agent configured in
Configuration Client.

Note: Refer to the Cloud Configuration Manager documentation for information
on this feature.

General
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Cloud Configuration Manager

General & RBED GG e

— General Configuration

Host URL | hitps://CommanderCM.verifone.com/cdm Restore Default URL

Company | Unassigned |
Custom ID | |

— Site Configuration

Site ID |AB123
Service ID
Host URL The URL of Cloud Configuration Manager.
Compan Company name that was set up when requesting for
pany Cloud Configuration Manager.
Custom ID Leave it as blank
Site ID The Site ID of the store
Service ID

CM Diagnostics

Use CM Diagnostics to see if Commander site Controller is connected to the Cloud
Configuration Manager.

Cloud Connect

The Petro Cloud Connect application allows to remotely configure data for the POS
system through the web. A technician does not have to visit each location to make
changes and updates. These updates can be done selectively or all at once for all the
POS devices from the web application.

Note: Refer to the Cloud Connect User Reference documentation for more
information on this feature. The User Reference is available on Premier Portal.
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Store Operations

Payment

Currencies

Use to define the common currency, one alternate currency, and the exchange rate of
the alternate currency in relation to the common currency.

Payment Management

o |-

Delete
Select Currency Name

2 Symbol
$
Amount

Enter a descriptive name for the currency
(alphanumeric, 1 - 14 characters). All transactions
use this currency unless the [OTHER CURR] key is

Name

pressed.
Each currency is selected separately.
Delete Click to delete the selected currency.
Symbol Select a symbol for each currency. The symbol

appears on receipts.

Enter the rate at which the alternate currency is
Amount compared to the base currency (0.000000 -
999.999999).
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Fees

Use to add an additional charge (for example, bottle deposits) to an item or
department. The Fees tab can contain up to 99 different fees. The current fees are
listed on the left side of the form.

Payment Management Payment Management
g e
e | curnces [0 v e or | curmors [GSRY] ox e
Delete "I Delete
Select Fee Name Dep Select Fee Name Dep
BTL DEP 9032 - BOTTLE DEPOSIT [] 001 - BTL DEP. ~ BTLDEP 9032 - BOTTLE DEPOSIT [~
002 - 6PK. DEP CIR 002 - 6PK. DEP 3w
Wi .

003 - ADF Fee Is Refundable 003 - ADF Fee Is Refundable

004 - M.O. FEE Fee Type 004 - M.O. FEE Fee Type

005 - CS DEP @ Range/Amt  Percentage 005 - CS DEP Range/Amt @ Percentage
006 - REBATE TR 006 - REBATE TR

007 - REBATE TN Amount Range 007 - REBATE TN Percentage
008 - 911 FEE 0.05 999.99 008 - 911 FEE 5.00
009 Amount Range 009
010 0.00 0.00 010

11 011
g‘ 2 Amount Range 012
5is 0.00 0.00 bis
014 Amount Range 014
015 0.00 0.00 015
016 A 016
017 000 017
018 o018
019 019
020 - 020

Enter a descriptive name for the Fee (alphanumeric,

Name 1 - 9 characters). The name prints on receipts.
Delete Select to delete the selected fee.

From the drop-down menu, select the department to
Department

which fee transactions are charged for report totals.

Select to indicate that the fee is refundable with the

Fee is Refundable cost of the item if it is returned.

Percentage: Percentage Fee will be calculated as the
configured percentage of base selling price.

For example, if Percentage Fee is configured as 4.555
and the same fee is applied to Item F with base
selling price $9.98, the Fee applied will be 4.555
percentage of 9.98. ie 9.98*4.555/100 = .45.

Fee Type

Range/Amt: Fee calculation for sales will be updated
to process by Range Amount.
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Amount (1) Enter the amount of the first fee (0.00 - 9999.99).
Range (1) Enter the ending dollar amount for items to which
S the first fee applies.
Amount (2) Enter the amount of the second fee (0.00 - 9999.99).
Range (2) Enter the ending dollar amount for items to which
g the second fee applies.
Amount (3) Enter the amount of the third fee (0.00 - 9999.99).
Range (3) Enter the ending dollar amount for items to which
g the third fee applies.
Amount (4) Enter the amount of the fourth fee (0.00 - 9999.99).
Range (4) Enter the ending dollar amount for items to which
S the fourth fee applies.
Enter the amount of the fifth fee (0.00 - 9999.99).
Amount (5) This fee is applied to all amounts higher than the
range end for the fourth fee.

Merchandise

The Merchandise Manager form is used to add, delete, and restore categories and
departments. The Product Code tab displays the current product codes. Product codes
cannot be edited.

Categories

Use to define the categories for your site. The current categories are listed on the left
side of the form.

The maximum number of categories that can be configured by platform:
e Ruby Ci - 9999

o Commander Site Controller - 9999
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Merchandise Configuration

Add | [lpelete
Select Category Number

999 _TEST MDSE

9999 - FUEL DEPOSIT Name

TEST MDSE

Add Click to add a new category
Number Enter a unique number for the category
Name Enter a unique name for the category

Product Code

The Product Code tab contains view-only data and cannot be edited. The fields in this
tab are Number, Name, Status and Fuel (Yes or No).

Sales

Sales Configuration

The Sales Configuration form is used to set up the sales functions and the login/logout
messages for the site.

Note: All the Security Level configurations from this form has been moved to
Security > POS Security > Sales Functions Security form.
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Allow Amount
Entry for Refund

Sales Configuration

Sales Parameters

Save || Cancel

Prepaid Card Recharge Department
Prevent Modify Key Cycling

GST Price Override Security Level
Print DOB on Journal

Print DOB on Receipt

Print receipt

Prompt Loyalty for PLU Mot Found
Refund security

Register Time-Out Timer

Release Terminal During Close
Reminder to use Imprinter

Reset display on drawer close
Reset display on timeout

Reset display timeout value

Safe Drop Correction Security
Store number

“Walue added tax (VAT)

Wendor payment security

Woid line security

Woid transaction security

|3

vawe O

=

Allows amount entry for refund so that the cashier can give the
amount entered as refund to the customer as a roundoff figure
after taking the difference from the customer.

Canadian GST

Select if the site collects Canadian GST tax. Special prompts for
Canadian GST appear in the Tax Rate File.

Cardload
Recharge Dept

Select to assign the department number for cardload recharge.

Cash Drawers
Connected

Enter the number of cash drawers connected to this register (1 -
2).

Cash Underrun
Auto Refund

If disabled, cashier must complete the underrun transaction by
selecting a MOP.

If enabled, when cashier claims the fuel sale, amount is
automatically refunded.

Check Drawer
Amount on Safe
Drop

Select to compare the amount of the MOP entered to the
calculated amount currently in the drawer.
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Count Underrun
Customers

When a cashier completes a prepay underrun transaction, the
underrun customer count is incremented in the Summary Report,
Shift Report and Daily Report with the attribute “Underrun
Customer”.

Disable Error
Correct Key

“Error Correct” key is not displayed on the POS touch-screen
when this parameter is enabled.

Discount
Denomination

Refer to Discount Denominations for configuring discounts.

Select so that when the cashier selects the discount key (hard
key, soft key, or touch-to-modify menu), any configured
discounts are displayed as part of the discount overlay.

Discount Type -
Pct or Amt

Select the type of discount to apply when the [DISC] key is used.

Percent — The discount is calculated as a percentage of the
price and then subtracted from the price of the item.

Amount — The discount is directly subtracted as a dollar amount
from the price of the item.

Display PLU not
found Department
List

Select to set a department number to assign to PLUs that are
not in the PLU department list.

Drawer Alarm
Timer

Enter the number of seconds a cash drawer is allowed to remain
open before an alarm is triggered (0 - 99).

Note: “Drawer Open During Sale” must not be selected for the
drawer alarm timer to work.

Drawer Open
During Sale

Select to allow the cash drawer to remain open during
transactions. (If not selected, the cash drawer must be closed
before the next transaction can be started.)

Note: Make sure that “Drawer Open During Sale” is not selected
if you are entering a value in “Drawer Alarm Timer”.
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Enable Managed
Update

Enable to provide an interim approval step during the PLU file
update process and to allow updates to take effect within the
POS system immediately upon approval. No restart required
after approval.

Enable Receipt

Enable to print the tax details on the receipt. Even if this
feature is disabled, if there is a taxable rebate in the

Settle Overrun

Tax Detail transaction, the tax details are printed on the receipt.
Select to determine whether to apply a charge on a prepaid sale
Enable Auto in case of an overrun. When enabled, the overrun amount should

automatically be settled to “Drive Off” MOP to complete the
transaction.

Error Correction
Security Level

Select to set the security level required to perform an [ERROR
CORR] on an item in a transaction.

Error Message
Prompt Timer

Enter the length of time (in seconds) that error messages display
(2 - 30).

Fixed Discount
Rate

If “Is Fixed Discount” is selected, enter the percent or amount
(set in “Discount Type”) that is automatically applied when the
[DISC] key is pressed.

Force DOB on ID
Check

Select to force ID checks by displaying messages, beeping, and
restricting sales until a birth date is entered, scanned, or
swiped.

Force No Sale
Print

Select to print “No Sale” on the receipt and the journal when
the cashier presses [No Sale] in Sales mode. (If not selected, “No
Sale” prints on the journal only.)

Force Refund
Print

Select to print a refund receipt when the cashier performs a
refund in the Sales mode. (If not selected, the refund prints on
the journal only.)

Force Void Line
Print

Select to print “Void Line” on the receipt and journal when the
cashier voids a line in the Sales mode.
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Force Void
Transaction Print

Select to print “Void Ticket” on the receipt and journal when
the cashier voids a ticket in the Sales mode. (If not selected,
“Void Ticket” prints on the journal only.)

Fuel Discount

Enter the dollar amount per gallon discount that is applied when
a fuel discount key is used (0.00 - 99.99).

Fuel Discount
Title

To rename Fuel Discount with a descriptive name, enter up to
30 characters.

Idle Prompt
Displays Due Sale

Select to display “No Due Sales” when the terminal is idle, and
no fuel transactions are due. Due fuel sales display if one or
more fuel sales are due. (If not selected, “Ready for Sale”
displays when the terminal is idle. Due fuel sales are viewed by
pressing the [VIEW] key.)

Is Cashier #
Required for Each
Sale

Select to require the cashier/employee number and password
before starting each sale.

Is Fixed Discount

Select to automatically enter discounts (set in “Discount Type”
as a percent or amount) for the amount entered in “Fixed
Discount Rate” when the [DISC] key is pressed. (If not selected,
all discounts must be entered as individual amounts.)

Is Sub-total
Required

Select to require pressing the [TOTAL] key before the MOP is
chosen.

Is Total in Double

Select to print the transaction total in double-wide characters
on the receipt and journal. (If not selected, the transaction
total will print in single-wide characters.)

Maximum Till
Transaction
Amount

Enter the maximum transaction amount.

Note: Maximum amount is 9999.99.
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Maximum Amount

Enter the maximum amount that any one department item may
cost if ‘0’ is entered for Department > Max Amt. (0.00 -
9999.99).

Note: The value set in Department >Max Amt overrides any
value set here.

Enter the maximum discount (either percent or dollar as set in

I\S\]E:élorzﬁ;n “Discount Type”) that can be applied to an item when using the
[DISC] key (0.00 - 99.99).

Maximum Enter the maximum quantity of any one item that may be sold in

Quantity one transaction (0.00 - 9999.99).

Minimum Amount

Enter the minimum amount that any one department item may
cost if ‘0’ is entered for Department > Min Amt (0.00 - 9999.99).

Note: If Department > Min Amt is not ‘0,’ then its value
overrides the value set here.

Minimum Discount

Enter the minimum discount (either percent or dollar as set in
“Discount Type”) that can be applied to an item when using the
[DISC] key (0.00 - 99.99).

Money Order Low

Enter the number of checks remaining before an alarm message
indicates that the money order machine needs to have more
checks loaded (0 - 99).

One Cashier per
Drawer

Select to limit login to one cashier per cash drawer until totals
are closed. This can be overridden by personnel with higher
security levels than the cashier. If not selected, more than one
cashier is allowed per cash drawer.

Note: This feature is not supported.

Open Drawer
Cashier Close

Select to close open drawer before another cashier can use the
cash drawer.
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PLU Not Found
Department

Enter a department number to assign to PLUs that are not on the
PLU File and are entered as a sale (0 - 9999).

0000 — Disables the PLU Not Found department.

Note: The department number must also be assigned as the PLU
Not Found department from Manager > Merchandise >
Department.

Prepaid Card
Activate
Department

Enter the department number for prepaid card activation sales
transactions.

Prepaid Card

Enter the department number for prepaid card recharge sales

Recharge )
transactions.
Department
. Select to prevent cycling through the modifiers of a PLU. (If not
Egvgcém(;d]fy selected, cycling through the modifiers of a PLU from the lowest

priced modifier to the highest priced is allowed.)

Print DOB on
Journal

Select to print DOB on journal.

Print DOB on
Receipt

Select to print DOB on receipt.

Print Receipt

Select to print a receipt for every transaction (if not selected, a
receipt will only print for No Sale, Pay In, Pay Out, Clock
In/Clock Out, Void, Car Wash, POP Discounts, Credit
Transactions, and when using the [Ticket Print] Key).

Print UPC on
Receipt

When this feature is enabled, the actual UPC or PLU will be
printed on the receipt, along with the description.

Prompt Dine In

Select to prompt dine in at food kiosk.
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Prompt Food
Order Name

Enable to prompt for entering customer name for food orders.

Prompt Food
Order Phone
Number

Enable to prompt for entering customer phone number for food
orders.

Prompt Loyalty
for PLU Not Found

When enabled, if a scanned barcode or manually entered
number comes as “PLU Not Found”, the system asks the user if
the number is a Loyalty Card.

Receipt Print
Program Name

Receipt prints loyalty program name.

Register Time-Out
Timer

Enter the number of minutes (001 - 999) after which an idle
terminal automatically switches out of Sales mode.

Entering 000 indicates that an idle terminal will not
automatically switch out of Sales mode.

Release Terminal
During Close

Select to allow the terminal to return immediately to Sales
mode after a close shift or close daily is started.

Reminder to Use
Imprinter

Determines whether a message is displayed that reminds
the cashier to use the imprinter after completing a
transaction using the Manual Credit MOP.

Reset Display on
Drawer Close

Idle sales message returns when the drawer closes.

Reset Display on
Time-out

Idle sales message returns when the time-out elapses.
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Reset Display
Time-out Value

Enter the time (in seconds) before the idle sales message returns
to the operator display after a transaction is complete. When
“Reset Display on Time-out” is selected, a value must be
entered here (2 - 3600).

1 = 2 seconds

0 = disables the option to reset display on time-out

Stack manual
Discount

If enabled, multiple manual discounts can be applied on a line
item. Cannot apply multiple discounts if item has NAXML
discount applied to it.

Store Number

Enter the number or name that identifies the store. This
information is printed on receipts and reports (alphanumeric, 1 -
5 characters).

Value Added Tax
(VAT)

Select if value added tax (VAT) is collected at the site. Special
prompts for VAT appear in the Tax Rate File (U.S. and Canadian
sites usually do not collect VAT).

Sales Login/Logout Message

Use to enter messages that are displayed when an employee logs in or out of Sales

mode.

Sales Configuration

==L inUELGGE Sales Login/Logout Message

Log In
[Ishow Log-In Message

Log Qut
[ Show Log-Out Message
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Log In - Show Log-In Select to display the prompt when the user logs on
Message to Sales.

Enter or edit the information displayed when Sales
Lines is entered.

Log Out - Show Log-Out | Select to display the prompt when the user logs out
Message of Sales.

Enter or edit the information displayed when Sales
Lines is exited.

Menu Keys

Refer to Menu Key Configuration

Register

The Register Configuration form is used to set up banners, logos/slogans, soft keys,
and copy registers for the site.

Banner

Use to define the message that appears on the customer display when sales
transactions are not in process.

Register Configuration

J o5 | scco | cop e

Reqgister |1 - controller %

Message

Line 1 | THAMK YOU M rotate
Line 2 Orotate
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Register Select the register.

Enter the messages for lines 1 and 2 (alphanumeric,

Line 1 and Line 2 up to 80 characters).

Select a rotation option — None, Line 1, Line 2,

Rotate Both.

Logos/Slogans

Use to enter the information that prints in the header (logo) and footer (slogan) of
receipts.

Register Configuration

oo [JEPET] v | co e

Register [1 - controller ¥ Ticket Logo Enabled  Mode Alignment
WELCOME TO WELCOME TO B [oousle v [Lett
OUR STORE OUR STORE @ [oounie v [Le

O [nomal
O [nomal
O [nowsar

Ticket Slegan EnE;ed ,'\l:ll::% AngﬂlL:

O [Nomai™ [ten ¥

O [vomai® [ten ™

O [vemar™ [Len »

O [wmaw [er ¥
Register Select the register.
Ticket Logo/Ticket Enter the information that appears on register
Slogan receipts.
Enabled Select to enable each logo and/or slogan.
Mode Select Single- or Double-wide characters.
Alignment Select Left, Right, or Center.

Copy Registers

Use to copy files from one register to another.
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Register Configuration

Select Registers

Source Register |1 - controller [%

Destination Register

Select Files to Copy

Banners Logos Slogans Sofikeys

Select Register - Source
Register

Select the register to copy.

Destination Register Select the register to which you want to copy files.

Select the files you want to copy: Banners, Soft

Select Files to Copy Keys, Logos, Slogans.

Touch Screen

The Touch Screen Configuration forms allow you to configure fuel keys, assign
buttons, define the parked menu panel, and orient the touch screen.

Note: Refer to the Base 53 and Higher feature reference documentation for

information on this feature. The Feature Reference is available on Premier
Portal.

Self Checkout

Self Checkout (SCO) is a self-checkout POS application for C-Stores implemented on
B53 and Higher Ul.

Note: Self Checkout will be disabled on future releases except for customers who
have licensed it from Verifone separately.
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Note: Refer to the Self Checkout feature reference documentation for
information on this feature. The Feature Reference is available on Premier
Portal.

House Account

A House Account is a non-network, local store account that is set up with credit
granted at the discretion of the site manager. House accounts require an account
number, which prints on the receipt. Commander keeps and reports totals for House
accounts but does not keep records of individual transactions or balances. Follow
store policy to manually record transactions.

Note: Refer to the In-House Accounts feature reference documentation for
information on this feature. The Feature Reference is available on Premier
Portal.

“force.InHouse.PaylnOut” in ConfigClient > Initial Setup > System Properties should
be set to Yes to enables sites to assign In House Accounts with Pay In and Pay Out.

House Account/ Pay IN/ Pay QUT Configuration

Aod Delete
Salect House Ascount ACCOURNT Mumbes

213 Account Name
231476 TESTING
TE23AGI4 Z369 Options

< Enabled

+ Prompl for SubAcche
Trigger Function

4 In-House MOF

¥ Pay IN

¥ Pay QUT

Click to add a new account. The account is

Add automatically enabled unless you clear the Enabled
check box.

Delete Select to delete the selected account.

Account Number Enter the account number
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(alphanumeric, 1 - 20 characters).

(Optional) Enter the name of the customer.

Account Name (alphanumeric 0 - 20 characters).

Enabled Select to enable the account.

Prompt for Sub Acc# Enable to prompt for sub account number.

Select what triggers a "In-House Account? [Y/N]"

Trigger Function prompt.

Group Price Change

Note: Refer to the Group Price Change feature reference documentation for
information on this feature. The Feature Reference is available on The Feature
Reference is available on Premier Portal.

Use to change the prices of multiple PLUs assigned to a selected department at the
same time.

Group Price Change

Select Department Select the PLU(S) to be adjusted

~

Select an adjustment type
O increase
O Decrease
© Make all prices the same
Select an adjustment option
O Amount
O Percent

Enter the adjustment amount

Calculations that are less than zero or greater than the Select Al Select Nong
department’s maximum amaount will be skipped.

To change a group of prices:

1. In the department list, select the department that contains the products
needing the price change.

2. Click an adjustment type — Increase, Decrease, Make all prices the same.

3. Click an adjustment option — Amount, Percent.

69



Configuration Client Screens

4. Enter the adjustment amount as dollars and cents (0.00 - 9999.99) or percent
(000.000 - 9999.99).

5. Select the PLUs to be adjusted.
e Click Select All to select every PLU in the department.
o Select several adjacent PLUs by using SHIFT and click.
e Remove selections by clicking Select None.

6. Click OK.
Managed Updates

The Managed Updates feature provides an interim approval step during the PLU file
update process and allows updates to take effect within the POS system immediately
after approval. The business purpose behind the approval step is to allow store
management to use a 3rd party system (SAP Retail Store) to identify, print and update
shelf labels as needed for price changes prior to those changes being reflected within
the POS system.

Enable Managed PLU Update

From Store Operations > Sales > Sales Configuration, enable “Enable Managed
Updates”.

Sales Configuration

Sales Configuration

Sales Parameters Allow amount entry for refund

Canadian GST ~
Cardload Recharge Dept

Cash drawers connected

Cash under run auto refund

Value [] Check drawer amount on safe drop
Count Underrun Customers

Discount Denomination

Discount Security Level

Discount type - Pct or Amt

Display PLU not found Department Lis
Drawer Alarm Timer

Drawer open during sale

Enable Receipt Tax Detail

Enable auto settle overrun

Error Correction Security Level

Error Message Prompt Timer

Fixed Discount rate v
Force DOB on ID Check

Description |Enable Managed Update

Managed Update Security Level

In Store Operations > Sales > Sales Configuration > Managed Update Security Level,
enter the security level of the manager who can apply the update.
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Sales Configuration

Sales Configuration |EEICERETHTELLINE Y EEERT

Sales Parameters Force refund print
Force void line print ~
Force void transaction print
Description |Managed Update Security Level Fuel Discount Title P

Fuel discount

Idle prompt displays due sale

Is cashier # required for each sale
Is fixed Discount

Is sub-total required

Is total in double

Maximum Till Transaction Amount
Maximum amount

Maximum discount

Maximum guantity

Minimum amount

Minimum discount

Money order low

No sale security V]
One Cashier per Drawer

Value |5

"Apply Updates" Touchscreen Button

In Store Operations > Touch Screen > User Panel, select Key Type as “Function”
and Function as “Apply Updates” to assign this function to a touch screen key or
Topaz POS key for easy access to the function.

Fuel Panel | Parked Menu Pane! (RIS g ]

Row

Key Type Line 1 \
[Functon <] oply g
a
Function Line 2 n
s
Apply Updates [v] Updates :
i
8
o
0
= m

S ol Key Preview Click an item to edit

[Fuel [] Menu key

[[]Parked Menu[_] Department

[JpLu [l Function

[Wnotused [l moP

- o

Inactive

| ]

Preview/Edit Get Text Apply || Cancel

Back

Pending Updates

View Pending Managed Updates from Store Operations > Managed Updates.

FPonmnding Manmnaged Updatoes

s L et B A restiariant
A LV ONn N DA Ftamews
- HOVB/ VAN ONn s W Framews
™ HOID/YNIND O 25 o an fresews
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Fiscal Receipt

This feature is available for LAC countries. In many LAC countries, controlled receipts
(e.g. “Facturas”) are printed from the POS. The receipts typically include a controlled
sequence number and other POS controlled data.

After all MOPs are processed, the application would determine which of the five types
of receipts to print.

The five types of receipts are:
e Fiscal Sale

Fiscal Refund

Fuel Voucher

Non-Fiscal Network

Pump Test

Transaction Processing of MOPs to Generate Receipts

Pump Test

If Pump Test MOP is used, the transaction generates a Pump Test Receipt. This will
not require any data input.

Fuel Voucher
If Fuel Voucher MOP (with fuel voucher MOP code) is used, the transaction
generates a Fuel Voucher Receipt. The Fuel Voucher MOP can be used only with
Postpay Fuel and Manual Fuel line items.
When this MOP is used, no split tender, no change and no refunds are allowed.

This MOP requires 2 cashier prompts:

a) For Fuel Voucher number (Alphanumeric 0-15 chars): “"Enter [receipt type name]

Number:”
b) For Customer number (Alphanumeric 0-15 chars): “Enter Customer Number:”

Note: More than one post pay fuel line can be allowed.
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Non-Fiscal Network

If a Network MOP is used and the FEP returns the flag “FiscalReceipt” = FALSE, the
application generates a Non-Fiscal Network Receipt.

Fiscal Refund

For a Fiscal Refund receipt, the system prompts for the original Fiscal Sale receipt
number.

Fiscal Sale

If the transaction is none of the four previous receipt types, the system generates
Fiscal Sale Receipt.

o]

Site

Us

e this form to configure site-level fiscal receipt configuration.

Fiscal Receipt Configuration

— Customer Tax ID

Minimum Length I:l
Maximum Length I:l
Check Digit

— Tax |D Database
[JEnable DB

Customer Name

Customer Address

— Warning Thresholds

— Other Settings

Merchant Tax ID Name I:l

Use common sequence # for all APTs [
Commen APT Register |D

Print Currency Symbal
Print Line ltem Unit Price
Print Verbose Total

Print Tax Summary Table

oooo
<]

Customer Tax ID
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Enter customer Tax ID Name; alpha-numeric string
between 3-20 characters.

Minimum Length

Enter customer Tax ID Number; minimum length
(numeric value between 0-20).

Maximum Length

Enter customer Tax ID Number; maximum length
(numeric value between 0-20).

Check Digit

Drop-down box with 2 values: ‘None’ and ‘Modulo
11°.

Tax ID Database

Enable DB

Click to enable Tax ID Database.

Customer Name

Use to prompt for customer name to be added to
Tax ID DB.

Customer Address

Use to prompt for customer address to be added to
Tax ID DB.

Warning Thresholds

Sequence Number

A countdown alarm that notifies the number of
sequence numbers still available on the range
defined for a specific authorization number.
Numeric value between 1-3. Default = '100'.

Authorization Days

Number of days before the Ending Authorization
Date expires. Numeric value up to 2 digits (00-99).
Default Value is 15 days.

Other Settings

Merchant Tax ID Name

Merchant Tax ID name.

Use common Sequence
Number # for All APTs

If this parameter is enabled, all the APTs configured
in a site have a common sequence number. Default
= Enabled.
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Select the APT register ID to configure. Only this
APT appears in the register selection field in the
Register form.

Common APT Register
ID

If this parameter is enabled, the currency symbol is

Print Currency Symbol printed on every amount printed on the receipt.

If this parameter is enabled, the unit price is
printed after the quantity on every receipt printed
and the header is printed as: “Qty/Unit P”
(Quantity/Unit Price) and translated to Spanish as
“Ctd./P. Unit.” (Cantidad/Precio Unitario).

If this parameter is disabled, the header is printed
as “Qty” and translated to Spanish as “Cant.”.
Default value = disabled. This only applies to
Honduras.

English:

0123456789012345678901234567890123456789

Print Line Item Unit

Price Description Qty/Unit P.  Amount
Description Qty Amount
Spanish:

0123456789012345678901234567890123456789

Descripcion Ctd. /P.Unit  Monto

Descripcion Cant. Monto
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Print Verbose Total

If this parameter is enabled, the verbose total is
printed on the receipt. Default = disabled. This only
applies to Honduras.

Note: The maximum verbose total amount printed

on the receipt matches the maximum total amount
on the receipt. See the example of receipts in the

next table for more information.

Print Tax summary
Table

If this parameter is enabled, the Tax Summary
Table is printed on the receipt. Default = disabled.
This only applies to Honduras.
This table has 4 columns:

e Imp%: Tax rate

e Base: Amount before Tax

e Tax: Tax rate * Base

e Total: Base + Tax

Register

This form is used to configure the different types of fiscal receipts. The different
types of fiscal receipts that can be configured with this form are Fiscal Sale, Fiscal

Refund, Fuel Voucher, Non-Fiscal Network and Pump Test.
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Fiscal Receipt Configuration

Site WEEMEETEN Fuel Flat Taxes

—Select

Enable Fiscal Receipts ]

Fiscal Refund

Fuel Voucher
Non-Fiscal Network
Pump Test

[ V]  Add

Register |101 - topaz.
Receipt Type
Fiscal Sale

—Receipt Type Configuration

[ Delete

Name |

Prefix/Series |

Begin Sequence (00000000

End Sequence 00000000

Update Next Sequence
Update Next Sequence [ ]

Next Sequence 00000000

Authorization Name |

Authorization Number |

Starting Authorization Date Label |

Starting Authorization Date | 05/08/19

Ending Authorization Date Label |

Ending Authorization Date |05/08/19

Merchant Tax ID

Prompt for Final Consumer |Disabled

Prompt for Customer Data [ ]

Select Register

Select the POS which is configured to print the
fiscal receipts.

Enable Fiscal Receipts

Select to enable fiscal receipts.

Add

Select fiscal receipt to configure and click Add

Receipt Type Configuration

Note: These configuration fields are enabled or greyed out depending on the

receipt being configured.
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Header
2 Up to 10 lines *** ::> A A) Header Expansion

B) Receipt Type Data Block

*** EPS Extended Header *** | C) Subtotal + Tax Lines

Autorizacion DGI D) Footer Expansion

AFC-DGC-SCC-006-06-2011
RUC: J0310000005336

FACTURA |:'l> B
No: 8902-00098214
Nombre: Gustavo Salazar

RUC del Cliente: 00110117100765

Descrip. Ctd. Monto

Cafe 2 5.00

Subtotal 4.25 |:'> C

15% IVA 0.75

TOTAL 5.00
CASH 20.00
CAMBIO  -15.00
*** EPS and Loyalty Data Block ™** I

Footer
{*"" Up to 10 lines *** } |::> D

REG# 002 CSH# 001 DR301 TRAN# 20007
27/09/2017 12:36:53 ST#AB123
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Hoadee ]
“*Upto 10 knes ** =

-

=>

A

| *** EPS ExSended Header ***

CAl
2505803015121

RTN 12345678901234

Rango: 020-002-01-00001000 a la

Fecha incio de Emeson.  01/26/2018
Fecha Lantte de Emusion. 01/26/2020

=B

FACTURA 3
No. 020-002-01-0001020 =
Nombre Gustavo Salazar
RTN del Chente: 08011986012824
Descrip. Ctd P .Unit Monto
A Jugo Naranjs 1 L.1.50
@L. 150
Dscto. Combo 1 L. -020
B Ensslsda Fruta 8cz. 1 L 250
@L. 250
Dscto. Combo 1 L.-0.50

| Descuentos y Rebajas L.-0.80 | [::> L

| Subtotal Gravado L. 2.20 | |::> M

A 0% IMP
B 15% IMF

L.0.00
L.0.42

[Eentoimp. L. 0.00] |:> H

A) Header Expansion

B) Recept Type Data Block

C) Subtotal + Tax Lines

D) Footer Expansion

E) Authorization Dates Range +

Authorized Receipt Type # Range

F) Line Rern Currency Symbol
G) Lne kem Unt Price

H) Tax Exempt Total Line
1) Verbose Total

J) Tax Exempt Block

K) Tax Summary Table
L) Discounts Line

M) Subtotal Line Label

N) Line before Total

TOTAL L 3.20 N
Efectivo L.20.00
Cambio L. 16.80
I TRES LEMPIRAS Y 201100 I E> I
=+ EXENTO DE IMPUESTO =*
No. OC Exenta:
No. Reg. Exonerado: [> J
No. Reg. SAG
Imp% Base Impuesto Total
0.00% L 1.50 L 0.00 L 150 L: C K
15 00% L 208 L 042 L 250 4
| " EPS and Loyaty Data Block *** |
Footer ]
{”‘Uplo 10 ks *** = =D

-
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Name Name of the receipt type (e.g., “FACTURA”).
Alphanumeric string between 0-15 characters.
Default = Empty.

Prefix/Serie

Receipt Type Number: This is composed by a
serie/prefix number (e.g., “8902”) and a sequence
number (e.g., “00098214”).

Begin Sequence

8-digit value between 00000001 - 99999999 (leading
zeros not required for input). Default = “00000000”.

End Sequence

8-digit value between 00000001 - 99999999 (leading
zeros not required for input). Default = “00000000”.

Update Next Sequence

Select to update next sequence manually in case of
a system failure.

Next Sequence

8-digit value between 00000001 - 99999999 (leading
zeros not required for input). Default = “00000000”

Authorization Name

Alphanumeric string value between 3-20 characters
(including special characters). Default =
“Autorizacion No:” (e.g., “Autorizacion DGI”).

Note: Spanish special characters are not allowed.

Authorization Number

Alphanumeric string up to 40 characters (including
special characters). Default = Empty (e.g., “AFC-
DGC-SCC-006-06-2011").

Starting Authorization
Date Label

Char string up to 30. Default = “Fecha Inicio de
Emision”.

Starting Authorization
Date

The Authorization Number is valid from this date.
Short Date Format string. This should be selected
from a calendar representation.

Ending Authorization
Date Label

Char string up to 30. Default = “Fecha Limite de
Emision”.
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Last valid day of the Authorization Number. Short
Date Format string. This should be selected from a
calendar representation.

Ending Authorization
Date

Alphanumeric between 0-20 characters. Default =

Merchant Tax ID
Empty.

Drop-down box with the following values:

Disabled: Prompt for Tax ID # and if the <ENTER>
key is pressed, then is a Final Consumer.

Prompt Y/N: This option is to indicate if after
enabling Prompt for Final Consumer, the prompt

Prompt for Final displayed should be: “Final Consumer? Yes/No”.

Consumer Menu: This option is to indicate that after enabling
Prompt for Final Consumer, the prompt displayed
should be a menu: “1. Final Consumer. 2. Customer
with Tax ID #”.

Note: ‘Final Consumer’ is any customer that
requires a ‘Fiscal Receipt’ but will not provide a
Customer Tax ID #.

Prompt for Customer Enable/disable prompts for Customer Data (Name,

Data Tax ID Number).

Prompt for Original Enable/disable prompting for Original Receipt

Receipt Number.

Prompt to get the original fiscal sale receipt

Prompt number: Alphanumeric string value between 0-30

characters (including special characters). Default =
“No Factura Original: ”.

Prompt for Fuel

Voucher Number Enable/disable prompting for Fuel Voucher Number.
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Fuel Flat Tax

This form allows the configuration of two flat taxes per fuel grade.

The flat tax is a fix amount per unit of measure (for example, 11 cents per gallon of a
specific fuel product). Depending on the country, the format of this amount is defined

as maximum 3 digits to the right and 4 to the left of the decimal point (e.g.,
XXXX.YYY?).

Note: Guatemala has only one fuel flat tax per fuel grade.

Fiscal Receipt Configuration

Delete
Fuel Products —Fuel Flat Tax 1

2-UNLD2 Name Amount
3-UNLD3 |
4 - UNLD4
5 - UNLD5
[
7
8

-METH —Fuel Flat Tax 2
-DIESL
-KERSN
9-REG Name Amount

10 - UNUSED1

11 - UNUSED2
12 - UNUSED3
13 - UNUSED4
14 - UNUSED5S
15 - UNUSEDG
16 - UNUSED7
17 - UNUSEDS
18 - UNUSEDS
19 - UNUSED10
20 - UNUSED11

Tax name. Allows up to 10 characters.
Fuel Flat Tax Name

Note: Guatemala only needs 3 characters.

Fuel Flat Tax Amount Tax amount.

The POS prints receipts with the Flat Tax information.
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BIENVENIDOS A
NUESTRA TIENDA
— il Monto
UNLD EF #01 4.5006 8.
@1.111/ 6
: £ 1'. : : 4 F
P 0.11/9 0.50
Sub Total 5.00
TOTAL 5.00
CASH 10.00
Canbio -5.00

Tax Exemption
Use the form to configure tax exemption if a Tax Exemption MOP code is used.

Fiscal Receipt Configuration

FIEREEAEVEES  Tax Exemption

Delete
Tax Exemption

oy Name [ ]
02 ~

03 Tax-Exempt Purchase Order # Prompt l:l
gé Tax-Exempt Customer # Prompt l:l
06 Exempt Merchandise Sales Tax []

07

08 Exempt Fuel Sales Tax [ ]

09 Exempt Fuel Flat Taxes []

10
11
12
13
14
15
16
17
18
19 v
20

This name is associated to the acronym of the
government entity that is tax-exempt (e.g., “SAR” =
Tax Exemption Type “Servicio de Administracion de Rentas” (Revenue
Name Management Department).

Alphanumeric, maximum 20 characters.

Tax-Exempt Purchase Alphanumeric, maximum 20 characters. (Description
Order # Prompt needed)
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Tax-Exempt Customer # | Alphanumeric, maximum 25 characters. (Description
Prompt needed)

Exempt Merchandise
Sales Tax

Select to exempt merchandise sales tax. This
parameter is enabled by default. Greyed out in this
screen in base 52.

Exempt Fuel Sales Tax

Select to exempt fuel sales tax. Greyed out in this
screen in base 52.

Exempt Fuel Flat Taxes

Select to exempt fuel flat tax. Greyed out in this
screen in base 52.

System Properties

The following system properties should be enabled for Honduras:

Print Tax-Exempt Total Line: If this is enabled, the system should print the line
“Exento Imp.” + [tax-exempt total amount].

Print Discounts Line: If this is enabled, the system should print the line
“Descuentos y Rebajas ” + [sum of all amounts discounted].

Print Subtotal Line Label: If this is enabled, the system should print the label
“Subtotal Gravado” in the subtotal line

Print Line Before Total: If this is enabled, the system should print a line before
the total amount

Currency Selection

Use this feature if the country is using a different currency than US dollar.

In Commander Site Controller Configuration Client, the currency of the country should
be selected from Payment Controller > EPS Configuration > EPS Global
Configuration.
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EPS Global Configuration

we Edits require a one-time password (OTP)

Rl POP | PINPAD Message | Loyalty | Trigger Pull Configur

—Dealer

Site Name VeriFone Gold Disk
Location ID
Address Line 1
City
State |FL
Postal Code

—Locale

Currency Name | US Dollar v
ISO Currency Code | Aruban Florin
Numeric Currency Code Bahamian Dollar

Belize Dollar
Currency Symbol | gormygian Dollar

Date Format  East Caribbean Dollar

Language |Guatemalan Quetzal |

Guyanese Dollar
Haitian Gourde —
— Signature Capture—JFonduran Lempira |
-| Jamaican Dollar
Signature Capture Eil Mexican Peso
; S Netherlands Antillean Guilder
Cashier Verify Signaf Panamanian Balboa
Print Signature on R¢é| Suriname Dollar
4 Trinidad and Tobago Dollar
| US Dollar

Charity Donations

The charity donation feature enables a customer walking into a c-store to donate
certain amount to a charity.

The system prompts customers during tendering process for charity donation.
Customers are asked if they wish to make a charity donation.

When the customer is using Cash as MOP there are three options that can be enabled
from configuration client to be presented to the customers on the Pin pad:

e Donate change amount (rest for charity) and is calculated as the difference
between the amount due and the amount paid.

e Round to next dollar amount which rounds off their transaction to the next
whole dollar. The donation amount is the difference between the total amount
of the purchase and the rounded dollar amount.

e ‘No Thanks’ when the customer decides not to donate.
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When the customer is using ‘Credit’ or ‘Debit’ cards as MOP, they will be presented
with three preset contribution amounts configured in configuration client or two
preset contribution amount and a round to next dollar amount along with another
option ‘No, Thanks’.

The chosen selection is shown on the receipt, where it reflects the contribution. Only
one charity can be active for any site.

The following configurations should be done before configuring the Charity Donations
Configuration form:

1. Create a department for charity with NACS code 971. Refer to the Department
Sales topic in this document for more information on creating departments.

2. For Cash MOP, “Tender Amount Required” parameter should be enabled. Refer
to the Method of Payment topic in this document for more information.

Charity Donations Configuration

Charity Donations Configuration

Enable Charity Donations

Department IChar dept.

—Cash — Card
POS Prompting Option Preset Amount 1
11.00 |
Rest for charity Preset Amount 2
I Round to next dollar |2-DC’l |
(®) Preset Amount 3 _)Round to next dollar
3.00 |

rekimaEn [ Nowsewherwdn
Enable Charity Donations Enable charity donations.
Department Select charity department.
Cash
Rest for charity Select if this option appears for cash
payments. This donates the change amount
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for charity.

Select if this option appears for cash
payments. Rounds off the transaction to the
next whole dollar. The donation amount is
the difference between the total amount of
the purchase and the rounded dollar

Round to next dollar

amount.
Card
Preset Amount 1 Enter the preset amount option 1.
Preset Amount 2 Enter the preset amount option 2.

Either this option or “Round to next dollar”

Preset Amount 3 can be selected as the third option.

Enter the preset amount option 3.

Either this option or “Preset Amount 3” can
be selected as the third option.

Select if this option appears for credit/debit
Round to next dollar card payments. Rounds off the transaction
to the next whole dollar. The donation
amount is the difference between the total
amount of the purchase and the rounded
dollar amount.

Close Lane
This is a Self Checkout feature.
Note: Refer to the Self Checkout feature reference documentation for

information on this feature. The Feature Reference is available on Premier
Portal.
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Promos and Discounts

NAXML Deal

Refer to NAXML Deal

POP Discount

Note: Refer to the POP Discount feature reference documentation for
information on this feature. The Feature Reference is available on Premier
Portal.

Coupon Scanning Configuration

The Coupon Family form is used to assign PLUs to a “family code” that appears on a
coupon, even though the code does not appear in the PLU. After the code and PLU are
associated in the Coupon Family form, the product with the associated PLU becomes
eligible for the discount when the PLU and the coupon are scanned on the POS.

For example, if a family code for cereal is 456 on a coupon, and the site’s PLUs for
several cereals do not contain 456, those PLUs can be associated with the family code
456 on the Coupon Family form. When the PLU for cereal and the coupon are scanned
on the POS, the customer receives the discount.

Note: Refer to the Coupon Scanning feature reference documentation for
information on this feature. The Feature Reference is available on The Feature
Reference is available on Premier Portal.

Site Parameters

Coupon Scanning Configuration

Site Parameters [l H =T
Coupon Processing Level | Transaction v

Allow Negative Transaction Totals

Coupon Processing Level Select the coupon processing level.

Allow Negative Transaction Totals Select to allow negative transaction totals.
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Coupon Families

Coupon Scanning Configuration

NG EEEES  Coupon Families

Add | (Jpelste

Select Coupon Family Code Description
‘ ‘CoupanZ ‘

999 - Couponi Manage PLUs

PLU D (0000000009398 | =]

PLUs

00000000099981/000 Add PLU

Remove PLU

Add Click to add coupons.

Delete Select to delete the selected coupon and click Save.

C Enter the coupon code. The code must be three
ode

characters long.

Enter the coupon description of the coupon family (30

Description characters maximum).
Enter a PLU/Modifier. Click Add to associate the PLU
with the family code.

Add a PLU Mod - Enter the modifier
Add - Click to add PLU

Remove PLU Click to remove the selected PLU.

Discount Denominations

This feature is used to configure various discounts which can be selected by the
cashier during a sale. When the cashier selects the discount key (hard key, soft key,
or touch-to-modify menu), any configured discounts are displayed as part of the
discount overlay.
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Note: This feature should be enabled in Configuration Client > Store Operations
> Sales Configuration.

Discount Denominations

[T Delete
Discounts Name
ECTI - | o
2 - Discount 2 Type
3- Percent |+

4

5- Amount
5- 10.00
7

8

Discounts Click to add discount name. A total of 16 discounts can
be configured.
Delete Select to delete the selected discount and click Save.
Name Enter the discount name.
e Percent
Type
e Amount
Amount Enter the percentage or amount discount.
Forecourt
DCR

Refer to Configuring Dispenser Card Readers

Fuel

Refer to Fuel Configuration

Fuel Prices
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The Pricing Manager form is used to set up fuel pricing, including tier pricing. Tier
Two pricing can be set up at any time but does not take effect until the appropriate
information is entered in the “Start Tier 2 Pricing” and “Number of Tier Hours”
parameters in Fuel > Site Parameters > Fuel Site Parameters.

Select the product, then double-click the Price text boxes and enter the price (0.000 -
9.999). The price of all products changes to match the price entered in the top text
box after ENTER is pressed. Prices can be edited if necessary.
Note: When entering a price, take care when placing the decimal point. For
example, to change a price to 1.159, enter it as written here. To change a price
to 1.500, enter the trailing zeros.

If you only change fuel prices, for the changes to take effect, initialize Fuel Prices by
selecting:

e Forecourt > Initialization > Fuel Prices

If you change other fuel parameters as well as prices, you will need to initialize Fuel
and DCRs for the changes to take effect. To do this, select both of the following:

o Forecourt > Initialization > Fuel
e Forecourt > Initialization > DCRs

Note: Make sure that your fueling positions are not in use when initializing any
Fuel Prices, Fuel, or DCRs.

Pricing Manager

Fuel Product Prices WorkSheet

SELF CASH 1111 SELF CASH 1.112

SELF CRED 1121 SELF CRED
FULL CASH 1211 FULL CASH

1221 FULL CRED 1222

MirI CASH 131 MinNI CASH 1312

MINI CRED 1321 NI CRED

DCR Keys

Each DCR should be assigned to a DCR key configuration. If sites have a mix of DCRs
with and without alphanumeric capabilities, sites would require to create 2 or more
DCR key configurations.

91



Configuration Client Screens

The configuration for DCRs that are alphanumeric should have the “Enable
Alphanumeric” checked, and NOT checked for the DCRs that only accept number
input.

Use to configure DCR keys for the different DCR positions.

DCR Keys Configuration

Add [ ]Delete
W Label |F\IphaNumeric |
Non-Alphalumeric Enable Alphanumeric
#Rows |4~  #Columns |5 .
NA NA
NA NA
NA NA
NA NA
Add Click Add to configure new DCR Keys layout.
Delete Select to delete the selected DCR Keys layout.
Label Label the new DCR Keys layout.
The configuration for DCRs that are alphanumeric should
Enable have the “Enable Alphanumeric” checked to use the
Alphanumeric alphanumeric keys layout. This field should NOT be

checked for the DCRs that only accept number input.
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Click assign positions and select the DCR that can be
used for entering alphanumeric characters. The DCRs

Assign Positions that do not have alphanumeric capabilities are grayed

out.
#Rows Number of rows for the DCR Keys layout.
#Columns Number of columns for the DCR Keys layout.

Select to assign the DCR Keys layout to the DCRs in the

Assign Positions site.

Note: Click on the keys to configure the values.

DCR Idle Screen

The DCR Idle Screen Configuration form is used to set up what displays on the DCR
screen when not in use.

DCR lIdle Screen Configuration

Add  [Delete

Name [Defaul Graphic Enabled (1 | Assign Positions

DCR Non-Graphic Idle Screen

Text Line 1 Lk

Texttine2 [ ]

TextLine3 | |

Text Line 4 L |
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DCR Idle Screen Configuration

Select the |dle Screen Mode

[ Attended Idle Screens

Screent

'y

|E| O Delete

-] Name |ScrEen1 | Graphic Enabled | Assign Positions

—DCR Graphic Idle Screen

Add Click Add to configure new DCR idle screen.
Delete Select to delete the selected DCR idle screen.
Name Enter a name for the DCR idle screen.

DCR Non-Graphic
Idle Screen

These are the text lines that the user would like to
appear on a Non-Graphic DCR’s Idle Screen.

= If it’s a 4-Line display DCR, then the 4 configured
lines would appear on the screen on one-line
each.

= If it’s a 2-Line or Single-Line display DCR, then the
4 lines could scroll one after the other in that
order.

Graphic Enabled

Select if the DCR has a Graphic Keypad. If this field is
disabled, the panel below would show the “DCR Non-
Graphic Idle Screen” configuration. If it is enabled, it
would show the “DCR Graphic Idle Screen” configuration.
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If the “Graphics Enabled” is selected, the Graphic Idle
Screen configuration opens.

The Left and Right keys allow the user to configure what
is displayed on each of the keys.

The middle lines provide the user the option of
displaying some lines in the middle for the top two rows
and use the bottom 2 rows for the keys. If the Middle
Text Line is configured, the keys on those lines are not
DCR Graphic Idle | displayed on the DCR.

Screen
On clicking each of the key buttons, the following pop-
up to configure the key is displayed.

= Softkey Type: Tags the key text to one of the
pre-defined types.

= Softkey Text: The text that is displayed for this
key on the DCR. After the text is entered here,
the text next to the button changes to reflect this
text.

Select to assign the DCR idle screen to the DCRs in the

Assign Positions site.

Outdoor TAVE

The TAVE (Trans Amor Verifone Edition) system minimizes the flow of unencrypted
payment card data within the POS system by performing end to end encryption.
Payment card data is encrypted by TAVE enabled card readers both at the dispenser
and inside the store. Card data is encrypted by these devices and passed to the First
Data front-end processor in encrypted form for authorization. The First Data front-
end processor decrypts the payment card data and sends the data to the issuing bank.
A token is linked to the authorization and sent back to the Verifone POS. The
VeriFone POS stores this token and uses the token instead of unencrypted payment
card data for all subsequent processing.

Enable the feature at Config Client > Forecourt > DCR > Site Configuration > Enable
Outdoor TAVE.
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Promos and Discounts Forecourt Devices Payment Controller Reporting Tools

Fuel 4
DCR
DCR Keys

DCR Idle Screen

TAVE Status
Outdoor TAVE 4 Registration Status

Cash Acceptor Register DCR
Fuel Tax Exempt Advance DCR Key

F{apld Change Fuel Conﬂg Update DCR SBﬂings
Unattended DCR

Initialization b

The Outdoor TAVE Config Client forms is limited to setting up and sending
configuration commands to a DCR.

The commands are:
e Register DCR - Enables encryption on a TAVE capable DCR (GVR CRIND).
e Advance DCR Key - Increments the DCR derived encryption key.
e Update DCR Settings - Installs VeriShield Crypto Library (VCL) settings.
Register DCR
Enables encryption on a TAVE capable DCR (GVR CRIND).

TAVE Regisiration

Select the DCR to Register

Ok Cancel

Configuration Manager
t. Register Command Sent Successfully

Ok
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Advance DCR Key
Increments the DCR derived encryption key.

TAVE Advance Key
Select the DCR to Advance

AlIDCRs v

Ok Cancel

Configuration Manager
ti Increment Command Sent Successfully

Ok

Update DCR Settings
Installs VeriShield Crypto Library (VCL) settings.

TAVE Update Settings
Select the DCR to Update

Ok Cancel

Configuration Manager
0 Update Command Sent Successfully

Ok

Registration Status

Shows the Outdoor TAVE registration status of the DCRs.
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—DCR TAVE Registration Status
DCRID TAVE Status
1 Registered
2 Registered
3 Registration Not Attempted
4 Attempted:Host Down
5 Attempted: Not able to communicate to host
6 Registration Not Attempted
7 Registration Not Attempted
8 Registration Not Attempted
J K 1-8of64 *» M

Cash Acceptor

The Cash Acceptor Configuration form is used to set up and edit cash acceptors at the
site. Site Information determines the behavior of all cash acceptors at a site.
Attributes determines the behavior of a specific cash acceptor at a specific fueling

point.

Select the Cash Acceptor on the list on the bottom of the form, then select the value
check boxes that are applicable for that Cash Acceptor.

Cash Acceptor Configuration

Cash Acceptor Site Information

[pisable If Cheated [Js1 Bill Enabled
[ oisable it Paper Low sz Bill Enabled
[pisable If No Printer [Is5 Bill Enabled
DF'rt:mp! insart cash’' [Js10 Bill Enabled

Timeout[Seconds 10-28] |10

Cash Acceptor Aftributes

Cash Acceptor I 1 b

=20 Bill Enabled
[Jss0 Bill Enabled
[Js100 Bill Enabled
[gin orientation

# | Duplicating Acceptor 1

b @ R

. Select target Acceptors to the left

Use the Cirl key to select multiple acceptors

. Use the Shift key to select a range of acceptors
. Click the "Duplicate™ button

Duplicate

[ cash Acceptor In Dispensar
[ Reset Printer Emor
[ Print Totals Now

98



Commander Site Controller User Reference

Disable If Select to turn off a cash acceptor when someone tries to
Cheated cheat it.

Disable If Paper Select to turn off a cash acceptor if the receipt tape is
Low running out.

Disable If No Select to turn off a cash acceptor if the printer is not
Printer working.

Prompt ‘insert Select to have the phrase “OR INSERT CASH” appear at
cash’ the end of the idle prompt.

$1 Bill Enabled Select to allow acceptance of one-dollar bills.

$2 Bill Enabled Select to allow acceptance of two-dollar bills.

$5 Bill Enabled Select to allow acceptance of five-dollar bills.

$10 Bill Enabled Select to allow acceptance of ten-dollar bills.

$20 Bill Enabled Select to allow acceptance of twenty-dollar bills.

$50 Bill Enabled Select to allow acceptance of fifty-dollar bills.

$100 Bill Enabled | Select to allow acceptance of one hundred-dollar bills.

This parameter does not apply to Tokheim dispensers.

Select to require that bills are inserted face-up with the
black-seal end first.

Bill Orientation (If not selected, bills can be inserted face-up in either
direction.)

Note: The black seal appears on the front of the bill to
the left of the face.

Enter the time (in seconds) between when a customer
inserts a bill and when the pump shuts off if no fuel has
been pumped (10 - 99).

Timeout [Seconds
10-99]

99



Cash Acceptor
Attributes -

Cash Acceptor

Configuration Client Screens

Select the number of the fueling point.

Duplicate
Acceptor

Click to copy the current cash acceptor’s attributes to
any number of other cash acceptors. In the Duplicating
Acceptor form, select the cash acceptor(s) to which you
want to copy and click Done Duplicating.

Cash Acceptor In
Dispenser

Select to indicate that the fuel pump has a cash
acceptor.

Reset Printer
Error

Note: This parameter is not currently supported.

Select to enable the printer after the cash acceptor has
been disabled and brought back online.

Print Totals Now

Note: This parameter is not currently supported.

Select to print the amount of money in the cash
acceptor.

Fuel Tax Exempt

The Fuel Tax Exemption Configuration form allows taxes to be removed from a post-
pay fuel sale by setting up one to five fuel tax exemptions. Each exemption can either

be setup by the Amount Per Gallon or the Tax File Entry that is setup in Store

Operations > Payment > Tax Rates, or Both.

The Fuel Tax Exempt Receipt Lines section is used to enter up to four lines of text

that you want to print on the header of Fuel Tax Exemption receipts.
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Fuel Tax Exemption Configuration

Delete
Fuel Tax Exempt Config

Fuel Tax Exempt Record

1- UNUSED 4 Name |UNUSED
Amount |0.000

Type | Amount Per Gallon

Signature Line []

Fuel Tax Exempt Receipt Lines

Fuel Tax Exempt
Record

Select a record number.

Delete Select to delete the selected fuel tax exempt record.
N Enter a name for the fuel tax exemption. The name
ame .
appears on receipts and reports.
Amount Enter the dollar amount per gallon of tax (0.000 -
99.000)
Select the tax type to exempt:
Amount Per Gallon - The dollar amount per gallon.
Type Tax File Entry - Taxes applied in Store Operations >

Payment > Tax Rates.

Both - A combination of Amount Per Gallon and the tax
rates entry that is setup in Store Operations > Payment >
Tax Rates.

Signature Line

Select to print the receipt with a signature line to certify
the customer’s eligibility for the tax exemption.

Fuel Tax Receipt
Lines (1 - 4)

Enter up to four header lines for the fuel tax exemption
receipt (alphanumeric, 1 - 10 characters).
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Rapid Change Fuel Config

Rapid Change Fuel configuration is configured from Forecourt > Rapid Change Fuel
Config.

This feature allows the cashier to change the pump’s service level and auto approval
rapidly at the pump using the POS without having to change the fuel configuration
using Commander Configuration Client or without manager intervention.

Rapid Change Fuel Configuration

[IDelete
Select Rapid Change Fuel Name

S
'RCF‘“ — Fueling Positions & Attributes
gg Fueling Position Service Level Auto Approval o
05 1 SELF ENABLE |v|

N
© e N @ ;A W N

[
=]
=

Lel [l el [ [l el [<] [< | L [<] <]

Ll el e [ [l Ll [ e [<] <

To change the fuel configuration level from the POS, the cashier should access CSR
Functions > Fuel Manager > Rapid Change Fuel Configuration.

Unattended DCR

Note: Refer to the Unattended Fueling feature reference documentation for
information on this feature. The Feature Reference is available on The
Feature Reference is available on Premier Portal.

Allows a site to have the Forecourt run unattended while the C-Store is closed.

Unattended DCR Configuration

Unattended mode IDisabIed v Cash receipt message
Start time m Line 1 |
Number of hours IO M Line 2 |

Help message 1 |

Line4 |
Line5 |

Help message 2 |

Disable Cash Acceptor [ ]

|
|
Line3 | \
|
|

Ignore eSign offline [
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Unattended mode

Enabled - Enable now
Disabled - Disable

Scheduled - Select and enter the start time and number
of hours the site runs unattended in the next two
parameters.

The Scheduled option is the one that uses the Start Time
and Number of hours. They should be ignored for the
other two options.

Start time

Select the start time of the unattended mode.

Number of hours

Select the number of hours from the start time the
unattended mode is enabled.

Help message 1

Two configurable help messages of up to 80 characters
that is displayed when HELP key is pressed during idle.

Help message 2

Two configurable help messages of up to 80 characters
that is displayed when HELP key is pressed during idle.

Disable Cash

Acceptor Use to disable the cash acceptor at the dispenser.
Handles price changes if the Fuel Price Display

Ignore eSign (electronic sign for fuel prices) is offline. If the

Offline parameter is checked, the fuel prices will change if the

sign is offline. If unchecked, the fuel prices will not
change if the sign is offline.

Cash Receipt
Message

Includes five configurable receipt lines of up to twenty
characters each for cash acceptor underrun instructions.

Devices

Car Wash

Refer to Car Wash Configuration

Car Wash Paypoint
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Note: Refer to the Car Wash Pay Point feature reference documentation for
information on this feature. The Feature Reference is available on Premier
Portal.

Tank Level Sensor

The TLS Configuration form is used to set up and edit Tank Level Sensor Parameters.

TLS Configuration

Low Limit Alarm [

LInit of Measure Gallons hd

Low Limit Alarm Select to turn on the TLS low-limit alarm.

Select the unit of measure for which the TLS is
Unit of Measure configured — Gallons or Liters. (The unit of measure
appears on the TLS reports.)

Enter the number of gallons or liters that fuel tank totals

Tank Variance can vary from the actual amount (0 - 999).

Electronic Check

The form is used to configure E-Check parameters.

104



Commander Site Controller User Reference

E-Check Configuration

Merchant

— Transaction

Merchant ID ‘0 ‘ IP Address I:H:“:“:l
Merchant Name ‘ ‘ Port Number ICl
Address ‘ ‘
oy sae| | | |mase
Merchant Phone l:| Processor Phone l:| Host Name/IP l:l
Port Number D
Upload Check Image
 Trailer
Trailer Line1 ‘ ‘Tra\ler Line3 ‘ ‘
Trailer Line2 ‘ ‘Tra\lel Line4 ‘ ‘
~Misc Limits
Allow Dual ID Swipe Prompt Dual ID Floor Limit
Date Of Birth Prompt  [] .
Check Writer Name Prompt [ Phone # Prompt Limit
. Supplemental ID Prompt  []
Check Writer Address Prompt  [] Response Timeout
- Offer Customer ECA  []
Check Writer Initials Prompt [ Close Period |2 |+

Merchant

Merchant ID

Enter the merchant ID number assigned by the network.
(alphanumeric up to 24 characters. Space and special
characters are not allowed)

Merchant Name

Enter the merchant name. (alphanumeric up to 40
character) (Space are allowed but not at start and end)

Enter the Address to print at top of all receipt.
(alphanumeric up to 40-character, special characters are

Address allowed) (no restriction)
Enter the city to print at top of all receipt.
Cit (alphanumeric up to 30 character) (Space are allowed
y but not at start and end)
State Enter the state code. (alphabetical up to 2 character)
Enter the zip code. (alphanumeric up to 10 characters ,
Zip dash and space are allowed but not at starting and end

positions)

Merchant Phone

Enter the phone number to print at the top of all receipt
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(numeric 0-15).

Processor Phone

Enter the check approval host's phone number that prints
on the receipt. (numeric 0-15)

Transaction

IP Address

Enter the IP Address that the host uses for transaction
approval request

Port Number

Enter the port number that the host uses for transaction
approval request. (Non-Negative value with max
999999999)

Upload Check
Image

When an Electronic Check payment is processed, a copy
of the check image is captured by default, temporarily
stored on the Site Controller and then uploaded to the
check image server. When disabled, the check image is
not captured or uploaded.

Image

IP Address

Enter the IP Address that the host uses for image
uploading to copy the image of the check.

Port Number

Enter the port number that the host uses for image
uploading to copy the image of the check. (Non-negative
value with max 999999999)

Trailer Line 1-4

Enter the text of the first, second, third and the fourth
line that prints on bottom of the receipt. (alphanumeric
up to 40-character, Space are allowed but not in starting
position)

Misc

Allowed Dual ID Select to prompt for a proof of identification from the
Swipe Prompt check writer.

Check Writer

Name Prompt

Select to prompt for the check writer's name.
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Check Writer
Address Prompt

Select to prompt for the check writer's address.

Check Writer
Initials Prompt

Select to prompt for the check writer's initials.

Date Of Birth
Prompt

Select to prompt for the check writer's date of birth.

Supplemental ID
Prompt

Select to prompt for a secondary proof of identification
from the check writer.

Offer Customer
ECA

Select to prompt the cashier to ask the check writer to
accept the use of an electronic check.

Limits

Dual ID Floor
Limit

Enter the dollar limit at which the check writer must
provide identification (0-999.99)

Phone # Prompt
Limit

Enter the dollar limit at which the check writer must
provide a phone number (0-999.99)

Response
Timeout

Enter the time allowed to wait for a reply from the host
(0-999)

Close Period

Select the period when the batch is closed.
o Period 1(Close Shift)

o Period 2 (Close Day)

Electronic Safe
Note: Refer to the Tidel Sentinel E-safe Interface feature reference
documentation for information on this feature. The Feature Reference is
available on Premier Portal.
The Electronic Safe (E-Safe) is available for use at sites with Commander and the POS.
An IP Connection to the safe hardware allows safe drop amounts to be retained and
totaled to compare with the total amounts in the safe upon shift or day close.

The reports available for the Electronic Safe are:
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amounts with amounts recorded on the Electronic Safe.

o E-Safe Day Report — (Generated at Shift or Day close) A report that reconciles
all cashiers’ safe drop amounts with amounts recorded on the Electronic Safe
for the period.

« E-Safe Content Report — A report that is generated whenever the safe is

opened. This time-stamped report, that lists the actual contents of the safe, is
stored on Commander and can be printed when required.

E-Safe Configuration

Site Parameters

Use E-Safe Only (V]
Close Period |1 j 1-CORPORATE |»| |1 : EXEC1

Safe Type | Tidel|™

Safe ID Mapping

Employee Safe D  Employee Safe ID

—Safe Configuration

Description  Tidel E-safe

Safe Port 4243
Safe P 192. 168. 031. 045

[ Delete

¥ Enable Device Type | Tidel ECND j

Gafe Subnet 285, 285, 285. O
Safe Gateway 192. 168. 031. 031

Use E-Safe Only

Select if all safes at the site are interfaced with the POS
system.

Do not select this parameter if safe drops will be made
to a safe that is not interfaced with the POS system.

Close Period

Select the period when the Electronic safe is closed.
1 - Period 1 (Close Shift)

2 - Period 2 (Close Daily)

Safe Type

Select E-Safe manufacturer
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Employee — From the drop-down list, select an
employee who can make safe drops to the Electronic
Safe.

Safe ID Mapping Safe ID - Select the number of the Electronic Safe to be
configured.

Employee Safe ID — Enter the login ID that the selected
employee uses to access the Electronic Safe.

Click Add to add a new Electronic Safe number to be

Add configured.

Delete Select Delete to remove the selected Electronic Safe.

Select the Device Type installed at the site. The
following are the Tidel device types:

o BCD: Bulk Coin Dispenser

e BCD-R: Bulk Coin Dispenser and Recycler
Device Type
o BCND: Bulk Coin and Note Dispenser

e SCD: Sentinel Control Device

e Tidel Tube Vend

Select to enable the Electronic Safe. (The safe will not

Enable exchange data with the POS system unless it is enabled.)

Description Enter a recognizable description of the Electronic Safe.
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Safe IP — Enter the IP Address of the Electronic Safe.

Safe Subnet — Enter the Subnet of the Electronic Safe.

IP Information Safe Gateway — Enter the Gateway of the Electronic
Safe.
Safe Port — Enter the Port number of the Electronic
Safe.

Timeout (sec) Enter the communication timeout in seconds.

Fuel Price Display

The Fuel Price Display Configuration form is used to set up and edit the Fuel Price
Display sign to suit the requirements of the site.

After configuring or changing Fuel Price Display, initialize fuel prices for the changes
to take effect. To initialize fuel prices, select Forecourt > Initialization > Fuel
Prices.

Note: Make sure that your fueling positions are not in use when initializing
Fuel Prices.

Fuel Price Display Configuration

— Site Parameters — Product Mapping

Fuel Price Display Channel |1 . Fuel Price Display 1D |0 . Fuel Product |1 - UNLD1

Enable Channel []

Enable [] Senvice Level [1-SELF  [v]

Delay Pump [0-300 secs] l:l
Price Level [1-CASH [v]
Delay Sign[0-300secs] [ | rice Level V]
Implied Decimal |3

— Fuel Price Display Text

TextID Delete

|

L= - B T N R
Ooooooodood
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Site Parameters

Fuel Price Display
Channel

Select the fuel price display channel.

Enable Channel

Select to enable the Fuel Price Display feature.

Delay Pump (0 - 300
secs)

Use to delay sending the price to the Pump.

Note: Delay Pump and Delay Sign parameters are
used to make the changed price appear
simultaneously at both places if one network is
slower than the other.

Delay Sign (0 - 300
secs)

Use to delay sending the price to the Fuel Price
Display.

Note: Delay Pump and Delay Sign parameters are
used to make the changed price appear
simultaneously at both places if one network is
slower than the other.

Product Mapping

Fuel Price Display
ID [0-9]

Select the ID number that maps to the fuel price line
on the Electronic Sign and then select Enable. (Follow
the Fuel Price Display sign manufacturer’s guidelines
for IDs.)

Note: The fuel prices that display is set in Forecourt >
Fuel Prices. If tier pricing is in effect, the Fuel Price
Display price is the current tier price.

Enable

Select to enable Fuel Price Display.

Fuel Product [1-9]

In the Fuel Product list, select only the fuel product(s)
to be displayed for the fuel price display ID.

Service Level

Select the service level — Self, Full, Mini.

Price Level

Select the price level — Cash, Credit, Check.

Implied Decimal [O-

For most U.S. sites, select 3. For information, see the
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5] Verifone bulletin for your Fuel Price Display sign.

Enter text to display on the Fuel Price Display sign
Fuel Price Display (alphanumeric, up to 128 characters). HTML text
Text - Lines [0-9] attributes may be used. For information, see the
Verifone bulletin for your Fuel Price Display sign.

Delete Select to delete a line.

Fuel Price Display Initialize

Fuel Price Display Initialize should only be used after the sign has been repaired or if
it is displaying pricing errors after losing power. In these cases, do the following:

Devices > Initialization > Fuel Price Display

Vending Machine

Note: This feature is no longer supported.

Attendant Payment Terminal

Attendant Payment Terminal (APT) is a mini-POS used in the forecourt.

Use Devices > Attendant Payment Terminal to configure APT.

Note: Refer to Attendant Payment Terminal (APT) reference documentation for
;’;’Z;)tranl'l'ation on this feature. The Feature Reference is available on Premier

Global

This form is used to enter the configuration that is valid for all APT terminals.
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Attendant Payment Terminal

Login for Every Transaction []

Login Timeout (1-15 minutes)

Cash Receipt Required []

Preset Security Level |0 .

Edit
Enabled Payment Codes

Edit
Enabled Departments

Login for Every

Enable to login for every transaction. Default value =

Transaction Disabled.
Login Timeout (1-15
minutes) The time a login lasts. Default value = 10 min.

Cash Receipt Enable to print cash receipts. Default value = Enabled.

Required
Preset Security Security level of the user who can login to the
Level terminal. Default value = ‘0’.

Click Edit button to select the payment codes

Enabled Payment supported. Default value = All Payment Codes

Codes enabled.
Enabled Click Edit to select the departments selected. Default
Departments value = All departments disabled.

Terminal

Use the form to enter each terminal detail.
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Attendant Payment Terminal Save | Cancel
Terminal
— Terminal 1D — Parameters

|152 . Fueling Positions
— Receipt Header/Traller —— PinPad Type

Receipt Header Alignment

| | [Left —Allowed Operations

| | ILeﬂ Merchandise [ ]

| | [Left Preset Fuel [

| | [Left Postpay Fuel []

| | |Leﬂ Preauth Fuel []

Receipt Trailer Alignment Bl STl (W

| | [Left

| | [teft

| | et

| | [Left

| | [Left

Terminal ID Select the Terminal ID. The external POS terminal IDs and

IPs are configured in Security > Manage devices.
Receipt . Enter details that will be printed on the receipt header and
Header/Trailer :

trailer.
Parameters

Click to attach fueling positions to the APT.

|
Assign Fueling Position(s)
Fueling Stations 1
(12
Save | | Cancel

PINpad type Select if the PIN pad for making payments is internal

or external.
Allowed Operations | Select the operations allowed using the APT
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Vista Devices

Note: Vista Devices CSC and CCW are not supported anymore.

Carbon Commander Workstation (CCW) is a POS application for retail shops
implemented on Carbon 10. The implementation leverages Commander Site
Controller’s capabilities for item management, payment and communication.

Use Devices > Vista Devices to configure CCW.

Note: Refer to CCW reference documentation for information on this feature. The
Feature Reference is available on Premier Portal.

Food Service

Note: Refer to all the iOrder reference documentation for information on this
feature. The Feature Reference is available on Premier Portal.

The Food Service form is used to configure the iOrder Kiosk connection parameters.

Food Service

—iOrder Configuration

iOrder P 192. 168. 31. 151
iOrder Port 5436
Send POS Food Orders to KDS [

—Food Service Payment (Notify Kitchen)

Notify Electronically [
Notify via Receipt [

Receipt Message Present to kitchen to pick up your order

iOrder Configuration

iOrder IP Enter the iOrder IP address

iOrder Port Enter the iOrder Port

Send POS Food Orders

to KDS Enable to send food orders to kitchen display system

Food Service Payment (Notify Kitchen)

115



Configuration Client Screens

Notify Electronically Enable to notify the kitchen electronically

Notify via Receipt Enable to notify the kitchen via receipt

Receipt Message Enter the receipt message

Payment controller

POS Configuration

Refer to Configuring Network Functions

Mobile Payment Configuration

Note: Refer to the Mobile Payment feature reference documentation for
information on this feature. The Feature Reference is available on Premier
Portal.

EPS Prepaid Configuration

The EPS Prepaid Configuration form is used to configure prepaid cards, PIN-based
products, and money transfer cards.

o Prepaid card (Stored value card or SVC) - A cash value is placed on the card,
which can then be used for purchases until the cash value is used up. The card
may be recharged with additional cash value.

e PIN-based product - The customer buys the PIN-based product and uses the PIN
(Personal Identification Number) printed on the receipt or card to activate the
product.

e Money transfer card - The customer presents the card and cash at the site,
designates the payee by number, and the electronic payment is made.
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EPS Prepaid Configuration

—Prepaid Network:

Network Name inmmm:

Enabled

— Prepaid Departments

Department Erabled | T2 m
Validate Level
IMANUAL FUEL DEPT : O FE[
" [
H 4 q1320f2 * M
Add | Delete

Select the InComm in the Network Name dropdown menu.

Check the Prepaid Enabled box.

Click Add.

Select the appropriate prepaid department from the Department dropdown

list.

Check the Enabled and/or Pre-Validate boxes.

o The Enabled check box is used to enable or disable the prepaid

department.

o The Pre-Validate check box is used to specify whether an InComm Pre-
Authorization Request needs to be sent to the host when selling items
from a prepaid department. The Pre-Authorization Request is used to
verify whether the actual transaction can be successfully completed

before the payment is tendered.

6. Click on Reprint Security Level column to set security levels for reprinting the
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receipt at the POS.

—Prepaid Network Messages

Show Guideline

Please ensure you are following
AML fraud guidelines by not
selling more than $1900.00 in
cards to one customer - The limit
is $999.00 in the state of
Arizona.

Show Purchase

Is this purchase being
made by someone on site?

Show Cancel

PIN numbers are never to
be given to anyone over
the phone - NO
EXCEPTIONS!
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7. Three types of message prompts is displayed to cashier during prepaid card
activation / recharge process:

Guideline message prompt: Guideline Prompt when enabled, prompts
the cashier when a prepaid card activation item (ProdCode: 560 to 575)
is added to the ticket. This message instructs the cashier to follow
guidelines to avoid fraud. Default message for guideline prompt is
“Please ensure you are following AML fraud guidelines by not selling
more than $1900.00 in cards to one customer - The limit is $999.00 in
the state of Arizona.”

Purchase message prompt: Purchase Prompt when enabled, prompts
the cashier if PIN Activation item (ProdCode = 560) is added to the
ticket. Purchase prompt appears after the Guideline Message Prompt if
guideline prompt is enabled. Purchase prompt is to instruct the cashier
not to give PIN numbers for prepaid cards over the phone. The Purchase
prompt has YES and NO buttons. If cashier responds YES, then PIN
Activation item can be added to the ticket. If cashier responds NO, then
PIN Activation item is not allowed for sale and the item is removed from
the ticket with an error message. Default message for purchase prompt
is “Is this purchase being made by someone on site?”

Cancel message prompt: When cashier responds with a NO to the
Purchase Prompt, the PIN Activation item is removed from the ticket and
Cancel Prompt message (if enabled) is shown to the cashier. This prompt
is to inform cashier that the item is being removed as it cannot be sold.
Default message for Cancel Prompt is “PIN numbers are never to be
given to anyone over the phone - NO EXCEPTIONS!”

Click Save to save the configuration.

Third Party Product Configuration

Third Party Product Configuration feature provides the ability to support financial
transaction services provided by the Cullinan Group.

Note: Refer to all the Cullinan Feature Reference documentation for information
on this feature. The Feature Reference is available on Premier Portal

EPS Configuration
EPS Global Configuration

Trigger Pull Configuration
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The Trigger Pull Function allows the host network to access the site any time for
debug, support or application update.

EPS Global Configuration
20 0 T I v v comprnen

Local Configuration

Merchantip [ |
companyo [ |
Terminaib [ ]
Update Available Timeout (minutes)
Update Download Timeout (minutes)

Remove Pending Update on Manual Trigger Pull  []
Display Alarm on POS on Manual Trigger Pull  []

Update Location

Service End Point | |

Passcode | |

Communication Options
Mode

®p
Dial

The Merchant ID is given to the store by the network

Merchant ID and is part of the terminal identification number.
Company ID The Company ID is given to the store by the network
pany and is part of the terminal identification number.
Terminal ID Terminal ID number. This number, supplied by the
network is part of terminal identification number.
Update Available

Timeout (minutes)

Timeout for Update Available prompt.

Update Download
Timeout (minutes)

Timeout for update download.

Remove Pending
Update on Manual
Trigger Pull

When this option is enabled, any pending updates are
canceled prior to downloading the trigger file.

Display Alarm on
POS on Manual
Trigger Pull

When this option is enabled, any pending updates are
canceled prior to downloading the trigger file.
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Update Location

This parameter holds the URL for the web service that
provides the trigger files.

This parameter holds the password required by the
web service that provides the trigger files.

Service End Point

Passcode

Communication Options

IP The communication is through an IP network.

Dial Not applicable

Full-Service Attendant Configuration

Note: Refer to the Full-Service Attendant feature reference documentation for
information on this feature. The Feature Reference is available on Premier
Portal.

FEP

Use this tab to enable Full-Service Attendant (FSA) cards.

FullServiceAttendant Configuration

& Edits require a one-time password (OTP)

Nat
— Metw

FEP Enabled [+

— FEP Parameter

Kay Index 0

1. Select FEP Enabled
2. Click Save

FEP Card

Use this tab to configure each FSA cards.
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FullServiceAttendant Configuration Save | Cancel

m FEP Card

Add  [Jpelete
Select Card

I, - ||| C Informaten

Card Table Index |FSA1

Card Abbrevation |FS

‘ Card Name |Attendant1
Lower ISO 110229000
Upper ISO  |110299300

Pan Length |13
Card Enabled

The record number of the FSA card. This number cannot be
Card Table Index
changed after a card has been saved.

Card Abbreviation Enter card Abbreviation.

Card Name The name of the FSA card.

Lower ISO Enter the Lower ISO of the card; given by the card provider.
Upper 1SO Enter the upper ISO of the card; given by the card provider.
Pan Length El:és:dtehf Pan Length of the card; given by the card

Card Enabled Select to accept the FSA card at the DCR.

InComm Configuration

Note: Refer to the InComm Configuration feature reference documentation for
information on this feature. The Feature Reference is available on Premier
Portal.
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9.
10.Enter Fallback Dollar Limit (50-9999).

11.Enter SAF Retry Interval (1-15 Minutes).

InComm Configuration

Network

FEP Enabled

Communication Options

Mode Communication Options

|P Address (IPV4 Format) | 12

Port
Secondary IP address (IPV4)

Secondary IF Port

FEP Parameters

Store ID.
Print Gift Receipt | NEVER

Enter Store ID.

. Check FEP Enabled.

Enter Terminal ID.

. Enter Dealer ID.

Enter IP Address (XXX.XXX.XX.XX).

Enter Port Number (XXXX).

Enter Fallback Transaction Limit.

Configuration Client Screens

Enter Gift Receipt Printing Option: Never, Always, Prompt Cashier

Enable Fallback (Y/N): The EPS prompts the enabling or disabling of
Fallback Processing. Fallback involves a stand-in approval of activations
in the event of network connectivity failure with the InComm host. After
connectivity is established, the stored transactions are sent to the host
when a response is received or a Daily Close is performed. Timeout
reversal will be always supported.
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12.Enter SAF Retry Limit.
Note: Zero means retry indefinitely.
13.Click Save to save the configuration.

FEP Card

InComm Configuration

| FE ;._j FEP Card E:\,

Add

Select Card
Card Information

Card Table Index
Card Abbreviation
Card Name
Lower ISO
Upper ISO
Pan Length
SendTrack | 'Dont Send -t.:
SendTrackll | Dont Send
Card Enabled

Refund Alicwed

1. Click Add
2. Enter Card Abbreviation
3. Enter Card Name
4. Enter Lower ISO
5. Enter Upper ISO
6. Enter Pan Length
7. Enter Send Track 1 Option: Dont Send, Send Primary, Send Secondary
8. Check Card Enabled to enable the card
9. Check Refund Allowed to allow refund on the card
10. Click Save to save the configuration
Payware Fleet Configuration

This form is used to enable and configure Payware Fleet Card transactions.
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FEP Qyaeci]
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—Network:-

FEP Enabled []
Dealer ID |000000000012345
Terminal ID 00000001
Acquirer ID |00000000001

— Communication Opti

Mode-

Communication Options:

P
Serial IP Address/Domain Name |192.168.31.205
(i Port (4135

Enable SSL

—FEP P;

Brand 5
Transport Protocol Data Unit | 6000010000
Net International ID 003

—NACS to Payware Product

D NACS Code Product Name PW Host Code

K4 1400 » ¥

Add  Delete

Network

FEP Enabled

Select to enable the network.

Enter the merchant ID number (alphanumeric, up to 11

Dealer ID characters).

Terminal ID Enter the terminal ID

Acquirer ID Enter the acquirer ID
Communication Options

Mode Select the physical connection.

IP Address/ Domain
Name

Enter IP address.

Port

Enter port number.

Enable SSL

Select to enable secure communication.

FEP Parameters
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Brand Enter brand code.

Transport Protocol Enter TPDU (Transport protocol data unit). The default
Data Unit value is “6000010000”.

Net International ID | Read-only value used for troubleshooting.

NACS to Payware Product Mapping

ID Auto generated

NACS Code Enter NACS code

Auto generated on save depending on the NACS Code

Product Name
entered.

PW Host Code Map the Payware host code to NACS code

FEP Card

(78 FEP Card

Add Delete

Select Card -
—Card Information

Card Table Index

Card Abbreviation I:l
Card Enabled
Card Enabled |BOTH
Accept Manual Entry  []

—Card Limits

Print Customer Name []

Fiscal Receipt Enable [ ]

Signature On Financial Advice [ ]
Max Value For Pump Auth l:l

Driver ID Prompt Enable []
DriverIDMaxlength ||
DriverIDMinlengh [ |

Vehicle ID Prompt Enable []
Vehicle IDMaxLength [ |
Vehicle IDMinlength | ]

Odometer Prompt Enable [
Odometer Max Length l:l
Odemeter Min Length l:l

—PAN Mask Configuration

Starting Visible Characters l:l
Ending Visible Characters l:l
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Enter the abbreviated proprietary card name.

Card Name

Enter the proprietary card name.

Lower ISO

Enter the lower beginning digits that identify the
proprietary card.

Note: If only one number is provided, add a ‘O’ to the
end. For example, XXXXXXO0.

Upper ISO

Enter the upper beginning digits that identify the
proprietary card.

Note: If only one number is provided, add a ‘9’ to the
end. For example, XXXXXX9.

PAN Length

Enter the total number of digits embossed on the card.

Card Enabled

Select to enable the selected proprietary card.

Manual Entry
Allowed

Select to allow the account number to be entered
manually.

Card Limits

Print Customer
Name

Select to print customer name.

Fiscal Receipt
Enable

Select to enable fiscal receipt.

Signature on
Financial Advice

This parameter only applies to indoor prepay
transactions. If enabled, the prepay receipt is not be
printed at the time of prepay. A prompt instructs
consumer to go inside for the receipt after fueling.

Max Value for Pump
Auth

Enter the maximum value for pump authorization.

Driver ID Prompt

Select to enable driver ID prompt.
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Enable

Driver ID Max

Length Enter driver ID maximum length; 1-12

Enter minimum length for Driver ID; 0-12. 0 means

Driver ID Min Length )
optional

Vehicle ID Prompt

Enable Select to enable vehicle ID prompt.

Vehicle ID Max Enter vehicle ID maximum length; 1-8.

Length
Vehicle ID Min Enter vehicle ID minimum length; 0-8. 0 means
Length optional.

Odometer Prompt Select to enable odometer prompt.

Enable
Odometer Max Odometer min len = 0-6, max len = 1-6, Min default =0
Length (0 min means optional), Max default = 6
Odometer Min Odometer min len = 0-6, max len = 1-6, Min default =0
Length (0 min means optional), Max default = 6

PAN Mask Configuration
Starting Visible Specify the PAN masked in receipts. More than first 6
Characters or last 4 digits can’t be exposed.
Ending Visible Specify the PAN masked in receipts. More than first 6
Characters or last 4 digits can’t be exposed.
Loyalty Configuration

This form is used to enable and configure Loyalty Cards.
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Note: Refer to the Loyalty Sales feature reference documentation for
information on this feature. The Feature Reference is available on Premier

Portal.

Proprietary Fleet Configuration

Note: Refer to the Proprietary Fleet Configuration feature reference
documentation for information on this feature. The Feature Reference is
available on Premier Portal.

FEP

S = FEP Card

Proprietary Fleet Configuration

ﬁ Edits require a one-time password (OTP)

Save | Cancel

—MNetwork

FEP Enabled K|

Dealer ID |9999780

— Communication Options

Mode

®p
O Serial

Communication Options

IP Address (IPV4 Format) | || [ ][ ]

Dial Port D
Enable SSL []
—FEP Parameters
Department (/]
Misc1 |
JobID R/
Driver License |
Vehicle ID W]
Driver ID ]
Misc2 [/
QOdometer V]
Last 4 digits of Accnt Num v
Signature Line on receipt [/

FEP Enabled

Select to enable the proprietary network.

Dealer ID

Enter the merchant ID number assigned by Mannatec
(alphanumeric, up to 11 characters).
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Communication Options

Mode Select the communication mode; whether IP or Serial.

Serial Mode - Communication Options

Serial Port Select the Serial Port that is being used.
Baud Rate Select the baud rate used by Mannatec.
Bits Select the Bits.

Parity Select the Parity.

Stop Bit Select the Stop Bit.

IP Mode - Communication Options

IP Address/ Domain Enter IP Address or domain name.

Name
Port Enter port number.
Enable SSL Select to enable SSL.

Select the list of prompts that appears for the user to
verify themselves. If the check box is enabled for a
prompt, then the prompt data that the user gives is
printed on the Receipt.

FEP Parameters
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WELCOME TO
CUR STORE

300 5. Park Place
Clearwater, FL 33759

FE12008179001
Description QrY Amcunt
Tmmr 1 s
Sub Total | 5.00
Tax 1.00
TOTAL 5.00

CREDIT & 5.00

Intevacen & 5.00

Accr/Card #: 000DNCOONN0OKK01T9
Ref: 00100010003

Resp Code :300

Stan: 000176

SITE ID: 999765

Odometer: 765432
Vehicle:345678

SIGNATURE

I agree to pay the amount stated
on this receipt

THANK YOU FOR COMING

PLEASE COME AGATN

5T# AB123 TILL XXXX DR# 1 TRAN# 1010004
C5H 1 04/13/15 14:29:58

FEP Card

Proprietary Fleet Configuration

6 Edits require a one-time password (OTP)

FEP Card

Add Delete

Select Card .
— Card Information

Card Table Index

S —
Corttome ||
e —

Upper 1ISO

I —

Card Enabled []

Accept Manual/Scanned Entry [ |

— Card Limits

T

Card Abbreviation Enter the abbreviated proprietary card name.

Card Name Enter the proprietary card name.
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Enter the lower beginning digits that identify the
proprietary card.
Lower ISO
Note: If only one number is provided, add a ‘0’ to the
end. For example, XXXXXXO0.
Enter the upper beginning digits that identify the
proprietary card.
Upper ISO
Note: If only one number is provided, add a ‘9’ to the
end. For example, XXXXXX9.
PAN Length Enter the total number of digits embossed on the card.
Card Enabled Select to enable the selected proprietary card.
Accept Select to allow the account humber to be entered
Manual/Scanned . .
E manually or scanned instead of swipe.
ntry
Enter the maximum credit transaction dollar amount
DCR Auth allowed at the DCR for this proprietary card.
(Authorization)
Amount Note: If the amount reaches the DCR limit, the pump
automatically shuts off.

EZ - Receipt Configuration

This feature enables everyday customers to opt for getting receipts emailed instead
of printed after a transaction.

Note: Refer to the EZ - Receipt feature reference documentation for more

information on this feature. The Feature Reference is available on Premier
Portal.
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EZ - Receipt Configuration

EZ-receipt Configuration

EZ - Receipt Enabled []
EZ - Receipt Activation Status  Active
Send EZ - Receipt Prompts to Cashier [ |

EZ - Receipt :

Enabled Select to enable EZ - Receipt

Send EZ- Receipt Select to get the EZ-Receipt Prompt on the POS in
Prompts to Cashier | addition to the PIN pad.

Reporting
Report Configuration

Refer to Report Configuration

Cashier Tracking

Refer to Cashier Tracking

Close Car Wash Paypoint Period

Refer to Close Car Wash Paypoint Period

Site Asset Data

Refer to Site Asset Data

Close Day Now

Refer to Close Day Now

Mobile Food Order Report

Note: Refer to the Mobile Food Order Feature Reference for more information on
the feature. The Feature Reference is available on Premier Portal.
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Tools

Rule Manager

Use to configure rules that automatically comply with corporate policies, laws, and
regulations, to limit the number of and amount of certain products that can be sold
over a period to a customer.

To open Rule Manager, click Tools > Rule Manager.

Rule Manager

Add | Cpelete
Select Rules

Name
01 - New Rule Active

New ol
02 - New Rule2 tevi Rule i
Scope Trigger Type

Transaction ¥ PLU i

Description Register Number
Mew Rule 678

Conditions

Where PLU is equal to [Must Modify to View List]

Add AND

Add OR

Actions

Avallable Actions

Edit

Set Atfributes

Rule Manager allows you to:
e Activate/deactivate a rule
o Reorder rules (move up, move down)
e Modify a rule
o Create a copy of a rule, rename it, and modify it
e Create a new rule
e Delete arule

o Set up fast food orders on POS. See “Fast Food Orders on POS.”
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Activating or Deactivating a Rule

To make a rule active or inactive

To activate a rule — Click the “Active” check box in front of the rule and click
Save.

To deactivate a rule — Clear the “Active” check box in front of the rule and
click Save.

Rule Manager

Add | [JDelete
Select Rules

01 - New Rule fame
— Hew Rule

02 - New Rule2

where PLU is equal to [Must Modify to View List]

Add AND

Add OR

Available Actions

Edit

Set Attributes

Creating a Rule

1.

2.

In Rule Manager, click Add.

Enter a name for the rule.

. Enter a description (optional).

Enter Register number.

. Select the scope of the rule:

o Transaction — The rule is evaluated at the time of sale.

« Line Item — The rule is evaluated when the item is entered as a line
item.

. Select the item that triggers the rule to be evaluated. Depending on the rule

you are modifying, select one of the following:

e PLU
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Department

Payment

Transaction Begin

Transaction End

5. Add conditions for the rule. Select the condition type from the drop-down list
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box.

Condition Type

Department
j Product Code
MOP
Quantity
Amount

Select the operator to apply to the rule.

Operator types “equal to, not equal to, and like” appear for “PLU,
Department, Product Code, and MOP” Condition Types.

Operator types “equal to, not equal to, greater than, less than, greater than or
equal to, and less than or equal to” appear for “Quantity and Amount”
Condition Types.

Operator Type

equal to

nat equal to
like

. Click “Edit” in Set Conditions section to select the PLUs or Departments or

MOPs.
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Rule Manager

Ada Delete

Select Rules

Name

Security Rule Active

Scope Trigger Type
Description Register Number

To Set Minimum Security L| 445

— Conditions
Condition Type QOperator Type
—Set Condition

Available PLUs

Edit

Save  Cancel

Or add the quantity or amount for Condition Types, “Quantity” and “Amount”.

Rule Manager

Delete
Select Rules
Name
Security Rule Active
Scope Trigger Type
Description Register Number
To Set Minimum Security L| 445
—Condition:
Condition Type Qperator Type
—Set Condition

Save | Cancel

8. Click Edit in Available Actions section to determine the actions that occur when
the rule is triggered, and the condition evaluates to true.
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Rule Manager
Add | O pelete
Select Rules
01 - New Rule pame
- New
Mew [ Active Copy
02 - New Rule2 few Rule 2
Scope Trigger Type
Transaction & FLU b
Description Register Number
New Rule 678
Conditions
Where PLU is equal to [Must Modify to View List]
Add AND
Add OR
Actions
Avallable Acticns
Edit
Set Attributes

9. The available actions are:
e Alert Cashier: When the rule is triggered, alert the cashier.
e Apply Blue Law: When the rule is triggered, apply a blue law.

Note: Blue Laws are set up in Store Operations > Restrictions > Blue
Laws.

e Apply ID Check: When the rule is triggered, apply an ID check.

e Apply Min.Security Level Check: When the rule is triggered, check if the
cashier has the minimum-security level to perform the transaction.

e Journal Event: When the rule is triggered, journal the event with a
message.

e Veto: When the rule is triggered, prevent the transaction from taking
place. For example, prevent a credit card MOP from being used when
lottery is in the transaction.

e Enter/Select POS Kitchen Printer: When the rule is triggered, send the
transaction to the selected kitchen printer.

e Send to Kitchen Display System via iOrder: When the rule is triggered,
send the transaction to the Kitchen Display System (KDS).
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e Add Receipt Message: When the rule is triggered, add a message on the
receipt.

e Change Receipt Header: When the rule is triggered, change the receipt
header.

e Add Item: When the rule is triggered, the selected menu key is
displayed.

e Restricted Department: Select to add a restricted department.

—Actions

Available Actions

Alert Cashier

App\y Blue Law

& Apply ID Check

App\y Min. Security Level Check

Journal Event

Veto

Enter/Select POS Kitchen Printer

Send to Kitchen Display System via iOrder
Add Receipt Message

Change Receipt Header

-

Select None | Select All Deone | | Cancel

10. Click Set Attributes to set actions for the selected action type.

Rule Manager
Add | [IDelete
Select Rules
01 - New Rule Hame
- New Rul -
i H Col
02 Now Rl MNew Rule [ Active %
Scope Trigger Type
|’ransacﬂcn v IF‘LU ¥
Description Register Number
Mew Rule 678
Conditions
Where PLU is equal to [Must Modify to View List]
Add AND
Add OR
Actions
Avallable Actions
Edit
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Rule Manager

Select Rules
Name
New Rule

Scope Trigger Type

Description Register Number
test 445

— Set Actions

Apply blue Law
Apply Security Level
B e |
Send to Kitchen Display System via iOrder [
Enter POS Kitchen Printer : Choose
Veto [
Receipt Message = Configure...
Change Receipt Header = Configure...
Add ltem | Configure...

Restricted Department [
Close

11.Click Close
12.In Rule Manager, click Save.
Modifying a Rule
Rules can be modified to change:
o whether they act on a line item or a transaction,
o which event triggers the rule,
« which conditions are in effect for the rule,

e which actions occur when the rule is triggered.

In Rule Manager, select the rule that you want to modify and click Modify.

Copying a Rule
The copy feature can be used to create the basis for a new rule.
To copy a rule and rename it:

1. In Rule Manager, select the rule.

2. Click Copy. The copy is added to the end of the rule list, with _0 appended to

the end of the original name.
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Deleting a Rule
To delete a rule

1. In Rule Manager, select the rule to be deleted.

2. Click Delete. The rule is deleted.
Fast Food Orders on POS
Note: Refer to the POS to iOrder Feature Reference documentation for more
information on this feature. The Feature Reference is available on Premier
Portal.
Note: Refer to the Kitchen Printer Feature Reference documentation for more
information on this feature. The Feature Reference is available on Premier
Portal.
A kitchen printer can be installed, and the Rule Wizard can be used to create a rule
that sends selected PLUs from the POS to the specific kitchen printer and prints a
receipt.

1. Create a new rule. See “Creating a New Rule.”

2. Follow the procedure to create the rule. See “Creating a Rule.” Set the
following attributes for the rule:

o Scope of the rule — Select Transaction.
o Trigger for the rule — Select Transaction End.

o Conditions — Enter PLUs for the rule and select “Like” as the operator to
apply to the rule.

e Action — Select Send to Kitchen Printer and click Add.

o Further define Action — Select or enter the name of the specific kitchen
printer.

3. Activate the rule. “See Activating or Deactivating a Rule.”
4. See “Store Operations > Menu Keys” to make the rule part of an Order Menu.
Entering customer name for food orders taken at POS

1. In Tools > Managed Modules:
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—_

Select Kitchen Printer Service as kp.svc.POS

g

Set System Hosting Kitchen Printer to ‘sitecontroller
3. Click on Advanced Settings
4. Select connection port and save
5. Check Enable Kitchen Printer Service and save
6. Click Tools->Refresh Configuration
2. In Tools > Rule manager, create new rule
1. Select Scope as “Transaction”
2. Select Trigger Type as “Transaction End”
3. Select Condition Type as “Department” and Operator Type as “like”
4. Select the food department
5. In Available Actions, select “Enter/Select POS Kitchen Printer”
6. In Set Attributes form, Select Kitchen Printer as “kp.svc.POS”
7. Reboot Commander Site Controller
3. In Store Operations > Sales > Sales Configuration:
1. Select “Prompt Food Order Name”
2. Select “Prompt Food Order Phone Number”
Managed Modules
Managed Modules is an interface for assigning port numbers and configuring
communication parameters for hardware modules connected to the POS or Site
Controller. The configuration changes do not require a reboot of the Site Controller
or the POS. Based on the device type selected, the default communication settings

are populated.

For any changes to be reflected in the system, select “Tools > Refresh
Configuration” from Configuration Client and logout and login back to the POS.
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Changes to Fuel Driver and DCR Driver modules need driver initialization from
“Forecourt > Initialization > DCR/Fuel Driver”.

Changes to Car Wash module need a DCR initialization from “Forecourt >
Initialization > DCR”.

Current Configuration

The current configuration tab is used for viewing, adding or editing the port and
communication parameters of each hardware module.

Managed Modules

Current Configuration

Host Names I j
Select Module I :

Host Name

Select the host to which the hardware module is connected. The host can be the site
controller, or each POS controlled bfy the site controller.

POS

Use to add the port and enable the hardware module connected to each POS. Select
the POS from the Host Name drop-down list. In order to switch ports, disable the
device you want to move, as well as the device you want to move it to. Otherwise the
Port Name drop-down only shows the port the device is already assigned to.

Note: Most of these modules have feature references. Refer to the feature
reference documentation for information on these modules. The Feature
Reference is available on Premier Portal.

Select Module

Check Scanner

Use to add the port and enable check scanner.
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Managed Modules

Current Configuration | o 11 e ee e £ e
Host Mames | topaz101 :
Select Module | Check Scanner x|

Enable Device

Port Name |COM 2 :

Coin Dispenser

Use to add the port and enable coin dispenser.

HostNames [topaz101 |~

SelectModule [Coin Dispenser |~

Enable Device v
PotName [comM6  [+]

DVR Logging Types

The Digital Video Recorder (DVR) feature provides a DVR interface to the Point of
Sales (POS) System to detect and deter attendant fraud. The DVR broadcasts certain
transactions performed on the POS terminal and displays these events with video
images recorded at the time the events occurred. This provides video images of
attendant actions coupled with a journal of events as recorded by the POS terminal.

Note: Refer to the Digital Video Recorder Implementation Guide for information
on this feature. The Feature Reference is available on Premier Portal.

The “DVR Logging Type” configuration allows selecting types or classes of DVR events
to be recorded.
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Managed Modules

Host Names | topaz101 :

Select Module {DVFLogging Types | |
ALERT
APPLY UPDATES
AUTO UPGRADE
CARWASH DEVICE STATUS EVENT
CAR WASH FEATURE STATUS EVENT
CHANGE QT
CWPP CASH RECON EVENT
CWPP CLOSE
CWPP INIT
CWPP REJECT
DCR EVENT
DRAWER VIOLATION EVENT
EFS MESSAGE
EPS PREPAID PURCHASE PMT ENTRY
ERROR CORRECT
EXCEPTION COMMITTING TRANSACTION
FUEL EVENT
LOGINLOGOUT
OTHER
PAY OUT EVENT
POP MESSAGE
PREFAID TOR DECLINE
PRICE CHECK.
SAFE DROP EVENT
SAFE LOAN EVENT
‘SALES EVENT

SECURE USER

i Y Y

—

TLS DEVICE STATUS EVENT I:‘

Use this form to add the port and enable DVR device.

PIN Entry Device

Managed Modules

Current Configuration [ [Tl Reel)i s [l
Host Names Itopaz101 j

Select Module [ DVR Journal

;V|

Enable Device

Port Name I COM 5 j

Use to add the port and enable PIN Entry Device.
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Managed Modules

pe—
Host Names Itopaz101 j

Select Module £ PIN Entry Device A

Enable Device

Port Name I coMm7 j

Enable 12V

Customer Display
Use to add the port and enable Customer Display of C18 POS.

On the back of the main C18 display are two USB ports located just below where the
main display is mounted to the "handle bar". Connect the C18 Customer Display
cable to one of the USB ports.

Note: Refer to the C18 Customer Display Installation guide for more information.
The document is available on Premier Portal.

Reboot the C18 system and wait for the main display to show "C18 Press Enter or
touch screen to log in".

Managed Modules Save | Cancel

Ep—
Host Names

Select Module | Customer Display i

Enable Device [

Port Name

Enable 12V

1. De-select Enable Device
2. For "Port Name", select USB Display.

Note: If "USB Display” is not shown in the list, make sure to connect the C18
Customer Display and reboot the POS.

3. Click ‘Save'.
4. Select the "Enable Device" checkbox and Click "Save" again.

5. Restart POS
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When the application starts, Register Closed is displayed on the Customer Display.

After logging in to 'Sales’, the phrase "Thank You" should be scrolling across the
Customer Display.

Scanner

Use to add the port and enable scanner.

Managed Modules
ES—

Host Names I topaz101 j

Select Module I Scanner El

Enable Device

Port Name ICOM 8 j

Enable 12V

Secondary Scanner

Use to add the port and enable secondary scanner.

Managed Modules
T p—

Host Nameas I topaz101 j

Select Module ESeoondary Scanner i'|

Enable Device

Port Name ICOM 1|7

Enable 12V

Receipt Printer

Use to add the port and enable Receipt Printer.
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Managed Modules

Current Configuration

Host Names I topaz101 :

Select Module | Receipt Printer i

Enable Device |V

Port Name I COM 4 j

Drive Thru Configuration

Use to add the port and enable drive through configuration.

Managed Modules

Curmrent Configuration

Host Names I topaz101 :

Select Module EDrive Thru Configuration I '|

Send to kitchen on suspend |V
Drive Thru POS

Controller

Use to add or edit the port and communication parameters of each hardware module
connected to the site controller. Select the site controller from the Host Name drop-
down list.

Note: Most of these modules have feature references. Refer to the feature
reference documentation for information on these modules. The Feature
Reference is available on Premier Portal.

Select Module

Auxiliary Forecourt

Note: Refer to the Auxilliary Forecourt feature reference documentation for
information on this feature. The Feature Reference is available on Premier

Portal.

Use to configure Auxilliary Forecourt devices like Aux Pos, Petro Vend and Wetstock
Management Devices.
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Managed Modules

Current Configuration [0 RSy (e ia]ys
Host Names Isitecontroller j

Select Module IAuiniar)«r Forecourt IZ|

Augiliary Forecourt Channel 1| Advanced Settings |
Auxiliary Forecourt Channel 2 Advanced Settings
Auxiliary Forecourt Channel 3 Advanced Settings
Auxiliary Forecourt Channel 4 Advanced Settings

1. Click Advanced Settings next to Auxiliary Forecourt Channel 1

Aunxiliary Fi Channel 1 G

Enable [

Device Type j
Serial Port Name j
Baud Rate | 9600 :

Stop Bits | 1 :
DataBits |8 :

Parity Bit | None :

Fueling Positions | Advanced Settings
Emulated PCTs | Advanced Settings

Save | Cancel

2. Select Enable to enable Channel 1
3. Select the Device Type: Aux Pos, Petro Vend or Wetstock Management
4. Assigns the Commander Site Controller serial port to be used for the Channel

5. Click Advanced Settings of Fueling Positions if the Device Type is Petro Vend.
A Petro Vend device on a channel can control 16 fueling positions.
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Channel 1 Fueling positions
Pasition 1 [ Position2  [] Position 3 [] Position 4[]
Pasition 5[] Position 6 [] Fosition 7 [ Fosition 8 [[]
Pasition9 [ Position 10 [ Fosition 11 [ Position 12 [
Position 13 [ Position 14 [ Fosition 15 [ Pasition 16 [
Position 17 [ Position 18 [ Position 19 [ Pasition 20 [
Position 21 [ Position 22 [] Position 23 [] Position 24 []
Position 25 [[] Position 26 [] Position 27 [[] Position 28 []
Position 29 [[] Position 30 [] Position 31 [[] Position 32 []
Position 33 [ Position 34 [] Position 35 [ Position 36 []
Position 37 [ Position 38 [] Position 39 [[] Position 40 []
Position 41 [ Position 42 [7] Position 43 [] Position 44 7]
Pasition 45 [ Position 46 [ Position 47 [ Position 48 [
Position 49 [ Position 50 [ Fosition 51 [ Position 52 [
Position 53 [ Position 54 [ Fosition 55 [ Position 56 [
Position 57 [ Position 68 [ Fosition 59 [ Position 60 [
Position 61 [ Position 62 [ Position 63 [ Position 64 [

Save  Cancel

6. Click Save on the Channel 1 Fueling Positions to go back to the Auxiliary
Forecourt Channel 1 Configuration form.

7. Click Advanced Settings of Emulated PCTs if the Device Type is Petro Vend.

Channel 1 PCTs

PCT 1

PCT 2

PCT 3

T i |

PCT 4

Save Cancel

8. Select PCT 1 for Channel 1 Petro Vend Configuration.
Car Wash

Note: Refer to the Car Wash topic in this document for information on this
feature.

Managed Modules

Cumrent Configuration S a0 T Ret il [0S
Host Names Isitecontroller j

Select Module | Car Wash =

Device Type |UNITEC ||| Advanced Settings |

1. From the Select Module list, select Car Wash
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2. Select Device Type

3. Click Advanced Settings

RYKO CAW 1l

Baud Rate |8600 A
Serial Port Name
Stop Bits |1 v

Data Bits |8 v

Parity Bit |NONE hd

Save | Cancel

Configuration Client Screens

4. Select the Serial Port

DCR Driver

Note: Refer to the Dispenser Car Reader topic in this document for information

on this feature.

Managed Modules

Curent Connguraton [T

Host Names Isitecontroller j

Select Module | DCR Driver

DCR Positions
DCR Channel 01
DCR Channel 02
DCR Channel 03
DCR Channel 04
DCR Channel 05
DCR Channel 06
DCR Channel 07
DCR Channel 08
DCR Channel 09
DCR Channel 10
DCR Channel 11
DCR Channel 12
DCR Channel 13
DCR Channel 14
DCR Channel 15
DCR Channel 16

Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings
Advanced Settings

B
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1. From the Select Module list, select DCR Driver
2. Select to enable DCR Control

3. Click Advanced Settings next to DCR Channel 01

DCR Channel 01

Enable [

IP Enabled |

Port Name I [v]
DCR Family type IVFI SPP  |v| | Advanced Settings

Save | Cancel

a. Click Enable Channel.

b. Select IP Enabled for outside EMV DCRs
c. Select Port name for serial port DCRs.
d. Select DCR Family type.

e. If debit encryption is to be used, click Advanced Settings

VFI SPP

Parity Im

Baud Rate Im
DataBits [8 ||
Flow Control INONE v
Stop Bits lﬁ’

Save ' Cancel

a. Select Debit Encrypt Type

DSM: Select if using a Dresser/Wayne DUKPT Security Module
(DSM).

DUKPT: Select for all US sites not using a GSM or DSM.
GSM: Select if using a Gilbarco Security Module (GSM).

MS: Select only for non-US sites using Master Session encryption.
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NONE: Select if not configuring for Debit (no encryption).
b. Click Save
e. Click Save on DCR Channel 01 window

Note: In feature Set 19 or higher for Wayne, there is an option to enable
Enhanced CAT used for Secure CAT DCRs. This setting would only be used
at Exxon Mobil sites that have Secure CAT DCRs (legacy or Dual CATs with
injected secure messages). For both Wayne and SPP, if debit is used at the
DCRs for the site a Debit Encrypt Type other than NONE must be selected
(failure to do so will result in the keypad not functioning properly).

4. Set up additional DCR channels as required using previous steps.

5. Click Advanced Settings at DCR Positions to configure the appropriate channel
for each DCR.

a. For each DCR, specify the channel to which it is assigned.

b. Click Save.
DVR Configuration
The Digital Video Recorder (DVR) feature provides a DVR interface to the Point of
Sales (POS) System to detect and deter attendant fraud. The DVR broadcasts certain
transactions performed on the POS terminal and displays these events with video
images recorded at the time the events occurred. This provides video images of
attendant actions coupled with a journal of events as recorded by the POS terminal.

Note: Refer to the Digital Video Recorder Implementation Guide for information
on this feature. The Feature Reference is available on Premier Portal.
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Managed Modules

Current Configuration

Host Names Isitecontroller ™

Select Module | DVR Configuration ™

DVR mode |Multicast ||
Mulicast IP Address | 230, 0. ol 1]
Multicast Port Number
Local UDP port connations are to use.
Number of upstream hops allowed for multicast packet |17

DVR Serial Setup Advanced Settings

. Select the DVR mode: mode of communication for the DVR interface. The

values are:

a. Multicast: multicast communication is enabled. This is the default
value.

b. Serial: serial communication is enabled
c. Both: serial and multi cast communications are enabled

d. Disabled: configures the system to not generate DVR events

. Multicast IP Address: The default Multicast IP Address is populated
. Multicast Port Number: The default Multicast Port Number is populated

. Local UDP port connations are to use: the fully qualified IP address and the

multicast address. For example, 230.0.0.1:14001

. Number of upstream hops allowed for multicast packet: The DVR “Multicast”

uses the “Multicast UDP Datagram” broadcasting mechanism to send DVR event
info. According to the IETF standard regarding “Multicast UDP Datagram”, the
default ‘hop’ (or Time-To-Live - TTL) is ‘1’. The TTL value is used by routers
that when they receive a datagram, they decrement the TTL value. If the TTL
is still is greater than ‘0’, the datagram is forwarded to the router’s upstream
LAN port (WAN). The IETF cautions about using a TTL value grater than 1 for
multicast UDP datagram in that they do not want the Internet flooded with
these multicast datagrams and only allows use of the TTL value greater than 1
if the routers are kept within an internal network.
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6. We supply the ability to specify a value greater than 1 for those customers who
have DVR monitoring equipment not in the “VFI Zone” and need to UDP
datagram to forward ‘upstream’.

7. Click Advanced Settings to select port

DVR Serial Setup

Port Name i
Baud Rate | 9600 v

Use Extended Protocol Mode

Save Cancel

1. Select port

2. Select baud rate

3. “Use Extended Protocol Mode” selects whether the DVR events send
prepended byte codes normally used by journal printers. Unselecting
this entity does not send the byte codes. Enable this value for
backwards compatibility of legacy DVR equipment.

For any changes to be reflected in the system, select “Tools -> Refresh
Configuration” from Config Client.

DVR Logging Types

The “DVR Logging Type” configuration allows selecting types or classes of DVR events
to be recorded.

For any changes to be reflected in the system, select “Tools -> Refresh
Configuration” from Config Client.
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Managed Modules
Cures ontiction
Host Mames | sitecontroller :

Salect Module | DVR Logging Types

ALERT

APPLY UPDATES

AUTO UPGRADE

CAR WASH DEVICE STATUS EVENT
CAR WASH FEATURE STATUS EVENT
CHANGE QT

CWPP CASH RECON EVENT

CWPFF CLOSE

CWPP INIT

CWPP REJECT

DCR EVENT

DRAWER VIOLATION EVENT

EPS MESSAGE

EFS PREFPAID PURCHASE PMT ENTRY
ERROR CORRECT

EXCEFPTION COMMITTING TRANSACTION
FUEL EVENT

LOGINLOGOUT

OTHER

PAY OUT EVENT

POP MESSAGE

NN NEEEERRR @ [

PREPAID TOR DECLINE

PRICE CHECK.
SAFE DROP EVENT
SAFE LOAN EVENT

SALES EVENT

SECURE USER

TLS DEVICE STATUS EVENT

Fuel Driver

Note: Refer to the Fuel Manager and Fuel Sales topics in this document for
information on this feature.
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Managed Modules

(&1L gy Tlel Ol Pending Configuration | System Resources

Host Mames Isitecontmller j

Select Module | Fuel Driver =

Enable POS Requests Logging [
Enable SPI communications [

Fuel Channel 01 Advanced Settings

Fuel Channel 02 Advanced Settings

Fuel Channel 03 Advanced Settings

Fuel Channel 04 Advanced Settings

Fuel Channel 05 Advanced Settings

Fuel Channel 06 Advanced Settings

Fuel Channel 07 Advanced Settings

Fuel Channel 08 Advanced Settings

1. Enable SPI when running Smart Pump Interface (SPI) at the site.

2. Click Advanced Settings to configure Fuel Channel 01

Fuel Channel 01

Enable Channel
Port Name | PortAl-4 N
Dispenser Type |Gilkarco v | Advanced Settings

Total Fueling 3
FPaositions

Maximum Delay |5

Minimurn Delay |2

Save  Cancel

. Click to Enable Channel.

o))

o

Assigns the Commander Site Controller serial port to be used for the
Channel.

c. Select Dispenser type.

e

Specify Total fueling positions on this channel.
e. The maximum and minimum delay for communication.

Note: Maximum and Minimum Delay are used with Non-Modular Highline
pumps only.
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Fuel Price Display

Note: Refer to the Fuel Price Sign Communication document for information on
this feature. The document is available on Premier Portal.

Managed Modules

Cumrent Configuration [ g s Refal i [T =1l
Host Names Isitecontroller j

Select Module | Fuel Price Display I~

Fuel Price Display Channel 1 | Advanced Settings
Fuel Price Display Channel 2 | Advanced Settings
Fuel Price Display Channel 3 | Advanced Settings
Fuel Price Display Channel 4 | Advanced Settings

Click Advanced Settings to select port.

| Standard Fuel Price Display

Serial Port I—i’
Name :

Save | Cancel

Fuel RFID Configuration

Note: Refer to the ORPAK AVI/RFID Fueling System feature reference
documentation for information on this feature. The Feature Reference is
available on Premier Portal.

Enter the RFID configuration details.

Managed Modules
T p—

Select Module | Fuel RFID Configuration ||

AVl enable [[]
AVI IP Address 0. 0. 0. 0
OTl enable [[]

OTI IP Address 04 04 0. ]
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GSM

Managed Modules

(&7 - Rl TGO Pending Configuration | System Resources
Select Module | GSM v

GSM 1 Port | Advanced Settings

GSM 2 Port | Advanced Settings

Click Advanced Settings for each GSM (Gilbarco Security Module) port to assign
the port.

. DCR GSM 1 Port
GSM 1 Port I—i[
Name

Save | Cancel

Kitchen Printer Service

Note: Refer to the Kitchen Printer feature reference documentation for
information on this feature. The Feature Reference is available on Premier

Portal.

Managed Modules

Cument Configuration SEERGLReS I TsE T
Host Names Iaitecomro\ler j

Select Module | Kitchen Printer Service ||

Enable Kitchen Printer Service [

Kitchen Printer ID | kp.svc.POS j
System hosting Kitchen Printer j

Port for connection | Advanced Settings

1. Click to Enable Kitchen Printer Service

2. Select the port for connection

158



Commander Site Controller User Reference

MNSP VPN Management Service

Verifone POS systems establishes or enables on-demand secure connections through
the Managed Network Service Provider (MNSP) router. This enables the Verifone
support personnel to interact with the POS systems through a VPN connection. New
PCl requirements do not allow continuous, persistent connections outside of the VFI
Zone and that if connections are to be made, they must be initiated by the customer
using Maintenance > Help Desk Diagnostics from the POS.

Use this form to configure the MNSP VPN configuration.

Managed Modules

Host Mames Isitecnntrollerﬂ

Select Module |MNSP VPN Management Service | v |

Enable Heldesk user to extend VPN ]

IP address of router |[192.165.31.31
Rest service port _
RestFUL service root path

Money Order Feature

Managed Modules

[Ty e T [TTE 100 I Pending Configuration | System Resources

Select Module |I‘-x1cney Order Feature

Enable Maney [
Order Feature

Reset Totals COn
Period Close

Device Terminal
- MoneyGram % | Advanced Settings

1. Select to enable money order feature

2. Reset Totals on Period Close is enabled by default and resets totals on the
money order device when a period is closed by the cashier.
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3. Select Device Terminal Type: MoneyGram Delta Network, Western Union ICE,
or Western Union T7E.

4. Click Advanced Settings to enter the communication parameters.

MoneyGram Delta Network

MoneyGram Delta Network

Security Access Number 00000000

Port Name I j

Terminal I 00000000

Save | Cancel

a. Select the Port

b. Enter Terminal Id

Western Union ICE6000

Western Union Ethemet

Teminal IP Address
Forwarding IP port for Terminal 1123
Terminal IP Port 1400
Terminal ID
Forwarding IP address for Terminal 169. 254. 13. 64

Socket connection Timeout 30000

Save | Cancel

a. Enter the money order terminal’s IP address
b. Enter the Terminal Id of the money order device
c. Enter the forwarding IP address for the money order terminal. Typically
the WAN side IP address of the Verifone zone router at the site should be
entered.
Note: The WAN side IP address of the Verifone zone router is the

forwarding IP address that should be used for the standard money order
device configuration where the device resides on the store LAN.
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Western Union T7E

Western Union T7E

portName I v

Save | Cancel

Select the Port
Speedpass

Managed Modules

Cument Configuratio

Select Module | Speedpass %

Speedpass

Wayne Device 1

Advanced Settings

Speedpass

Wayne Device 2 Advanced Settings

Speedpass

Gilbarco Device advanced Seiiks

1. Click Advance Settings of Wayne Device 1

Wayne Trac Speedpass Configuration
Enable []
Trac Controller l—il
Address
predm—
Baud Rate |9600 v
Stop Bits |1 |V
Data Bits |8 i
Parity Bit INone v
Begin Der# |1

End Der# |1

Jd

Save Cancel

a. Click to Enable

b. Trac Controller Address for device1 is HEX 95
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C.

Select Port

d. Begin DCR #: 1

e. End DCR #: 1- 32

2. Click Advance Settings of Wayne Device 2

a.

b.

C.

d.

e.

Click to Enable

Configuration Client Screens

Trac Controller Address for device2 is HEX 96

Select Port

Begin DCR #: 33

End DCR #: 33 - 64

3. Click Advance Settings of Gilbarco Device 1

Tank

Gilbarco Trind Speedpass Configuration

m}

Der Position 1

Der Position &

Der Position 9
Der Position 13
Der Position 17
Der Pasition 21
Der Position 25
Der Position 29
Der Position 33
Der Position 37
Der Position 41
Der Position 45
Der Position 49
Der Position 53

Der Position &7

OooDooDooooooOooooogog

Der Pasition 61

Der Position 2 [ Der Position 3

Dor Position 6 [ Der Position 7
Der Position 10 [ Der Position 11
Der Position 14 [] Der Position 15
Der Position 18 ] Der Position 19
Der Position 22 [] Der Position 23
Der Position 26 [] Der Position 27
Der Position 30 [ Der Position 31
Der Position 34 [ Der Position 35
Der Position 38 [ Der Position 39
Der Position 42 [] Der Position 43
Der Position 46 [] Der Position 47
Der Position 50 (] Der Position 51
Der Position 54 [ Der Position 55
DerPosition 58 ] Der Position 59
Der Position 62 [] Der Position 63

Save | Cancel

OooDooDoooooDooooogogo

Der Position 4

Der Position &

Der Position 12

Der Position 16

Der Position 20

Der Positien 24

Der Position 28

Der Position 32

Der Position 36

Der Position 40

Der Position 44

Der Position 48

Der Position 52

Der Position 56

Der Position 60

Der Positien 64

OooDooDooooDoDooooogogo

Click to enable DCR Positions.

Select Module

Managed Modules

Current Configuration =l Reelyiils i =10 F

TANK

TANK Model |EDIM v | Advanced Settings
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BIR (Business Inventory Reconciliation) E-DIM is an expansion card in the TLS box that
receives transaction data from Commander fuel sales for reconciliation.

1. Select Tank Model as EDIM

2. Click Advance Settings

[ EDim

—

Baud Rate |1200 [-]

Serial Port
Nomg | POTA2-8 =]

Stop Bits |1 :
Data Bits |7 -]
Parity |Even B

Flow Centrol | None :

Save  Cancel

o

3. Change Serial Port name to Port to be used, all other settings should be left
default.

Tank Level Sensor

Managed Modules

Current Configuration [JZERGIVEeT eI BE=E Rl (et
Select Module |Tank Level Sensor | %

Device Type |Auto Stik ET ¥ Advanced Seftings

1. Select Device Type

2. Click Advanced Settings to select port

| Auto Stik ETM

Baud Rate |9600 v
Serial Port I—Z’
Name .
Stop Bits |1 |™
Data Bits |? i
| Parity Bit Im

Save | Cancel
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Receipt Printer

Use to add the port and enable Receipt Printer.

Managed Modules
(W GGG EL LI Pending Configuration | System Resources

Host Names Isitecontroller v

Select Module | Receipt Printer ~

Enable Device

Port Name I PortA1-4 ~

Order Confirmation System

Note: Refer to the Outside Confirmation Board feature reference documentation
for information on this feature. The Feature Reference is available on Premier
Portal.

Use to configure the order confirmation system.

Managed Modules Save  Cancel

Current Configuration [JEENGTITEELTe eI N BT Gl e ES T (=1
Host Names Isitecontroller v

Select Module |OrderConfirmat\on System |~

Enable OCS

OCS System Type I Delphi Syster ~ | | Advanced Settings

« If the "Enable OCS" is selected, de-select and press [Save].

» For "OCS Type", select Delphi Systems OCS Ethernet

» Select [Advanced Settings].

e For "Device Network Address”, enter above IP for the device.

» For "Device Network Port”, enter above listening port for the device.
o The “Order Confirmation System" settings should now be displayed

» Select the Enable OCS and press [Save].
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Pending Configuration
Feature not available.
System Resources

System Resources tab shows a list of the module names and the ports to which the
modules and Channels are assigned.

Managed Modules

System Resources

Resource Name Module Name

Portat-1 Der-Channel-1

Portal-3 FuelChannell

Portal-5 FuelChannel?

PortAz-g TANK

Porta3-z| Fuel Price Display

Refresh Configuration

After any changes are made to Car Wash, POP, or Network parameters including
Loyalty, the command “Tools > Refresh Configuration” needs to be executed for the
new settings to be applied to fuel and DCRs.

After changes are made to DCR parameters, the command “Tools > Refresh
Configuration” is executed for the new settings to be applied to DCRs.

Changes to the Receipt Header/Trailer parameters also require a DCR download.
All the DCR position attributes except Pay At Pump, Push To Start Button, Grade

Select Button, and Lever On Pump require a Initialize DCR Driver in addition to
“Tools > Refresh Configuration”.

Ping Utility

Use to ping the devices in the LAN to check the communication status. Enter the IP
address of the device and click Ping

Ping Utility
Enter Host Name to Ping

Ping
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Image Upload
Users can import their own images and logos from Tools > Image Upload.

Note: Refer to the Self Checkout User Reference documentation for information
on this feature. The Feature Reference is available on Premier Portal.

Event Manager

Enhanced System Monitoring feature provides a mechanism for retailers to remotely
monitor certain events that occur at the site. Data required to monitor the site
remotely is collected from all the registers at the site and sent to a configured
remote server.

Note: This document does not cover information on how to configure the server
to receive events and view events. This section only covers the configuration
done through the Configuration Client.

Events that can be monitored are of two types:

e Real Time Events: A Real Time Event triggers notification to the remote server
only when there is an occurrence of a specific activity at the site.

e Scheduled Events: Unlike Real Time Events, Scheduled Events trigger
notification to the remote server periodically. We can configure the desired
frequency rate at which the remote server should receive notifications.

Event Configuration

Event Manager Tool

Event Configuration

Add | [pelete
Select Event Target
T DEs
EZ:?E URL
aic] http://192.168.31.202:8090/testl
Event Registration
Notification
Enable Event Event Type Mapped User Frequency Tesrl Evz%nl
e Registration
(in minutes)
O FUEL_INIT
&4 PERIPHERAL_STATUS
O FUNDS_AUDIT
O SALES_MONITOR
O PERIOD_CLOSE
1-50f7 *» M
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Name An alias to the server. This should be unique.

URL The URL to reach the remote server.

Check “Enable Event” to register for the event. A target

Enable Event server can be registered for multiple events.

The following are the event types:

e APP_START: Select to get notification when
applications are started on each register including
Commander Site Controller.

e PERIPHERAL_STATUS: Get notification on the
status of peripherals like scanner, PIN pad etc on
each register.

e FUEL_INIT: An event is triggered when fuel gets
initialized.

e PERIOD_CLOSE: An event is triggered on period
close.

e FUNDS_AUDIT: Get notification when funds are
Event Type audited.

e MWS_MGRACCEPTED: Get notification when the
totals are accepted by manager on the Manager
Workstation.

e SALES_MONITOR: All Sales transactions are sent
to the server at certain frequency of time.

e OTP_GENERATED - When OTP Generated is

enabled, Commander Site Controller transmits the
one-time password (OTP) that is requested within
Configuration Client for specific secure actions,
especially EPS Global Configuration, to the
specified server URL. Enabling this function allows
the OTP to be retrieved from the server rather
than requiring the site to provide the OTP.
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Note: Verifone does not dictate how
communication for the listening server is
configured or set up. The server must be listening
for the event to be collected at the time the
Commander creates the event. The Commander
does not retry or verify if the listening server
received the message. It only functions to
broadcast the one-time password.

Note: This event can be used in conjunction with
Verifone’s TSA Program. Contact your Sales
Account Manager for more information on TSA.

Mapped User

|hslpdask %

Certain events provide flexibility to receive a mapped
user’s secure token (Cookie) as part of event
notification.

This secure token can be used by the remote machine to
fetch the data further from the site by executing CGI
commands.

Notification

This is applicable only for Scheduled event (Sales
monitor). User can select the desired frequency rate

Frequency listed.
The Test button is used to resend the last occurred
Test Event .
. . event data (real time event) and snapshot of current
Registration

system data (scheduled event).

Reboot Commander

This option reboots commander site controller.

o

Configuration Manager

Are you sure you want to reboot Commander?
The site will be down during reboot.
Please make sure no transactions are taking place and no one is fueling outside.

_____________________

Yes | No

After the user selects “Yes”, an OTP is required to complete the process.
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Helpdesk Diagnostics
This menu is accessible from Configuration Client and POS.

This menu provides diagnostic information. The diagnostics information can be used
by both the Helpdesk as well as site users.

The screens provide overall Online/Offline/Mixed status for configured devices in
each section.
e Online = Device(s) is/are connected and functioning

e Offline - Device(s) is/are not connected or functioning
e Mixed - One or more devices is not connected or functioning.

There is a visual indicator (e.g. green/orange/red) along with the textual status.
General Status
The General Status screen reports the general status of the system.
General Status reports overall Online/Offline/Mixed status of:

e Controller (Commander)

e Zone Router

e Secure Services

e Electronic Check, if configured

e Electronic Safe, if configured

e Food Services, if configured

e Configured Registers

e Configured Register Printers

e Configured Register Scanners

e Configured Pinpads
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Configuration Client Screens

General Status

POS
Controller

Status

Mixed

Zone Router
Secure Services

Electronic Check
Electronic Safe
Food Service

Registers
Printers
Scanners

Forecourt Status
Fuel Mixed
DCRs Mixed
Cash Acceptors Mixed
Car Wash

Car Wash Paypoint -
Tank Level Sensor Mixed
Fuel Price Display

Vending Machine

Payment
Controller
Primary Network

Secondary Network

Proprietary Fleet
Loyalty Host 1
Loyalty Host 2
Loyalty Host 3
Loyalty Host 4
Lottery

Mobile

InComm

Pinpads

4/21/16 10:35 AM

Status Last Transaction
1 minago
1minago
1hourago

3 hours ago
1minago
5days ago

2 hours ago

2min ago
1dayago

Mixed

Forecourt Status

This screen reports the last Online/Offline status and Offline time of all configured:

Pumps
DCRs
Car Wash

Car Wash Paypoint

Tanks connected to a Tank Level Sensor

Fuel Price Display
Vending Machine

Cash Acceptor

Forecourt Status
Pump # Status
Overall Mixed

1

Time
30 sec ago

30 sec ago
30 sec ago

2min age

o~ oW N

DCR & Status
Owverall Mixed

Time Device Status Time
Forecourt Controller _
carwash SRRSO - :::
Car wash Paypoint (RSN
5 hours ago
Tank Level Sensor
1 hour ago TANK #1 5 days ago
1 min ago TAMK #2 1day ago
5 min ago TANK#3

vending Machine 3 min ago
S hours ago

Fuel Price Display

4/21/1610:25 AM

.
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POS Status
The POS status screen reports the following:

e The Online/Offline status and time of all configured registers along with their
ID.

e The register as the device name (e.g. Topaz, Ruby2).
e The detailed status and time of all configured printers.

e Primary Scanners that are connected to a configured register and if they are
enabled or disabled.

e The detailed status and Offline time of all configured Electronic Check
services.

e The detailed status and Offline time of all configured Electronic Safes.
e The overall status and Offline time of Commander Core Services.

e The overall status and Offline time of EZR (connectivity from Commander
devices to EZR).

e The MAC address of EZR.

e The overall status and Offline time of Secure Services (connectivity from
Commander to online support).

o The status and Offline time of connectivity to Cybera Support

o The status and Offline time of connectivity to VRSD

POS Status 4/21/16 10:35 AM
Device Status  Time Device Status  Time Device Status  Time
Topaz 101 _ Electronic Check _ Commander (Core Services)
Last Reboot 1menth ago Last Reboot 22 hours ago
Printer Electronic Safe
Scanner safeiD1 Enhanced Zone Router
SafelD2 MAC Address 00:08:5C:00:00:01
Ruby2102  [GRIMENY SafelD 3
Last Reboot 1day ago safelD4
Printer _ SafelD5 ldayago  Secure Services
Scanner SafelD6 Cybera Support
safelD7 VRSD
Topaz 103 [GRIRENN safaiD8

Last Reboot 1hour ago safelD9
Printer Safe 1D 10
Scanner

Ruby2 104
Last Reboot 24 hours ago
Printer
Scanner

171



Payment Status

Last Batch Closed

Current Batch Number

Current Batch Count

IP Address

Last Transaction Date

Current Net Amount

Current Terminal Batch

Store and Forward count

Reports the following information (if supported) for the Feps

Configuration Client Screens

Reports Online/Offline status and time of all configured Feps, listed by Fep name.
These include all configured Payment, Lottery, and Loyalty Feps, as well as Mobile.

Payment Status
FEP NAME
Connection Status
Last Batch Closed
Current Batch Number
Current Batch Count
1P Address
Last Transaction Date
Current Net Amount
Current Terminal Batch
store and Forward Count

Proprietary Fleet Name
Connection Status
Last Batch Closed
Current Batch Number
Current Batch Count
Serial Port/Baud Rate
Last Transaction Date
Current Net Amount
Current Terminal Batch

Status.

N/A
N/A
N/A
127.00.1
N/A
N/A

Status

N/A

N/A

N/A

COM_2 / 9600
N/A

N/A

6

Loyalty Host 1 Name
Connection Status
Last Batch Closed
Current Batch Number
Current Batch Count
1P Address
Last Transaction Date
Current Net Amaunt
Current Terminal Batch
Store and Forward Count

Loyalty Host 3 Name
Connection Status
Last Batch Closed
Current Batch Number
Current Batch Count
1P Address
Last Transaction Date
Current Net Amount
Current Terminal Batch
Store and Forward Count

Status

N/A
N/A
N/A
127.0.0.1
N/A
N/A

6

Status

N/A
N/A
N/A
127.0.0.1
N/A
N/A

6

Loyalty Host 2 Name

Connection Status

Last Batch Closed
Current Batch Number
Current Batch Count

1P Address

Last Transaction Date
Current Net Amount
Current Terminal Batch
Store and Forward Count

Loyalty Host 4 Name

Connection Status

Last Batch Closed
Current Batch Number
Current Batch Count

1P Address

Last Transaction Date
Current Net Amount
Current Terminal Batch
Store and Forward Count

Status.

NfA

NfA

NfA
127.00.1
N/A

N/A

6

Status.

NfA

NfA

NfA
127.00.1
NfA

NfA

6

InComm
Connection Status
Last Batch Closed
Current Batch Number
Current Batch Count
1P Address
Last Transaction Date
Current Net Amount
Current Terminal Batch
Store and Forward Count

Lottery Name
Connection Status
Last Batch Closed
Current Batch Number
Current Batch Count
1P Address
Last Transaction Date
Current Net Amount
Current Terminal Batch

Status.

N/A

N/A

N/A
10.71.132.61
N/A

N/A

6

Status

N/A

N/A

N/A
127.00.1
N/A

N/A

6

4/21/16 10:39 AM|
Status.

Device
Payment Controller

Mobile Name
Connection Status

Status.

Pinpads
POSID POPID Status
Topaz1 001
Topaz2 002
Topaz3 003
Topazd 004
Topazl 005

MNSP Status

Shows the MNSP Status.

172



Commander Site Controller User Reference

MNSP Status

Connection Status Router Information
Status false API Version
Connected since 00:00:00 Manufactuer
Time left on connection 00:00:00  Model Number
Link information Serial Number

Uplink MAC
Uplink IP

Firmware Version

Host Name

Help

About

The About screen in the Help tab displays the versions of the software that the system
is running.

System Configuration
Manager

Version Information

Suite - exxonmabil 1.00.00
Base 018.00.00 2013-12-05T15:47:23-05:00
Buypass 6.00.00 2018-12-10T12:42:36-05:00
Commander Sil i

o insader A8 Conticller; =y no 2013-12-10T13:43:17-05:00
EPs 5.03.00 2013.12-10T13:42:17-06:00
Ret 5.03.00 2018-12-10T12:42:61-05:00
Topaz 05 303 2013-12-10T13:43:13-05:00
wes 5.03.00 2018-12-10T13:43:11-05:00

Topaz Version Details

Topaz 101 - Base 018.00.00 2013-12-06T15:47:23-05:00

Topaz 102 - Base 018.00.00 2013-12-05T15:47:23-05:00

Support

This screen contains the service ID entered during installation and the help desk phoe
number.

The help desk phone number can be edited on configuration client from Initial Setup
> Maintenance Configuration > Telephone & Postal Code.

Support Information

Service ID 1234567
Help Desk Phone Number 7279534032

For product information, go to http://global verifone com/company/terms-and-conditions
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Auto Upgrade and VRSD

Overview

The Auto Upgrade feature allows a site to initiate a complete software upgrade
without requiring the presence or expertise of a technician (VASC) or intervention
from the Verifone HelpDesk.

The software is transferred to the system either by using the Auto_Upgrade.jar
program or by an automated remote software download. Verifone Remote Software
Download (VRSD) is the name for Verifone's implementation of the automated remote
software download.

Note: Refer to the Auto Upgrade feature reference documentation for

information on this feature. The Feature Reference is available on Premier
Portal.
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Car Wash

Overview

Car Wash feature is used to buy a Car Wash by different methods, at the POS, at the
dispenser or at the car wash controller (if the site has the option available). When a
customer purchases a car wash the system that is used for the purchase is forced to

print a receipt because it prints the Car Wash code on the receipt. Car Wash code is
entered at the Car Wash Controller when the customer decides to redeem the code

for the Car Wash.

When Car Wash is integrated with Commander™ Site Controller the following is some
information on how this works:

o Car Wash “items” must be sold as PLUs.

o Car Wash items can be sold at POS or at dispenser where consumer is led
through the required steps for purchase.

o Car Wash code (for redeeming the car wash) prints on the receipt and so ticket
printing is forced.

e The PLU Promotions feature may be used to automatically discount Car Wash

when the configured requirements for fuel purchased in the same transaction
are met.

Using Car Wash

Transactions with Car Wash purchases print the Car Wash code on the receipt
and so will always force a ticket print.

Car Wash sales may be configured to offer a promotional price based on
characteristics of the transaction.

Note: This is an example of an automated discount and requires no special
handling by the cashier.

A Car Wash sale is a PLU sale and can be sold at the POS by the following
methods:

e The PLU number

e A PLU soft key set up with a Car Wash PLU
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Car Wash

e A menu key set up with Car Wash PLUs

Note: A Car wash cannot be sold as a department sale. Car wash items can also
be sold through a dispenser card reader.

Car Wash Sale at the Dispenser

Prompts for the customer to purchase one (or not) and to select a type appear
before or after the customer begins fueling, depending on the POS settings. The
following exceptions may occur:

o Car Wash Disabled: The DCRs do not display the car wash prompt.

o Cash Acceptor Sales: With cash acceptors, the car wash prompt is
always displayed before fueling.

« POS/Car Wash Controller Not Communicating: The DCRs display the
prompt "CAR WASH UNAVAILABLE".

The steps involved to sell or decline a sale of a car wash are as follows:
Note: The steps indicated depends on the type of fuel dispenser, the POS
settings, and the type of DCR. A receipt always prints if a customer purchases a

car wash at the DCR.

1. The car wash sale prompt appears if it is set for the beginning of the
sale, otherwise, go to step 2

= Touch [YES] to buy a car wash and choose from a list of wash
options

= Touch [NO] to refuse a car wash

2. The car wash sale prompt appears if set to display at the end of the sale
and the customer has not already purchased a car wash.

Note: If the site has cash acceptors the car wash prompt will be at the
beginning of the sale. Otherwise go to step 4.

= Touch [YES] to buy a car wash and then choose from a list of
wash options

= Touch [NO] to refuse a car wash

3. The DCR processes the receipt
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= If the customer purchased a car wash, a receipt prints
= If no car wash is purchased, standard receipt procedures occur

Car Wash Sale at the POS

Car wash items are sold in the same way as any other PLU at the POS.

1. Enter Car Wash sale using one of the methods defined in “Using PLU
Sales” section

2. Press [TOTAL] to see amount due with car wash discount (if any) applied

Note: If the car wash is not working at the time the customer made the
purchase you will see one of the following messages appear on the screen:

=  “CAR WASH DOWN. CODE AVAILABLE PROCEED WITH SALE?”,
answer “Y” if customer wants a rain check with car wash code or
“N” if customer decides not to purchase the car wash.

=  “CAR WASH DOWN. CODE UNAVAILABLE PROCEED WITH SALE?”,
answer “Y” if the customer wants to proceed with the sale and
willing to return to get a code at a later date or “N” if customer
decides against the car wash purchase.
3. The POS processes the receipt
= If the customer purchased a car wash, a receipt prints
= If no car wash is purchased, standard receipt procedures occur

Car Wash Receipt

When a car wash is entered into a transaction, the POS prints a car wash code
on the receipt. The customer can then use this code to run the car wash. When
more than one car wash is sold on a ticket, a code prints for each one. Because
each car wash sold must have a code to go with it, enter each car wash sale
separately. The [QTY] key cannot be used.

177



Car Wash

Descr. qty
SUPER WASH 1
DELUXE WASH 1
Sub Total
Tax
TOTAL
CASH S
Change S

amount

1.54

23.54

25.00

1.46

Your 5 digit Car Wash code(s)

SUPER WASH

DELUXE WASH

Good thru THU 01/

30940

14220

10/13

Sample Car wash
Receipt

Configuring Car Wash

Use Devices > Car Wash to configure car wash.

The Car Wash Configuration form is used to set up and edit car wash functions. See
Store Operations > Restrictions > PLU Promotions to set up car wash promotions.

Use Tools > Managed Modules > Car_Wash_Configuration to assign port and configure
the communication parameters for Car Wash.

Note: After any changes are made to Car Wash, POP, or Network parameters
including Loyalty, the command “Tools > Refresh Configuration” needs to be
executed for the new settings to be applied to fuel and DCRs.
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Car Wash Configuration

Car Wash Configuration

Car Wash Key Setup

1. PLU |

2 PLU. |

3 pLU |

4.PLU |

5 PLU |

6 PLU |

7.PLU |

Enable Car Wash v Car Wash DCR Attributes
Car Wash Department IO - Mot Found DPrompt at Beginning of Sale
Days Car Wash Code is Valid |M | [ IPrompt at End of Sale
Display Crder (by Expense} |None [ IMenu Presentation

Qutdoor Qutdoor
= o B L]
| | | I | [
L | O wew] B O
o |om B | .
| | | O 1zpwu | I | l
L] O e B O
| | | O rapw | I | | m

Enable Car Wash | Select to enable car wash.

Car Wash Select the car wash department.

Department

Days Car Wash Enter the number of days a car wash code is valid.
Code is Valid

A zero value denotes non-expiring card wash code. An expiration
message is not printed on the receipt if the value is zero.

Display Order (by
Expense)

Select ‘None,’ ‘Ascending,’ or ‘Descending’ (according to price)
to establish the order in which car washes appear on the DCR
display.

Car Wash DCR Attributes

Prompt at
Beginning of Sale

Select to prompt for a car wash before the customer begins
fueling.

Prompt at End of
Sale

Select to prompt for a car wash after the customer has finished
fueling.
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Car Wash

Menu Presentation | Select to display the car wash prompt in menu form.

The customer can choose a car wash item by keying the item
number and pressing [ENTER] on the DCR keypad.

(If not selected, the car wash prompt displays in a series of
Yes/No questions.)

Car Wash Key Setup

PLU Enter the PLU number of the car wash.
Modifier Enter the modifier for the PLU.
[%' If the PLU is valid, a small yellow index card appears. If the PLU

cannot be validated, a black ‘X’ appears.

Outdoor Select the car washes that can be purchased at the DCR.

Valid Dates

The receipt contains a code the customer can use to start a car wash. The last date
that the code can be used follows the code. This date depends on the type of car
wash controller and the site’s policy.

Discounts

Car wash discounts are set up as promotional items. This means that if the customer
purchases a car wash and has met the criteria for the promotional price, then the
correct price is automatically applied after the cashier presses [TOTAL].

Note: Until the cashier press [TOTAL], the Operator Display and the Customer
Display show the running total with the undiscounted price for the car wash.

If the discount is set for the same price as the car wash item and the purchase
requirements are met, then the car wash is free. The customer must request the car
wash and the cashier must enter it into the transaction. The car wash promotion
prints on the receipt and on the journal.

Whether or not a car wash discount is available depends on three conditions:
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e The type of discount that has been set up.

e Whether the customer prepays or postpays for the fuel.

e When the customer requests the discount.

The following table displays how these conditions affect one another:

Minimum Quantity
Purchase

No discount

Discount available

Minimum Dollar Purchase
of Specific Fuel Product

No discount

Discount available

Minimum Dollar Purchase
of Any Fuel Product

Discount available if a
customer purchases at least
the minimum dollar amount
set up in the PLU Promotion
File and requests a discount
before fueling.

Discount available

Reporting

The Car Wash Report summarizes car wash sale activity and totals.
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DESCRIPTION AMOUNT
COIN 1.00
TOKEN 2.00
USED 4

Sample Car Wash
Report




Car Wash

Report Details
e COIN: The total amount collected at the coin box outside the car wash.

e TOKEN: The total dollar value of tokens collected at the coin box outside the
car wash.

e USED: The total amount of car washes.

Troubleshooting

E1174 NO CAR WASH COMM| The POS and car wash controller are not
communicating. Check that the controller is plugged in
and connected to the correct POS COM port.

E1170 CARWASH QTY SALE | Car washes can be sold only one at a time.
NOT ALLOWED

E1171 NO CAR WASH KEY | A key for this car wash item must be defined. Set up a
car wash PLU
DEFINED FOR PLU

E1210 CAR WASH DOWN. | The POS is not communicating with the car wash
CODE AVAILABLE controller but can still provide a car wash code. The
code is valid for a specified time.

E1211 CAR WASH CODE The POS is communicating with the car wash controller
UNAVAILABLE and no car wash code is available. The servicer should
investigate the problem.

E3033 ERROR IN CARWASH | The car wash parameters have not been set up

SETUP correctly and the Discount Type prompt displays in the
PLU Promotion File function. Check the car wash
parameters.
E4003 INVALID CAR WASH | A car wash department in the Car Wash function has
DEPARTMENT been specified and the number entered has no

department setup. Check the department number and
re-enter the information.

E4004 INVALID DAY Displays if the Car Wash Controller returns an invalid
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day.
E4005 INVALID INPUT Entered an invalid value. Wait for the prompt to clear
Either and enter the correct information.
may
appear ERROR DISABLING | An attempt was made to disable the car wash but was
CAR WASH unsuccessful. Check the connections. Call the servicer
if the connections are good.
E4006 ERROR ENABLING An attempt was made to enable the car wash but was
CAR WASH unsuccessful. Check the connections. Call the servicer
if the connections are good.
E4007 PLU ALREADY USED | Attempted to assign a PLU to a car wash but it has
already been assigned. Assign another PLU.
E4008 NO OPEN PLUS Attempted to assign an open PLU to a car wash. This is
ALLOWED not allowed.
E4009 UNABLE TO READ Attempted to assign a PLU to a car wash but the car
CAR WASH FILE wash key file cannot be read. Have the servicer
investigate.
E4010 ONLY CAR WASH Attempted to assign a PLU to a car wash when the PLU
ITEMS ALLOWED has not been assigned to a car wash department.
Assign the PLU to a car wash department then assign
the PLU to a car wash.
E4011 C/W PORT Alarm Line Only: Another device has been assigned to
CONFLICT the car wash port. Check for correct port assignments.
E4012 CAR WASH Alarm Line Only: The POS was unable to communicate
COMMUNICATION with the car wash device. The servicer should
ERROR investigate.
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Car Wash Pay Point

Overview

This feature supports up to 4 Car Wash PayPoints; allowing customers to pay for a car
wash at the car wash itself with cash or card. Cash payment is handled at the
paypoint and credit/debit payment is handled through the POS card processing
network. All sales made using this feature are made available to the system for
reporting.

Note: Refer to the Car Wash Pay Point feature reference documentation for
information on this feature. The Feature Reference is available on Premier

Portal.
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Cash Acceptors

Overview

Cash Acceptors can be used to allow customers to purchase fuel using cash at the
DCRs. This is for cash acceptors that are internal to the dispenser.

The cash sales are reported along with the outside sales on the POS system.

Using Cash Acceptors

1.

2.

4.

5.

To begin a transaction, insert a bill in the Cash Acceptor

Continue to insert bills until the desired amount of fuel to be purchased

is reached

. Press [Enter]

Dispense Fuel

The standard receipt procedures occur

Configuring Cash Acceptors

The Cash Acceptor Configuration form is used to set up and edit cash acceptors at the

site. Site Information determines the behavior of all cash acceptors at a site.
Attributes determines the behavior of a specific cash acceptor at a specific fueling

point.

Cash Acceptor Configuration

Cash Acceptor Site Information

O pisable If Cheated [Js1 Bl Enabled
[Jpisable If Paper Low [J82 Bill Enabled
[ pisable If No Printer [J¢5 Bill Enabled
DF'rt:mp?. insert cash’ [J$10 Bill Enabled

Timeout[Seconds 10-99] |10

Cash Acceptor Attributes

Cash Acceptor |1 v

[Is20 Bil Enabled
[Js50 Bill Enabled
[Js100 Bill Enabled
[Osill orientation

/| Duplicating Acceptor 1
1. Select target Acceptors to the left
2. Use the Ctrl key to select multiple acceptors

4. Click the "Duplicate” button

- Duplicate

3. Use the Shift key to select a range of acceptors

[ cash Acceptor In Dispenser

U Reset Printer Eror
O Print Totals Now
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Cash Acceptors

Disable If Select to turn off a cash acceptor when someone tries to
Cheated cheat it.

Disable If Paper Select to turn off a cash acceptor if the receipt tape is
Low running out.

Disable If No Select to turn off a cash acceptor if the printer is not
Printer working.

Prompt ‘insert Select to have the phrase “OR INSERT CASH” appear at
cash’ the end of the idle prompt.

$1 Bill Enabled Select to allow acceptance of one-dollar bills.

$2 Bill Enabled Select to allow acceptance of two-dollar bills.

S5 Bill Enabled Select to allow acceptance of five-dollar bills.

$10 Bill Enabled Select to allow acceptance of ten-dollar bills.

$20 Bill Enabled Select to allow acceptance of twenty-dollar bills.

$50 Bill Enabled Select to allow acceptance of fifty-dollar bills.

$100 Bill Enabled | Select to allow acceptance of one hundred-dollar bills.

This parameter does not apply to Tokheim dispensers.

Select to require that bills are inserted face-up with the
black-seal end first.

Bill Orientation (If not selected, bills can be inserted face-up in either
direction.)

Note: The black seal appears on the front of the bill to
the left of the face.

Timeout Enter the time (in seconds) between when a customer
inserts a bill and when the pump shuts off if no fuel has
[Seconds 10-99] been pumped (10 - 99).
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Cash Acceptor
Attributes -

Cash Acceptor Select the number of the fueling point.

Click to copy the current cash acceptor’s attributes to
Duplicate any number of other cash acceptors. In the Duplicating
Acceptor Acceptor form, select the cash acceptor(s) to which you
want to copy and click Done Duplicating.

Cash Acceptor In Select to indicate that the fuel pump has a cash
Dispenser acceptor.

Note: This parameter is not currently supported.
Reset Printer
Error Select to enable the printer after the cash acceptor has
been disabled and brought back online.

Note: This parameter is not currently supported.

Print Totals Now | qoiact to print the amount of money in the cash

acceptor.
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Cash/Credit Pricing

Overview

Cash/Credit Pricing is used to allow a site to sell fuel at different fuel price levels
based on whether the sale is paid by Cash or Credit (e.g. sites will often set the credit
fuel price higher than the cash fuel price to offset the credit transactions fees for the
site).

If the site is using different fuel prices for cash and credit, they must disable (or
uncheck) the Ignore MOP Conflict setting in Fuel Configuration > Site Params.

The price level for each card type can be configured in the Payment Controller > EPS
Configuration > <Primary FEP> FEPCard - Cash Credit Pricing by Card Type
configuration screen.

If no configuration is done for the price level by card type, debit and prepaid cards
default to cash fuel price level and all other card types default to credit fuel price
level.

Using Cash/Credit Pricing

Prepay Transactions

Amount Prepay: If the transaction is tendered by cash, the customer dispenses
fuel at the cash fuel price level at the pump. If the transaction is paid by
credit, the customer dispenses fuel at the fuel price level configured for the
card type (e.g. debit cards can either be configured at cash or credit price
level).

Volume Prepay: For volume prepays, the cashier must select a fuel grade and a
fuel price level when they ring up the fuel prepay. If the transaction is tendered
by cash, the MOP entered must match the fuel price level selected by the
cashier. If the transaction is paid by credit, the price level configured for the
card type must match the fuel price level selected by the cashier. If thereis a
price level conflict, then an error message appears indicating "MOP Conflict".

Postpay Transactions

When the Ignore MOP Conflict parameter is enabled (or checked), sales can be
tendered using any MOP regardless of the original fuel price level of the sale.
When this parameter is not enabled (or not checked) and if the transaction is
tendered by cash, the MOP entered must match the fuel price level. If the
transaction is paid by credit, the price level configured for the card type must
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match the fuel price level. If there is a price level conflict then an error
message appears indicating "MOP Conflict".

DCR Transactions

Transactions initiated at the dispenser card reader are authorized at the fuel
price level that has been configured for the card type that is used.

Configuring Cash/Credit Pricing

If the site is using different fuel prices for cash and credit, they must disable (or
uncheck) the Ignore MOP Conflict setting in Forecourt > Fuel > Site Parameters.

Fuel Manager

b0 CRae e Tl Fuel Servica Levals | Fuel MOPs | Fuel Tanks | Fuel Blend Types Fueling Positions

Tier2 Schedule Settings
Unit of Measure [Gallong™]

S N=or [ Start Tier 2 Pricing |0 ™
T ST ’3_\'[ Number of Tier Hours IG—E!
Total Decimal Position [2 ™| Postpay Schedule Settings
Autodisapproval Delay  [5.0 e Start Posipay Aowed m
I BnreIM O Conky I Number of Postpay Hours ,24—_'\/!

Approve All Enabled =
Autocoliect Inside |

O

Force 9 Cents Per Gallon  []
¥ Manual Approval Schedule Settings
O

Start Manual Approval 2 v
Required —

Number Manual Approval
~
Hours 1° ™~

Grade Restriction

Offline Fuel Prompt

Mumber of Seconds |1 ~

Enforce Prompting Insidge [
Prompt Restriction Outside |

Configure cash and credit price amount for each fuel product service levels in
Forecourt > Fuel Prices form.

Pricing Manager

Fuel Product Prices WorkSheet

Froduct m
Tigr Ong Prices Tier Twe Prices
service Level]|  mop || Price Service Level|  moP Price
SELF casH | 1111 SELF CASH 1112
SELF cRED | 1121 SELF CRED 1122
FULL casd | 1211 FULL CASH 1212
FULL CRED I 1221 FULL CRED 1222
Wil casH | 1311 MIN CASH 1312
MINI cRED | 1.321 MM CRED 1322
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Price Tier allows credit cards to be setup for cash pricing for fuel. Configure Price
Tier in Payment Controller > EPS Configuration > <Primary FEP> > FEPCard Type
form.

E FEP Card Type

Select Card Type Card Information

BF - VALFR Card Name |AMEX
DE - VISADEEBIT

DE - MC DEBIT Entry Point | both
DB - GASCRD DEBIT Card Enabled
DE - AEMP DEBIT -

OE - GASPRO DEBIT E Manual Entry Allowed

DB - DEBIT |PriceTier [creait  [=]]
DS - DISCOVER

EB-EBTFS o

EC - EBT Cash Card Limits

FL - FLEET ONE

CF - FUELMAN Inside Offline Limit 74
GP - GENERIC PROPRIETAR OutSide Offiine Limit 74
MC - SunocoRwds

MC - SunocolC DCR Auth Amount 100
MC - MASTERCARD Small Credit Amount 25
MF - MC FLEET

SC-DRVTY

SC-SINCLAIR R -

Troubleshooting

If the site is using Cash/Credit pricing and did not ensure the Ignore MOP Conflict
parameter is disabled (or unchecked), customers are able to select cash price level at
the pump and pay with credit MOP for postpay transactions. This would result in the
customer receiving the lower cash price even though they are paying by credit.
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Combined Discounts

Overview

Discounts can be applied in varying ways to the transaction and are distinguished at
the following levels:

= Price Per Gallon (PPG) Discounts: These discounts reduce the price of fuel at
the dispenser prior to fueling.

= Line Item Discounts: These discounts are amount discounts that apply against
an individual line item for a transaction.

= Ticket Level Discounts: These discounts are amount discounts that apply to
the entire transaction.

Discounts Categories

= Local: Local discounts are configured and applied on the POS system.
= Host: Host discounts are applied by the loyalty or payment host.

Local Discounts

POP Discount (PPG and Fuel Line Item): Only one POP discount allowed per
transaction.

VIP NAXML Discounts (Line Item): Multiple VIP NAXML discounts may be applied per
transaction.

Car Wash Promotions (Carwash Line Item): Only one Car Wash promotion allowed
per transaction.

Special Discount (MOP Ticket Level): Only one Special discount allowed per
transaction.

Manual Discount (Line Item): Multiple Manual discounts may be applied per
transaction.

Host Discounts

EPS Loyalty Discount (PPG, Ticket Level, and Line Item): Multiple EPS Loyalty
discounts may be applied per transaction.
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Payment Host Discounts (PPG, Ticket Level, and Line Item): Multiple Payment Host
discounts may be applied per transaction.

Using Combined Discounts

Multiple ticket level discounts may be applied in a single transaction.

A line Item may receive multiple discounts depending on order of the
discounts within the transaction and loyalty host response.

Depending on configuration, multiple PPG discounts can be combined in a
single transaction as a stacked PPG. This means that the multiple PPG
discounts may be combined to a single PPG discount in fuel price. The
combined discount cannot lower the price per gallon at the dispenser to
lower than the minimum Price Per Unit (PPU) setting in Fuel
Configuration.

When combining Payment Host and EPS Loyalty discounts, the Payment
Host discounts have a higher precedence than EPS Loyalty discounts.

Configuring Combined Discounts

Inorder for the discount to be applied, the discount feature must be enabled and
configured. Refer to the configuring section of the appropriate topic for further

details.

The "EPS PPG precedes POS PPG" parameter can be found in Payment Controller >
POS configuration > POS > Loyalty. When this parameter is enabled, EPS Loyalty PPG
discounts are applied before considering any POS PPG discounts. When this parameter
is disabled, POS PPG discounts are applied before considering any EPS Loyalty PPG

discounts.
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Corrections

Overview

Use any of the following correction functions to remove, cancel, modify, or change
line items in a transaction or to void the entire transaction:

« ERROR CORR - Removes most recently entered line item or payment method
when amount due > 0.

e VOID LINE - Removes any non-fuel line item in the transaction.
o VOID TICKET - Cancels the entire transaction.

o PRICE OVER - Modifies unit price of a line item.

« Change Qty - Modifies the quantity of a line item.

o Allow Food Stamp - Allows the item that is entered to be purchased with food
stamps.

Note: After a loyalty card has been swiped, [VOID LINE] or [ERROR CORR]
cannot be used, [VOID TICKET] must be used instead.

Using Corrections

Utilizing the various correction keys is dependent on if the cashier who is logged in
has the required security level to perform the function.

Error Correct

Press [ERROR CORR] to remove last entry or partial payment entered in a
transaction

Note: [ERROR CORR] does not work if [CREDIT] has been pressed.

Void Line

1. Touch the line item to be voided, touch [VOID LINE]; if prompted, key
User ID and password

2. Key the line item exactly as it was first entered, and the line item
negating the voided line is added to the transaction
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Or
1. Press [VOID LINE], and if prompted, key the User ID and password

2. Key the line item exactly as it was first entered, and the line item
negating the voided line is added to the transaction

Void Ticket
1. Press [VOID TICKET], and if prompted, key the User ID and password

2. Entire ticket is voided and the system is ready to begin a new
transaction

Price Override

1. Immediately after a line item has been added to the ticket, key new unit
price

2. Press [PRICE OVER] to change the unit price of that particular item
and to recalculate the line item

Or
1. Touch the line item, and key the new single-unit price

2. Press [PRICE OVER] to change the unit price of that particular item and
to recalculate the line item

Change Quantity
1. Touch the line item to be changed, and key the new quantity
2. Touch Change Qty to recalculate the line item using the new quantity
Allow Food Stamps for Item
This function processes an item not configured as food stamp eligible as though
it is eligible for payment with food stamps. It should be used in only accordance
with store policies and procedures.

1. Press [ALLOW FOOD STAMP]

2. Key item
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3. Tender Sale with Food Stamps MOP alone or in combination with another
MOP

Configuring Corrections

Corrective functions may be customized through available options found in Store
Operation > Sales.

Securing Corrective Functions

To secure corrective functions, enter a security value greater than zero for the
appropriate function in "Sales Configuration.” This forces a prompt for user ID and
password and requires the security level of that user to meet or exceed the security
level of the function.

The following corrective functions may be configured to require ID and password
entry:

e Error Correct

Void Line

Void Transaction

Price Override

Forcing Receipt Print for Corrective Functions

The following functions may be configured to force a receipt print when used:
« Void Transaction
« Void Line

Reporting

The Corrections information is available in the “Memo Items” section of the following
reports:

e Summary Report

o Cashier Report
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ERR/CORRECTS 1 2.54
VOID LINES 1 0.69
Sample Cashier
Summary Report
VOID TICKETS (+) 2 1.25
VOID TICKETS (-) 2 6.00

Report Details

o« ERR/CORRECTS: Number of times and total amount caused by using the
[ERROR CORR].

« VOID LINES: Number of times and total amount caused by using [VOID LINE].
This does not include lines voided as part of a void ticket.

« VOID TICKETS: Number of times and total amount caused by using the [VOID

TICKET] key. This includes a line for positive amounts and a line for negative
amounts.

Troubleshooting

If you try to void an item that is not in the transaction
or do not enter the item exactly as it was originally
OPER. NOT
E1119 ALLOWED entered, then the message
“E1119: OPER. NOT ALLOWED?” displays briefly.
USE VOID Attempted to use [ERROR CORR] to remove more than
the last item from the current transaction. Use [VOID
E1106 LINE/VOID . . .
TICKET LINE] to remove additional items frqm the transaction
or [VOID TICKET] to remove the entire ticket.
E1200 USE VOID [VOID LINE] cannot be used in this transaction, use
TICKET [VOID TICKET].
Attempted to enter disallowed functions after a
FUNC NOT loyalty card has been swiped (assuming a discount is
E1297 VALID AFTER given). For example, void line or error correct are not
LOYALTY allowed after a loyalty packet has been sent. You must
either void the ticket or complete the sale.
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Department Sales

Overview

A department is a group of similar items. For example, a dairy department might
include items like milk, butter, eggs, and ice cream.

A department item is sold in one of the following ways:
o [Department] soft key: A specific key set up for a specific department.

o [OTHER DEPT] key: A specific key set up to accept sales to any defined
department number.

The maximum number of departments that can be configured by platform:
o Ruby Ci - 9999
o Commander Site controller - 9999
Do not use departments 9990-9999:
e 9990 - Loyalty (invisible department)
e 9991 - Loyalty (invisible department)
e 9992 - Fees (invisible in new applications)

e 9998 - Manual fuel deposit - not invisible but required to ring up a manual fuel
sale that doesn’t set the dispenser. This must not be altered or changed.

e 9999 - Fuel Deposit (invisible) this department is read only because it’s the
holding department for prepay fuel sales. It cannot be modified or changed.

Using Department Sales
Following are the types of Department Sales:

o Basic Department Sale

« Department Sale with Fee (Money Order)
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« Department Sale with ID Check

o Department Sale with Fractional Quantity

e Department Sale with At-For Pricing

Basic Department Sale
1. Key <amount> of the item
2. Do one of the following:
= Touch department
= Press department key

= Press [OTHER DEPT] and then press appropriate department in
the Other Department list

Department Sale with Fee (Money Order)

Money orders are typically sold using department keys. It is common to charge a

fee for each money order sold. This fee is typically configured to be added
automatically.

Note: No more than five money orders can be sold during a single transaction.
1. Key <amount> (for example: [1][0][0][0] = $10.00)

2. Touch [MONEY ORDER] soft key

Or

1. Press [OTHER DEPT] and touch Money Order in the Other Department
list

2. Key <payee> or touch [OK] for a blank nhame

3. Touch [OK] or press [ENTER] to complete manually and add money
order sale to the transaction along with any applicable configured fee

Department Sale with ID Check

Departments with alcohol and tobacco products are usually set up with age
verification. Purchase of these products is the same as with other departments
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with the exception of the age verification feature. The system displays a
message alerting the cashier that an ID check is required.

The system rejects further entries until the date of birth is entered. Once
entered, the system determines if the customer is old enough to purchase the
item and either adds it to the transaction or displays a message.
1. Touch or scan a product requiring ID checking
2. Do one of the following:
= Key birth date (mm/dd/yy) and touch [OK] or press [ENTER]
= Swipe the magnetic stripe on the driver's license

» Scan the 2D barcode on the driver's license

The system either adds item to transaction or displays a message that purchase
is not allowed.

Department Sale with Fractional Quantity
Department items can be sold in fractional quantity.
1. Key quantity to be sold (for example: [5] [0] = 1/2 pound)
2. Press [QTY] or enter the department item
3. Do one of the following:
= Key a PLU on the keyboard and press [ENTER]
= Touch a PLU soft key
= Scan the barcode
Department Sale with At-For Pricing
Pricing for some department items is based on purchase of a particular quantity;
for example, 3 candy bars for § 1.00. This is known as At-For Pricing (@/
pricing).
Note: At-For Pricing cannot be used with items sold in fractional quantities.

1. Key quantity being sold and press [QTY]
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2. Key number of items on which the price is based (for example, if the
item sells three for $1.00, then key [3])

3. Press [QTY] and key the base price (for example, key [1][0][0])
4. Do one of the following

= Touch the department

= Press the department key

= Press [OTHER DEPT] and then touch the department in the Other
Department list

Recap: To ring up one unit of item that sells 3 for $ 1.00 - Press [3][QTY] [3]
[QTY][1][0][0] this will look on screen like 3@3/100, then department.

Configuring Department Sales

Use Department section under Store Operations > Merchandise > Departments to
define the departments.

Merchandise Configuration

Merchandise Configuration

HUGITRNGLEER  Departments

Add [ |Delete
Select Department Number Name
6541 - Lottery Sales Winner 6541 |Lﬂﬂery Sales Winner ‘
9995 - TEST A DEPT =
9996 - TEST B DEPT . Amount fhax. Amount
9997 - TEST C DEPT | y | | - ‘
9998 - MANUAL FUEL DEPT P G Category
|0399 - MISCELLA OTHER Fi[v| | v
Fuel Tax Exemption Transaction Quantity Limit
~ [o0o |
Fees
I Edit
ID Check
I Edit
Taxes
I Edit
Blue Laws
Edit
Options
[JAllow Food Stamps [C]Allow Special Discount
[] Allow Fractional Quantity [¥] Negative Department
[ Fuel Department [IMoney Crder Department
[ Prompt Serial Num [_IProhibit Manual Discount
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Number Enter the new department number (1 - 9999).
Delete Click to delete the selected department.

Add Click to add a new department.

Name Enter a description (alphanumeric, 1 - 16).

Enter the department’s minimum allowable dollar amount for

Min Amt a line item sale (0.00 - 9999.99).

Enter the department’s maximum allowable dollar amount for

Max Amt a line item sale (0.00 - 9999.99).

Select the name assigned to the product code (set by the
network) that categorizes the products sold.

Product Code Note: If a PLU and a department have different codes, the
product code assigned to the PLU overrides but only if the
product code in the PLU File = 0.

If categories are used, select the category.

Category Note: Categories are set up in Store Operations >

Merchandise > Category.

If a fee automatically applies to sales in this department,
select the fee.

Fee
Note: Fees are set up in Store Operations > Payment >
Fees.

If the department requires an ID check for purchase, click the
Edit button.

ID Check In the ID Check form, select the appropriate ID Check. Click
Done.

Note: ID Checks are set up in Store Operations >
Restrictions > ID Check.
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Department Sales

If a tax is added when items in the department are sold, click
Edit and select the appropriate tax.

Note: Taxes are set up in Store Operations > Payment >
Tax Rates

Blue Laws

If the sale of an item in the department is restricted on a
designated day(s), click Edit and select the appropriate Blue
Law.

Note: Blue Laws are set up in Store Operations >
Restrictions > Blue Laws

Fuel Tax
Exemption

Select the Fuel Tax Exemption that applies to the
department.

Notes:
e This parameter does not appear unless a Fuel Tax
Exemption record has been set up in Forecourt > Fuel

Tax Exemption.

e Applies to fuel departments only.

Transaction
Quantity Limit

Determines the quantity limit per transaction.

This parameter is used to restrict bulk quantity purchase of
certain items. This field accepts non-negative decimal
number to allow for fractional quantity. Default value is 0.00
and means that there is no restrictions on the total purchase
quantity in a transaction.

Allow Food
Stamps

Select if food stamps may be used to purchase items in this
department.
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Select if the items in this department may have a special
discount applied to them (for example, a Senior Citizen

Allow Special Discount).

Discount Note: If this parameter is selected, then Special Discount
MOP should be set up in Store Operations > Payment > MOP
with Special Discount MOP Code.

Select if items in this department are to be sold in fractional
quantities.

Allow ; . s .

. Note: If this parameter is selected, all quantities entered in
Fractional . :
Quantity department sqles for this erartment are read as decimals.

For example, if the quantity is 1% lbs of turkey, key [1] [7]
[5]. If this parameter is not selected, all quantities entered
are read as whole numbers.

Negative Select if transaction amounts are subtracted from receipt and

Department report totals.

Select to define the department as a fuel department.

Fuel

Department Note: If this parameter is selected, then do not select “Mark
as Negative.”

Select to define the department as a money order

Money Order department.

Department Note: If this parameter is selected, then do not select "Mark
as Negative."
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Prompt Serial
Number

Department Sales

Some items that Convenience Stores sell need to have their
serial number printed on the receipt. When such an item is
scanned/entered, the POS needs to prompt the cashier to
enter the product’s serial humber.

Enable to prompt for serial number to be printed on the
receipt. Cashier can either enter the serial number or bypass
the prompt to complete the transaction. Serial number can
be entered via screen keys, hard keys, or scanned via
scanner.

Prohibit
Discount

Select to prohibit discounts configured to be applied by
pressing the discount key.

Prohibit Discount does not affect PLU Promo, NAXML Promo
(Combo/MixMatch), or Loyalty line item discounts.

Reporting

The Department Report reflects sales-related totals and counts on a department by

department basis.

DEPARTMENT REPORT

DEPT# DESCRIPTION CUST ITEMS $OF SALES

GROSS REFUNDS DISCOUNTS NET SALES

9001 BAKERY 2 2.00 2.83% Sample Department
Report for All
11.00 0.00 0.00 11.00 Departments
9004 TAX GROC 5 6.00 2.46%
10.26 0.00 0.70 9.56
9005 DAIRY 2 2.00 1.31%
5.58 0.00 0.50 5.08
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9006 N/TAX GROC 3 1.00 3.48%
15.50 2.00 0.00 13.50
9030 MONEY ORDER 2 2.00 30.96%
120.00 0.00 0.00 120.00
9031 M.O. FEE 2 3.00 . 81%
3.00 0.00 0.00 0.22
9032 BOTTLE DEPOS 1 7.00 0.33%
1.30 0.00 0.00 1.30
9033 BOTTLE RETUR 1 -2.00 -0.08%
-0.30 0.00 0.00 -0.30
9040 UNLD. 2 2.00 25.80%
100.00 0.00 0.00 100.00
9041 MID 1 1.00 12.96%
50.24 0.00 0.00 50.24
9042 PREM. 1 1.00 11.86%
50.00 0.00 4.02 45.98
9050 PLU NOT FOUN 1 1.00 0.32%
1.25 0.00 0.00 1.25
9060 MISC 8 12.00 2.11%
32.98 0.69 4.95 8.20
NEG DEPTS -2.00
-0.30 0.00 0.00 -0.30
OTHER DEPTS 66.00
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400.81 2.69 10.17 387.95
TOTAL 64.00 100.00%
400.51 2.69 10.17 387.65

Report Details

DEPT#: Four-digit identification of the product as it appears in the Department
File.

DESCRIPTION: Description of the product as it appears in the Department File.

CUST: Number of transactions that included one or more items from this
department.

ITEMS: Quantity sold of this item.

%OF SALES: Total Sales for this department divided by Total Sales (all
departments).

GROSS: Total dollar amount collected for sales of a department.
REFUNDS: Total dollar amount refunded for items returned in a department.

DISCOUNTS: Total dollar amount discounted for items sold in a department.
This total includes both automated and manual discount types:

o Use of the [DISC], [DISC%], and [DISC AMT] keys
o Combo, mix 'n match, fuel, and promotional discounts
o POP discounts

NET SALES: Total dollar amount of items sold in a department after refunds
and discounts have been applied.

NEG DEPTS: The totals for departments marked as negative departments.

OTHER DEPTS: The totals for other department sales not marked as negative
departments (typically, most departments fall into this group).
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o« TOTAL: Total department sales after negative department total is subtracted
from other (standard) departments.

Troubleshooting

The department entered in Department
Setup function in Car Wash Manager mode
E1115 INVALID DEPARTMENT does not exist. Define the department in
the Department File or choose another
department

The dollar amount entered is larger than
E1116 AMOUNT TOO LARGE the maximum allowed for this department
or MOP.

The discount entered is less than the set

E1121 DISCOUNT TOO SMALL ..
minimum amount.

The discount entered is more than the set

E1122 DISCOUNT TOO LARGE .
maximum amount.

The dollar amount entered is less than the

E1131 AMOUNT TOO SMALL minimum set up for the department or
MOP.
E1140 AMOUNT REQUIRED A dollar amount must be entered.

The customer cannot purchase this item
because either (1) the date of birth entered
for the ID check does not meet the age
requirements or (2) a Blue Law restriction
has been set up for this item or department
at this time on this day.

E1141 PURCH. NOT ALLOWED

E1145 CASH ONLY ALLOWED Only cash is allowed in this transaction.
E1201 NO AT-FOR SALES At-for pricing cannot be used for items that
W/FRACTIONAL QTY can be sold in fractional quantities.

The department number was determined to

E6720 DEPARTMENT INVALID . .
be invalid.
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User has attempted to configure an invalid

PART OF LOYALTY

E7056 DEPARTMENT NOT FOUND department for the Loyalty program.
User has attempted to configure the same
E7057 DEPARTMENT ALREADY department more than once in the Loyalty

file.
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Dispenser Card Readers

Overview

Dispenser Card Readers (DCRs) give customers the option of paying at the dispenser.
DCRs read the magnetic stripe of credit, debit, and similar cards, sends the
information to a credit network, and controls dispensing fuel based on the network’s
response.

Dispenser Types

Although different manufacturers refer to card readers by various trade names,
Verifone uses DCR (Dispenser Card Reader) as a generic term for all of them.

Bennett Dispenser Card Terminal (DCT)

Dresser/Wayne Dispenser Card Processing Terminal (DCPT)

Gilbarco CRIND®: Card Reader IN Dispenser

Tokheim Dispenser Payment Terminal (DPT)

Using Dispenser Card Readers

Dispenser Card Reader (DCR) Card Fuel Sale

Below are some common functions that are related to DCR sales:

= Approve DCR Transaction: Some states require cashier intervention
before fueling can begin.

= View Fueling Point: A small yellow triangle indicates that the network
has returned a message or customer has requested help. In either case,
fueling position should be viewed to clear the message.

= Reprint DCR Transaction: Occasionally, customers come to the counter
to request a DCR receipt (paper ran out).

This function reprints DCR and completed prepay transaction receipts.

Touch <fueling point> [VIEW], touch [Reprint DCR TRAN] and select the
transaction to print.
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The most recent transaction is always at the top of the list and

highlighted.

During a DCR transaction, a small card icon appears in the background of the
graphic for that fueling position as shown below:

POS Icon Description

35

DCR Calling: Customer swipes the credit card and the card
appears on button.

DCR Approved: Image changes into a nozzle ready to dispense
fuel.

DCR Dispensing: Nozzle moves and fuel "drips” to show fueling.

Idle: Fueling point returns to Idle upon completion of DCR sale.

Help: Help is requested or there is a network message that
should be viewed. View pump to clear the icon.

DCR Sales Sequence Table

The sales sequences for DCR transactions for all dispensers the POS supports are in
the tables below. These tables show how the configuration can change the customer
experience at the pump. Consider the following in all tables:

= If the POS is in the idle state, the fueling point number remains lit and the

icons are dark.

= If the POS is sending data to the DCRs, a “LOADING” message replaces the
current prompt until the transmission is complete.
= Card types cause different prompts to appear:

= Debit cards: If a customer inserts a debit card without first pressing the
[DEBIT] key, “DEBIT OR CREDIT?” appears on the display. After a card
has been identified as a debit card, the display prompts with “ENTER

PIN.”

= Fleet cards: Different Fleet cards prompt the customer for information
such as odometer reading, vehicle identification number, etc.

= Stored Value Cards: Also known as prepaid cards, these cards usually
display the balance that remains on the card.
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DCR Sales Examples
The following DCR sales examples are mentioned the DCR sales sequences table:

= DCR Sale Using a Card

= DCR Sale Using a POP Discount Code

= Pay Inside Sale Using a POP Discount

= Postpay Inside Sale

= Prepay Inside Sale

= (Card Rejected with Hot Pump Enabled
= Card Rejected with Hot Pump Disabled
= Card Not Removed

= POP Discount Code Rejected

DCR Sale Using a Card

DCR Sale Using a Card

User/DCR Action POS Action DCR Prompt
DCR is in idle state. Idle state. Idle Prompt
REMOVE CARD RAPIDLY
Customer inserts a Fueling point number icon Schlumberger: PLEASE
card. flashes. REMOVE THE CARD

Displays for 5 seconds.

Customer removes
card. If customer does
not remove card, see
“Card Not Removed”
table.

POS performs local validation of

ONE MOMENT PLEASE
card.

POS requests card

Customer waits. g
authorization.

“Hot DCR pump” in Fuel Manager > DCR Configuration is set to ‘Y’.
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User/DCR Action

DCR Sale Using a Card

POS Action

Dispenser Card Readers

DCR Prompt

Credit or debit card:
The customer waits.

POS approves pump before
authorization is received. Car
icon lights. If authorization is
then rejected, see “Card
Rejected with Hot DCR Pump
Enabled.” Card rejection
information is noted on the
journal.

Start Fueling Prompt

“Hot DCR pump” is set

to ‘N’.

Credit or debit card:
The customer waits.

POS approves pump after
receiving authorization. If
authorization is rejected, see
“Card Rejected with Hot DCR
Pump Disabled.” Card rejection
information is noted on the
journal.

Start Fueling Prompt

Customer removes
nozzle and dispenses
fuel.

POS sounds a tone to indicate
fueling has started. Nozzle icon
lights.

Promotional Message

If “Always print receipt” parameter in DCR Site Parameters in Fuel Manager mode is

set to ‘N’.

Customer completes
fueling and replaces
nozzle. Customer
responds ‘Yes’ to
“RECEIPT?”

Fueling point number icon
flashes. Ruby beeps to indicate
fueling is complete.

RECEIPT (YES/NO)?
followed by PRINTING
RECEIPT followed by
RECEIPT IS READY Displays
for 5 seconds - beeps.

Customer completes
fueling and replaces
nozzle.

Customer responds
(No!

Fueling point humber icon
flashes. POS beeps to indicate
fueling is complete.

RECEIPT (YES/NO)?
THANK YOU

If “Always print receipt” is set to ‘Y’.
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User/DCR Action

DCR Sale Using a Card

POS Action

DCR Prompt

Customer completes
fueling and replaces
nozzle. Customer
waits.

Fueling point number icon
flashes. POS beeps to indicate
fueling is complete.

PRINTING RECEIPT
followed by RECEIPT IS
READY THANK YOU,
displays for 5 seconds -
beeps.

DCR returns to idle
state.

Idle state.

Idle Prompt

DCR Sale Using a POP Discount Code

User/DCR Action

DCR Sale Using a POP Discount Code

POS Action

DCR Prompt

DCR is in idle state.

Idle state.

Idle Prompt

Customer inserts a
card.

Fueling point number icon flashes.

REMOVE CARD RAPIDLY
Schlumberger: PLEASE
REMOVE THE CARD

Displays for 5 seconds.

Customer removes
card. If customer
does not remove
card, see “Card Not
Removed” table.

POS performs local validation of
card.

ONE MOMENT PLEASE

Customer waits.

POS requests card authorization.

are set to ‘Y’.

“Hot DCR pump” in Fuel Manager > DCR Configuration is set to ‘Y’; “POP Discount
Enable” and “POP Discount Code Enable” in Manager > Configuration > Sales Config

Customer enters ‘Y’
or ‘N’.

POP CODE? Y/N
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User/DCR Action

If customer enters
‘Y’, prompt to enter
the POP code
appears.

Dispenser Card Readers

DCR Sale Using a POP Discount Code

POS Action

DCR Prompt

ENTER DATA

Customer enters 7-
digit POP Code.

POS approves code before
prompting for card. If code is
rejected, see “POP Code Rejected”
table.

Credit or debit
card: The customer
waits.

POS approves pump before
authorization is received. Car icon
lights. If authorization is then
rejected, see “Card Rejected with
Hot DCR Pump Enabled.” Card
rejection information is noted on
the journal.

Start Fueling Prompt

“Hot DCR pump” is s

et to ‘N’.

Credit or debit
card: The customer
waits.

POS approves pump after receiving
authorization. If authorization is
rejected, see “Card Rejected with
Hot DCR Pump Disabled.” Card
rejection information is noted on
the journal.

Start Fueling Prompt

Customer removes
nozzle and
dispenses fuel.

POS sounds a tone to indicate
fueling has started. Nozzle icon
lights.

Promotional Message

set to ‘N’.

If “Always print receipt” parameter in DCR Site Parameters in Fuel Manager mode is
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User/DCR Action

DCR Sale Using a POP Discount Code

POS Action

DCR Prompt

Customer completes
fueling and replaces
nozzle. Customer
responds ‘Yes’ to
“RECEIPT?”

Fueling point number icon flashes.
POS beeps to indicate that fueling
is complete.

RECEIPT (YES/NO)?
followed by PRINTING
RECEIPT followed by
RECEIPT IS READY
Displays for 5 seconds -
beeps.

Customer completes
fueling and replaces
nozzle.

Customer responds
(No’

Fueling point number icon flashes.
POS beeps to indicate fueling is
complete.

RECEIPT (YES/NO)?

THANK YOU

If “Always print receipt” is set to ‘Y’

Customer completes
fueling and replaces
nozzle. Customer
waits.

Fueling point number icon flashes.
POS beeps to indicate fueling is
complete.

PRINTING RECEIPT
followed by RECEIPT IS
READY THANK YOU
displays for 5 seconds -
beeps.

DCR returns to idle
state.

Idle state.

Idle Prompt

Pay Inside Sale Using a POP Discount

User/DCR Action

Pay Inside Sale Using POP Discount

POS Action

DCR Prompt

DCR is in idle state.

Idle state.

Idle Prompt

Customer selects any PAY
INSIDE option (PAY INSIDE

CASH, PAY INSIDE
CREDIT).

Car icon flashes and POS beeps
repeatedly.

ONE MOMENT PLEASE
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User/DCR Action

POS Action

Dispenser Card Readers

DCR Prompt

Customer waits.

Cashier approves pump. Nozzle
icon lights.

Start Fueling Prompt

Customer dispenses fuel.

POS sounds a tone to indicate
that fueling has started.

Promotional Message

Customer completes
fueling and replaces
nozzle.

Dollar icon lights. POS beeps to
indicate fueling is complete.

PLEASE PAY CASHIER
Displays for 20 seconds
- beeps 3 times.

Customer goes inside to | If codes are enabled, cashier Idle Prompt
pay. processes POP discount code or

coupon at the POS when fuel

sale is tendered.
DCR returns to idle state.| Idle state. Idle Prompt

Postpay Inside Sale

User/DCR Action

Postpay Inside Sale

POS Action

DCR Prompt

DCR is in idle state.

Idle state.

Idle Prompt

Customer removes nozzle.

Car icon flashes and POS
beeps repeatedly.

ONE MOMENT PLEASE

Customer waits.

Cashier approves pump.
Nozzle icon lights.

Start Fueling Prompt

Customer dispenses fuel.

POS sounds a tone to
indicate fueling has started.

Promotional Message
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User/DCR Action

Postpay Inside Sale

POS Action

DCR Prompt

Customer completes fueling
and replaces nozzle.

POS beeps to indicate fueling
is complete.

PLEASE PAY CASHIER

Displays for 20 seconds -

Dollar icon lights.

beeps 3 times

DCR returns to idle state.

Idle state.

Idle Prompt

Prepay Inside Sale

Prepay Inside Sale

User/DCR Action

POS Action

DCR Prompt

DCR is in idle state.

Idle state.

Idle Prompt

Customer prepays inside.

Car icon lights. Pump is
approved.

Start Fueling
Prompt

Customer inserts card at an
already prepaid pump. (This
applies to systems without a
[CASH] key and the “Handle Up
Calling” set to ‘N’, “Full Service
Preset at Pump” set to ‘Y’ and
“Autocollect” set to ‘0’.)

CARD NOT READ
Displays for 5
seconds - beeps 3
times.

Customer removes nozzle and

Nozzle icon lights. POS

Promotional

prepaid amount.

to indicate fueling is
complete.

follows start fueling instructions, | sounds a tone to indicate Message
and begins to dispense fuel. fueling has started.
Customer completes fueling and | Nozzle icon turns off. POS
replaces nozzle. beeps to indicate fueling is
complete.
Customer has dispensed less than | Dollar icon lights. POS beeps | SEE CASHIER
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Prepay Inside Sale

User/DCR Action POS Action DCR Prompt

Customer has dispensed more Dollar icon lights. POS beeps | SEE CASHIER
than prepaid amount. to indicate fueling is
complete.

Customer has dispensed prepaid | POS beeps to indicate fueling| Idle Prompt
amount. is complete.

DCR returns to idle state. Idle state. Idle Prompt

Card Rejected with Hot Pump Enabled

Card Rejected with Hot Pump Enabled

User/DCR Action POS Action DCR Prompt
DCRis in idle state. Idle state. Idle Prompt
Customer inserts a Fueling point number icon REMOVE CARD RAPIDLY
card. flashes. Schlumberger: PLEASE
REMOVE THE CARD

Displays for 5 seconds.

Customer removes POS validates card. ONE MOMENT PLEASE
card. If customer does
not remove card, see
“Card Not Removed”

table.
Customer waits. POS requests authorization for | Start Fueling Prompt
card and approves pump.
Customer removes Nozzle icon lights. POS sounds | Promotional Message
nozzle dispenses fuel. | a tone to indicate fueling has
started.
Card is rejected. Fueling point number, car, and| PLEASE SEE ATTENDANT
nozzle icons flash. Pump is Displays until cashier
stopped. Card rejection views message inside. DCR

information is noted on the
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User/DCR Action

Card Rejected with Hot Pump Enabled

POS Action

DCR Prompt

journal.

beeps 3 times.

Customer replaces
nozzle.

Dollar icon lights. POS beeps
to indicate fueling is
complete.

PLEASE SEE ATTENDANT
Displays for 20 seconds -
beeps 3 times.

DCR returns to idle
state.

Idle state.

Idle Prompt

Card Rejected with Hot Pump Disabled

User/DCR Action

Card Rejected with Hot Pump Disabled

POS Action

DCR Prompt

DCR is in idle state.

Idle state.

Idle Prompt

Customer inserts a
card.

Fueling point number icon flashes.

REMOVE CARD RAPIDLY
Schlumberger:
PLEASE REMOVE THE CARD

Displays for 5 seconds.

Customer removes
card.

If customer does
not remove card,
see “Card Not

IRemoved” table.

POS validates card.

ONE MOMENT PLEASE

Card is rejected.

Fueling point number, car, and
nozzle icons flash. Card rejection
information is noted on the
journal.

PLEASE SEE ATTENDANT

Displays until cashier views
message inside. DCR beeps
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Card Rejected with Hot Pump Disabled

User/DCR Action POS Action DCR Prompt

3 times.

DCR returns to idle | Idle state. Idle Prompt
state.

Card Not Removed

Card Not Removed

User/DCR Action POS Action DCR Prompt

DCRis in idle state. | Idle state. Idle Prompt

Customer inserts a Fueling point number | REMOVE CARD RAPIDLY Displays for
card. icon flashes. 5 seconds.

Customer does not Fueling point number | PLEASE REMOVE CARD Displays for

remove card. icon flashes. 10 seconds - beeps 3 times.
DCR returns to idle Idle state. Idle Prompt
state.

Note: In addition to message alert beeps, DCR beeps once per second while card is
in reader.

POP Discount Code Rejected

POP Discount Code Rejected

User/DCR Action POS Action DCR Prompt

POP Code is rejected. Fueling point number icon flashes. | INVALID CODE
POP Code rejection information is | CONTINUE Y/N
noted on the journal.

If customer enters ‘Y’, 2nd ENTER DATA
prompt for code entry
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POP Discount Code Rejected

User/DCR Action POS Action DCR Prompt

appears.

If customer enters invalid Fueling point number icon flashes. | INVALID CODE
entry, 3rd prompt for code | POP Code rejection information is | CONTINUE Y/N

entry appears. noted on the journal.

If 3rd attempt fails, INVALID CODE

transaction is cancelled. TRANS
CANCELLED

DCR returns to idle state. Idle state. Idle Prompt

Bad Card Read

Bad Card Read

User/DCR Action POS Action DCR Prompt

DCRis in idle state. Idle state. Idle Prompt

Customer inserts a card. Fueling point number | REMOVE CARD RAPIDLY
icon flashes. Displays for 5 seconds.

Card is unreadable or was Fueling point number | REENTER CARD Displays for

inserted incorrectly. icon flashes. 20 seconds - beeps 3 times.

Customer has made three Fueling point number, | PLEASE SEE ATTENDANT

unsuccessful attempts to car, and nozzle icons Displays for 20 seconds.

insert card. flash.

Card has expired. Fueling point number, | EXPIRED CARD Displays for
car, and nozzle icons 20 seconds - beeps 3 times.
flash.

Additional DCR Prompts

The following additional DCR prompts may appear:
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Dispenser Card Readers

Additional DCR Prompts

POS Action

Customer presses [HELP]
key.

Fueling point
number, car, and
nozzle icons flash.

No prompt displays, but message is
sent inside.

Customer presses
[CANCEL] before
dispensing fuel.

TRANSACTION CANCELED Displays for
10 seconds - beeps 3 times.

Customer inserts a fleet
card.

ENTER DRIVER NO ENTER UNIT NO

ENTER ODOMETER

Customer inserts a
Proprietary card or debit
card.

One of the following prompts
displays:

e ENTER USERID
e ENTER DATA
e ENTERPIN

The customer then keys the
identifying number.

Customer inserts a
Proprietary card.

Card declined by
Proprietary
network.

CARD LOCKED OUT

Customer enters
incorrect PIN, data, or
user ID information for a
Proprietary card.

Prompts customer
to enter correct
information.

One of the following prompts
display: INVALID USER ID INVALID
DATA INVALID PIN The customer is
then directed to: PLEASE SEE
CASHIER

Configuring Dispenser Card Readers

The DCR Configuration form is used to define general operating procedures for
dispenser card readers (DCRs) at the site.

Use Forecourt > DCR to configure DCRs.
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Use Tools > Managed Modules > DCR_Driver_Configuration to assign port and
configure the communication parameters for DCR.

Note: Fuel Manager / Fuel / Site Parameters provides additional parameters required
for successful fuel operations. Refer to the Configuring Fuel Manager section in the
Fuel Manager topic for details on configuring site parameters related to DCRs.

Note: After changes are made to DCR parameters, the command “Tools > Refresh
Configuration” can typically be executed for the new settings to be applied to DCRs.

The Receipt Header/Trailer parameters also require a DCR download.

All the DCR position attributes except Pay At Pump, Push To Start Button, Grade
Select Button, and Lever On Pump require to initialize DCR driver.

DCR

Site Configuration

Use to set up the operation of all DCRs at a site. If these are the last changes you
make before exiting Fuel Manager, use both of the following commands:

= Forecourt > Initialization > DCR

DCR Configuration Save | Cancel

TRyl i 8 DCR Position Attributes | Receipt HeaderTrailer | DCR Display

Approve All Sales

Always Print Receipt

Low Paper Alarm

Receipt Prompt Befare Sale
Receipt Prompt After Sale
Prompt Prepay Receipt Ouiside
Send Preset Amount to Host
Allow Fill-Up with Preset

Armed Forces Restriction
Handle Up Help Message [0-99]

Error Prompt Time [5-300]

Info Prompt Time [5-300]

User Prompt Time [5-300]

Enable Keypress Beep

Enable Aitention Beep

Enable Mistake Beep

Graphics Pay Inside Cash/Credit Prompis
Audible Help Message On POS

Enable Outdoor TAVE

ﬁDBDDDDDHD

Approve All Sales | Select to require the cashier to approve all outside sales.
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Always Print
Receipt

Select to automatically print a receipt at the pump after every
DCR sale. (If not selected, the customer is prompted “Receipt
Y/N?” and must choose whether to print the receipt.)

Low Paper Alarm

Select to alert the cashier when the DCR is low on receipt paper.

Receipt Prompt
Before Sale

Select to prompt the customer about a receipt prior to dispensing
fuel.

Receipt Prompt
After Sale

Select to prompt the customer about a receipt after dispensing
fuel.

Prompt Prepay
Receipt Outside

Select to allow a customer to be prompted for a receipt at the
DCR after prepaying inside.

Send Preset
Amount to Host

Select to send preset amount to host.

Allow fill-up with
Preset

Enable to fill-up gas with the preset amount.

Armed Forces
Restriction

Select to display the Armed Forces prompt “Are you authorized
[Y/N]?” prior to dispensing.

Handle Up Help
Message [0-99]

Enter the length of time (in seconds) until a help message displays
on the terminal to alert the cashier that the handle on the DCR is
raised and an MOP has not been selected during the specified time
(0 -99).

Error Prompt
Time [5-300]

Enter the length of time (in seconds) that DCR errors display for
the customer (5 - 300).

Info Prompt Time
[5-300]

Enter the length of time (in seconds) that the last message on the
DCR displays for the customer (5 - 300).

User Prompt Time
[5-300]

Enter the length of time (in seconds) that the user input prompt
displays for the customer (5 - 300).
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Enable Keypress | This parameter applies to Dresser/Wayne and Tokheim DCRs.
Beep
Select to enable the beep when the customer presses keys on the
DCR keypad.

Enable Attention | This parameter applies to Dresser/Wayne, Gilbarco,
Beep Schlumberger, and Tokheim DCRs.

Select to enable the beep to get the customer’s attention.

Enable Mistake | This parameter applies to Dresser/Wayne, Gilbarco, and
Beep Schlumberger DCRs.

Select to enable the beep when the customer makes a mistake.

Graphics Pay Select to enable graphics pay inside cash/credit prompts.
Inside

Cash/Credit

Prompts

Audible Help Enable to hear audio help message on POS.

message on POS

Enable Outdoor |The TAVE (Trans Amor Verifone Edition) system minimizes the
Tave flow of unencrypted payment card data within the POS system by
performing end to end encryption. Payment card data is
encrypted by TAVE enabled card readers both at the dispenser and
inside the store. Card data is encrypted by these devices and
passed to the First Data front-end processor in encrypted form for
authorization. The First Data front-end processor decrypts the
payment card data and sends the data to the issuing bank. A token
is linked to the authorization and sent back to the Verifone POS.
The VeriFone POS stores this token and uses the token instead of
unencrypted payment card data for all subsequent processing.

Select to enable Tave feature.

DCR Position Attributes

Use to set up the operation of a specific DCR at a site.
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If these are the last changes you make before exiting Fuel Manager, use both of the
following commands:

= Forecourt > Initialization > DCR

ICARGE DCR Position Attributes |JREIR g EEG T FETET S Wele vl e

—Select DCR Positon———— —EMV Parameters
Pasition |1 . Enable EMV [ ]
— Select Duplicate Position P address [ [ [ ][]
P [ ]
1 Duplicating Position1
2
3 1.Select target DCR positions —Other Parameters.
4 to the left
5 -
6 2.Use the Ctrl key to select Pay AtPump [ ] Enable Graphic Support [ ]
7 multiple positions Push To Start Button [ ] Graphic Keypad [ ]
8
9 3.Use the Shift key to select a Grade Select Button [] Graphic Printer  []
10 range of positions. Lever On Pump [ Primary Graphic Side(0-64) [0 |
M W
12 4 Click the "Duplicate” button. Enable Scanner [ Graphic Display |None .
Duplicate Enable Debit [] Graphic Screen Size |5 INCHES 2
Btk GrD (W Graphic Text Lines |2 Lines .
Menu Capable [

Select DCR Position

Position Select the DCR to be configured.

Select Duplicate Position

Duplicate Select the DCR to be copied and click Duplicate this Position.
Select the DCR to which you want to copy the information. When
copying is complete, click Done Duplicating.

EMV Parameters

Enable EMV Select to enable outside EMV.
IP Address Enter outside EMV IP address.
Port Enter port number.

Other Parameters
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Pay At Pump

Select if the pump has a DCR and if it is available for use by the
customer.

Push To Start
Button

Select if the dispenser has a Start button that must be pressed to
begin fueling. This parameter ensures that the correct instructions
are displayed on the DCR.

Grade Select
Button

Select to make the customer select a type of fuel product by
pressing a corresponding button at a dispenser that dispenses
multiple fuel products from a single hose.

Lever On Pump

Select to make the DCR display instructions for starting to fuel
from a dispenser with a lever. (If not selected, the DCR displays
instructions for starting to fuel from a dispenser without a lever.)

Enable Scanner

Select if a barcode scanner is installed at the DCR.

Enable Debit

Select to enable debit payment.

Enable RFID

Select to enable RFID.

Menu Capable

Select to enable menus.

Enable Graphic
Support

Select if graphics are supported by the DCR.

Graphic Keypad

Select if a graphic keypad is installed at the DCR.

Graphic Printer

This parameter applies to Tokeim DCRs only. Select if the printer
prints graphics.

Enable Scanner

Select if a barcode scanner is installed at the DCR.

Primary Graphic
Side [0-64]

Gilbarco only. Enter the number of one DCR on each pump as the
primary DCR.

Note: One controller operates the graphics for both sides of a
pump. Select only one side of each pump as primary.
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Graphic Display |Select the display type supported — Monochrome, Color, ROM,
Monochrome + ROM, None.

Graphic Screen | Select 5 inches or 10 inches.
Size

Graphic Text Select 2 Lines or Full Screen (multiple lines).
Lines

Receipt Header/Trailer
Use to define the messages printed on the header and trailer of the DCR receipt.

If these are the last changes you make before exiting Fuel Manager, use both of the
following commands:

= Forecourt > Initialization > DCR

DCR Configuration
5ol 82000 L W bl =8 Receipt Header/Trailer

Receipt Header Alignment
WELCOME [center]v]
]

|mignt
I
———

WELCOME

THANK YOU Receipt Trailer Alignment

THANK YOU |center[v]
HAVE A NICE DAY

|rignt

Field/Button Allowable Value/Function

Receipt The message that prints on the first five lines of the DCR receipt.
Header Enter the message on each line and select the alignment — Left,
Right, Center.
Receipt The message that prints on the last five lines of the DCR receipt. Enter
Trailer the message on each line and select the alighment — Left, Right,
Center.
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DCR Display

Use to enter the DCR promotional message that appears on the DCR display while the
customer pumps fuel.

If these are the last changes you make before exiting Fuel Manager, use both of the
following commands:

= Forecourt > Initialization > Fuel

= Forecourt > Initialization > DCR

DCR Configuration

DCR Promo Message
[THANK YOU FOR SHOPPING WITH US TODAY. |

Reporting
DCR Statistical Report

Reports fuel sales at dispenser card readers only.

DCR STATISTICAL RPT

#CUST VOLUME AMOUNT S%FP S$DCR SFUEL

DCR #01
1 8.921 10.00 69.7 51.1 38.6 SAMPLE DCR
STATISTICAL
REPORT
DCR #02
1 8.526 9.56  82.7 48.9 36.9
ALL DCRS
2 17.447 19.56 75.5
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Report Details:
o #CUST: The number of customers at a DCR.
e VOLUME: The amount of fuel dispensed at a DCR.
e AMOUNT: The sale amount of fuel dispensed at a DCR.
e %FP: The total percent of DCR activity at a specific fueling point.
o %DCR: The percent of all dispenser card reader sales dispensed at a specific DCR.

e %FUEL: The percent of all fuel sales dispensed at a specific DCR.

Troubleshooting
CARD IN READER A customer left a card in a DCR.

(Schlumberger) Broadcast loading of all DCRs
CARDSCAN 0 LOADED (CARDSCANSs) has concluded. The ‘0’ means ‘all.’

DEBIT MODULE NOT Debit is not available at a DCR.

PRESENT
Attempted to do a ticket reprint or ticket recall
E1156 INVALID RECEIPT on a DCR/ fuel transaction and the POS found
INFO the ticket data invalid. Call servicer for
assistance.
£1212 NO DCR RECEIPT Attempted to print a DCR receipt inside and
AVAILABLE there are none available.
INVALID DCR Attempted to disable or download to a DCR and

E5002 entered an invalid DCR number. Enter the
NUMBER
correct value between 1 and 32.

230



Discounts

Overview

Automated Discounts are discounts that the system applies automatically during a
sale.

Using Discounts

Discounts can broadly be divided into two types, automated and manual.
Automated discounts are applied by the system based on characteristics of the
transaction.

Manual discount unlike automatic discount requires specific actions by the
cashier. Examples include any discount using a discount key or entering a
discount amount.

For detailed information, see the respective topics for each of the following
discounts:

« Combined Discounts

o« Loyalty Sales

e Manual Discounts

o NAXML Promotions

¢ PLU Promotions

¢ POP Discount

e Special Discount
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Overview
Fuel Manager mode contains functions that define fuel control and sales conditions.

Available options depend on user’s security level. Refer “Fuel Sales” topic for
additional information.

Using Fuel Manager

Navigate to CSR Func > Fuel Manager from the POS (While in Sales, CSR Func can be
located on the right-hand side bottom corner of the screen on Topaz and bottom of
the screen on Ruby 2) to access the following Fuel Manager functions:

Initialize Fuel

« Download Fuel Prices

« Download to DCRs

e Clear Pump on Hold

« Reset Controller

o Fuel Price Configuration

e Toggle Fuel Site Pause

Initialize Site Sign

Initialize Fuel
1. Touch [Initialize Fuel]
2. Touch [YES] to initialize
System Message on POS indicates pumps are being initialized.
Download Fuel Prices
1. Touch [Download Fuel Prices]

2. Touch [YES] to continue the download
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System Message on POS indicates prices are being sent to pumps.
Download to DCRs
1. Touch [Download to DCRs]

2. Enter <DCR number> to download to a single DCR or Enter 0 to download to all
DCRs

3. Touch [OK] or press [ENTER] to continue
System Message on POS indicates DCRs are being downloaded.
Clear Pump on Hold
1. Touch [Clear Pump on Hold]
2. Key <pump number>
3. Touch [YES] or press [ENTER] to continue
Fuel sale is unclaimed and available to be tendered.
Note: This function is available only from the POS register.
Reset Controller
1. Touch [Reset Controller]
2. Touch [YES] or press [ENTER] to continue

System Message on POS will indicate “Reset” and then indicate pumps are being
initialized.

Note: This function is for use with Tokheim dispensers only. This function resets
the Tokheim fuel controller. No fuel can be dispensed while the controller is
resetting. This function is available only from the POS register.

Fuel Price Configuration
1. Touch [Fuel Price Configuration]
2. In the Fuel Price Configuration list, touch a product

3. In the Fuel Price Configuration list, touch a price level
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4. Key the new price and touch [OK]
5. Do one of the following:

= Touch [Previous Menu] twice to return to the Fuel Price Configuration
list

= Touch [Save Changes] to return to the Fuel Manager menu
6. The fuel prices have been changed in the POS system only and the Fuel Prices

Download function must be completed to update the prices at the dispensers (the
Fuel Initialization function also sends the updated fuel prices to the dispensers).

Toggle Fuel Site Pause

This function is used to temporarily disable all fuel and DCR sales at the site.
Normal sales operations resume once this function is performed again.

After fuel site pause has been enabled, the cashier or customer attempting a
fuel or DCR sale receives a message indicating that the sale is not allowed.

Note: This function is only available from the POS register.
1. Touch [Toggle Fuel Site Pause]

2. Confirm Toggle of Site Pause by selecting Yes or No at the prompt as indicated
below:

If site pause is disabled, the prompt asks if you want to “Enable Fuel
Site Pause”.

1. Touch [YES] to prevent new fuel sales
2. POS displays message that “Fuel Site Pause is Enabled”
Fuel cannot be dispensed at the site.

If site pause is disabled, the prompt asks if you want to “Disable Fuel Site
Pause”.

1. Touch [YES] to open the site back up for fuel sales
2. POS displays message that “Fuel Site Pause is Disabled”

Fuel can now be dispensed at the site.
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Note: New fuel sales cannot be approved while the pumps are paused.
Pumps currently dispensing fuel are not interrupted.

Note: Disable fuel will perform a “Fuel Site Pause” function. When Disable
fuel is enabled it will prevent both new DCR and prepay fuel transactions
from starting. Although new fuel sales cannot be approved while the
pumps are paused, pumps currently dispensing fuel are not interrupted.

The functionality does NOT wait until all fuel positions are idle before the
Close Day can begin.

Initialize Site Sign
1. Touch [Initialize Site Sign]
2. Touch [YES] to initialize fuel sign

System Message on POS indicates Site Sign is being initialized
Configuring Fuel Manager

Use Forecourt > Fuel to configure fuel manager functions.

Use Tools > Managed Modules > Fuel_Driver_Configuration to assign ports and
configure the communication parameters for Fuel Driver.

See Fuel_Driver_Configuration in Managed Modules section for information on
configuring the Fuel Driver.

Note: The Fuel Sales and Dispenser Card Reader topics in this document include
additional parameters that are required provides additional parameters
required for successful fuel operations with card readers.

Fuel Configuration

Site Parameters

Use to define operating procedures for all pumps at the site. If these are the last
changes you make before exiting Fuel Manager, use both of the following commands:

= Forecourt > Initialization > Fuel
= Forecourt > Initialization > DCR

For all Global sites (including U.S.), Commander fuel configuration needs to be in sync
with the configuration on the pump. Depending on the local currency, sites use a
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variety of decimal point settings for the ‘PPU Decimal Position’ and ‘Total Decimal
Position’. In addition, for Gilbarco pumps, many sites also require the enabling of ‘Six

Digits Gilbarco Mode’.

Note: Prior to changing the ‘PPU Decimal Position’ in Commander, the current prices
need to be changed to a whole number. For example, a default price of 1.234 should
be changed to 1.000. If this is not done, then the validation of fuel prices will fail and
the new configuration will not be properly set. After the ‘PPU Decimal Position’ is set,
then the fuel prices can be changed to the current prices at the site.

In addition, the ‘Currency Limit’ for each fueling position needs to be a valid number
within the range in the table below.

3 (U.S. default) X XXX 0.001 - 9.999
2 XX. XX 00.01 - 99.99
1 XXX.X 000.1 - 999.1
0 XXXX 0001 - 9999

2 (U.S. default)

XXX.XX (000.01 - 999.99)

XXXX.XX (0000.01 - 9999.99)

1

XXXX.X (0000.1 - 9999.9)

XXXXX.X (00000.1 - 99999.9)

0

XXXXX (00001 - 99999)

XXXXXX (000001 - 999999)
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Fuel Configuration - Pending

e =Nl Ll Fuel Service Levels | Fuel MOPs | Fuel Tanks | Fuel Blend Types | Fuel Products | Fueling Positions

— Tier2 Schedule Settings
Unit of Measure
Halt Mode [Sont Start Tier 2 Pricing
PPU Decimal Position Number of Tier Hours
Total Decimal Position
Autodisapproval |5.0

Multi-Grade Timeout
Miinutes) 29 Start Postpay Allowed

<

¢

<

—Postpay Schedule Settings

<

lgnore MOP Conflict Number of Postpay Hours |24 hd
Force .9 Cents Per Gallon [
Approve All Enabled —Manual Approval Schedule Settings—
Recall Autacollect Inside [ Start Manual Approval
Gilbarco Six Digits Money 0 Required
EERE Number Manual Approval
Require Attendant Card [ Hours
— Offline Fuel Prompt — Grade Restriction
Number of Seconds Enforce Prompting Inside [

Prompt Restriction Outside [

—Real Time Sales Data

Motification Frequency D
(Milliseconds)

— Commercial Configuration

Alert Cashier (Minutes)

Unit of Measure Select Gallons (USG) or Liters.

Halt Mode Note: This parameter applies to Tokheim dispensers. All
others automatically use the soft halt.

Select one of the following:

Hard Halt — A fuel sale that is stopped with the [STOP] key
on the terminal cannot be restarted with the [APPROVE]
key. It will become due when the nozzle is replaced (or the
lever put down) at the dispenser.

Soft Halt — A fuel sale that is stopped with the [STOP] key
on the terminal can be restarted with the [APPROVE] key,
as long as the nozzle was not replaced (or the lever put
down) at the dispenser.

PPU Decimal Position | Select a value to define the position of the decimal point
whenever a fuel price is displayed on the terminal or
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[0-3]

printed (0 - 3).

Note: For sites in the US, this value should be set to 3.

Total Decimal

Position [0-2]

Select a value to define the position of the decimal point on
the pump’s total sales display (0 - 2).

Note: Terminal receipts and displays always use two
decimal point positions for fuel sale amounts.

0 — The terminal appends .00 to all fuel sale amounts.
1 — The terminal appends .x0 to all fuel sale amounts.

Note: For sites in the US, this should be set to 2.

Autodisapproval Delay
[0-10]

Select the number of minutes of inactivity that must pass
before a pump is automatically disapproved (0.0 - 10.0
minutes, in half minute increments).

For example, entering 7.5 will result in automatic
disapproval after 7 minutes and 30 seconds.

Note: This parameter works with ‘Autodisapproval’ in Pump
Configuration- Pump Attributes.

Multi-Grade Timeout

Enter the minutes before the pump timeout after fueling
the first grade in a multi-grade transaction.

Note: Refer to the Fleet Cards feature reference
documentation for information on this feature. The
Feature Reference is available on Premier Portal.

Ignore MOP Conflict

When this parameter is checked, sales can be tendered
using any MOP regardless of the original fuel price level of
the sale. When this parameter is not checked, the MOP
entered must match the fuel price level and if it does not
an error message will be given indicating MOP conflict.

Force .9 cents Per
Gallon

Select to force the last digit of the fuel price to 9 on the
price entered at Fuel > Fuel Prices. For example, if price
entered is $3.47/gallon, the price is forced to be
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$3.479/gallon

Approve All

Enabled

Select to allow the cashier to press [APPROVE] to approve
all calling pumps. (If not selected, the cashier must identify
the pump that is requesting approval, press that pump
number, and then press [APPROVE].

Recall Autocollect
Inside

Select to allow autocollect sales to be recalled on the
terminal if an attendant is collecting fuel sale payments
outside.

Gilbarco Six Digits
Money Display

This is a site-wide parameter used with Gilbarco pumps at
some non-US sites that require 6 digits as opposed to 5 for
the money display. This is required for some non-US
countries that have currencies that require large money
amount values. Note that the pumps must also be
programmed to run in 6 digit money display mode.

Require Attendant Card

Enable for the enhanced FSA feature.

Note: Refer to the Full Service Attendant feature
reference documentation for information on this
feature. The Feature Reference is available on Premier
Portal.

Offline Fuel Prompt -
Number of Seconds

Enter the number of seconds before the offline fuel prompt
is displayed.

Real Time Sales Data -
Notification Frequency
(milliseconds)

This parameter controls how often fuel sales data (total
sales amount) is updated on the fueling point icons, while
fueling is in progress.

This allows the user to watch the fuel sale amount roll off,
in real-time. The number represents the amount of time (in
milliseconds) between each update.

A default value of 0, disables this feature. The minimum
allowable value is 500, resulting in a reporting interval of
two times per second. Configured values between 1 and 499
will automatically apply 500 millisecond intervals to the
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icons.

A value of 2000 or greater will reduce load on the system
making it more responsive.

Tier2 Schedule
Settings - Start Tier 2
Pricing

Select the time (using the 24-hour clock) that tier 2 pricing
begins (0 - 23).

Number of Tier Hours

Select the number of hours that Tier 2 prices will be in
effect, starting at the time set in “Start Tier 2 Pricing”. Set
values between 0 and 24 to use Tier 2 Pricing.

The following special values can also be used:

0 — Tier 2 prices are not used.

24 — Tier 2 prices are always used.

Postpay Schedule
Settings - Start Postpay
Allowed

Select the time (using the 24-hour clock) that postpay fuel
sales begin (0 - 23).

Number of Postpay
Hours

Select the number of hours that postpay fuel sales are
allowed, starting at the time set in “Start Postpay Allowed”.
Set values between 0 and 24.

The following special values can also be used:

0 — Postpay fuel sales are not allowed.

24 — Postpay fuel sales are always allowed.

Manual Approval
Schedule Settings -
Start Manual Approval
Required

Select the time (using the 24-hour clock) after which every
fuel sale must be approved by the cashier (0 - 23).

Number Manual
Approval Hours

Select the number of hours that manual approval is
required, starting at the time set in “Start Manual Approval
Required” (0 - 24).
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0 — Manual approval is not required at any time.

24 — Manual approval is always required.
Grade Restriction - Select to display the grade restriction prompt that lists
Enforce Prompting allowable grade selections inside at the POS.
Inside
Prompt Restriction Select to display the grade restriction prompt that lists
Outside allowable grade selections on the DCR.
Fuel Tanks

Use to define the tank names and designate which tanks are manifolded.

If these are the last changes you make before exiting Fuel Manager, use both of the
following commands:

» Forecourt > Initialization > Fuel

» Forecourt > Initialization > DCR

Fuel Manager

Site Parameters § Fuel Service Levels | Fuel MOPs ‘ESTCRELL I Fuel Blend Types | Fuel Products § Fueling Positions

Fuel Tank Settings

Tank Name
om0 N |
z“:gi Manifold Tank

ni
tank04 I
tank05 Fuel Product 1D
tank0s [o |

tank07
tankD8
tankD9
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Name The tank name (alphanumeric, up to six characters).

Manifold Tank | The primary tank for each fuel product. The primary tank is
manifolded to itself; the secondary tank is manifolded to the
primary tank.

Fuel Product ID | The NAXML Fuel Product ID (four digits).

Fuel Products

Use to define product names and tank blending parameters. Click a text box to enter,
edit, or select a value.

If these are the last changes you make before exiting Fuel Manager, use both of the
following commands:

= Forecourt > Initialization > Fuel

= Forecourt > Initialization > DCR

Fuel Configuration - Pending

Site Parameters [ Fuel Service Levels Fuel Tanks | Fuel Blend Types 0«0 Fueling Positions

— Fuel Product Settings

Product Secondary Product

1 - Tractor - i

5 _ UNLO2 Name Primary Product

2 UNLD3 [ Tractor | [7-DIESL v

4-UNLD4 Tank Configuration

5- UNLDS

6 - METH

7 - DIESL Low Feed Tank FPercentage1

8 - KERSN

g-REG Service Level 1 Product Code  Service Level 2 Product Code

10 - UNUSEDA1 ¥ | [0001-UNLEADEDRE~ | 0001 - UNLEADED RE v |
Department Fuel Grade ID
[9998 - MANUAL FUEL w | 0
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Secondary Product | Select to fuel a primary product as a secondary product
with a different name.

For example, Tractor and Reefer are dispensed from the
diesel hose and is Diesel but named as Tractor and
Reefer.

Tank and Price for the secondary products is same as
Primary product. Secondary Product has its own product
code.

Note: Refer to the Fleet Cards feature reference
documentation for information on this feature. The
Feature Reference is available on Premier Portal.

Product Name Enter the product name (alphanumeric, up to six
characters).

Primary Product | When a product is enabled as secondary, select the
primary product that is used as the secondary product.

For Example, Tractor and Reefer are dispensed from the
diesel hose and is diesel but named as Tractor and
Reefer.

Tank and Price for the secondary products is same as
Primary product. Secondary Product has its own product
code.

The advantage of using the primary product as a
secondary product with a different name is that the
product when used as a secondary product can save tax
or/and can be eligible for a discount.

Note: Refer to the Fleet Cards feature reference
documentation for information on this feature. The
Feature Reference is available on Premier Portal.

Low Feed Tank From the drop-down menu, select the primary tank.
Low Feed Enter a percent (0 - 100).
Percentage
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Service Level 1 From the drop-down menu, select the product code for

Product Code service level 1.

Service Level 2 From the drop-down menu, select the product code for

Product Code service level 2.

Department From the drop-down menu, select the department.

Fuel Grade ID Itis a ‘1 - 4’ digit-value that maps Verifone product sysIDs
to a NAXML equivalent. It is used as part of generating the
NAXML POSJournal.

Fueling Positions

Use to define the attributes and hose assignments of each pump. If these are the last
changes you make before exiting Fuel Manager, use both of the following commands:

= Forecourt > Initialization > Fuel

= Forecourt > Initialization > DCR
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Fuel Configuration - Pending

Fuel Service Levels | Fuel MOPs | Fuel Tanks | Fuel Blend Types | Fuel Products ERgTTLN g ot -]

—Fueling Position Settings

—Select Fueling Position
Allow Access
sP11e Adaress | 192, 168] [ 31)( 160
—Duplicate Fueling Position — Default Attributes
1 Defaut MOP  Default Service Level Blend Type Slow Flow Offset
2 CASH v ] [SELF _ w NONE v ] [2
3
5 Fueling Limit Settings
6 1.Select target fuel positions = 7 Auto Collect
7 1o the left Currency Limit  Volume Limit  Minimum PPU [NoNE v]
I (30000 | [500000 | [0.009 NONE
9 2.Use the Ctrl key to select
10 Tuaion pooons —Hose Product Settings
1 :
12 ?;:Sz g;e S:I:‘D::V B seocd Hose 1 Product Hose 2 Product Hose 3 Product
13 sl [UNLDA «] [UNLD3 ~ ] [UNLD4 v
14 4.Click the "Duplicate” button Hose 4 Product Hose § Product Hose 6 Product
% e [uNLDS ~ | [METH ~ | [NONE ~ |
16 Uprce Hose 7 Product
a4 NONE ~
18
19
0 ¥ — Options
[ Auto Approval [ Auto Disapproval EDCR In Dispenser
CIFirstinFirstout [ DCR Prompt Preset Amount  EHandle Up Calling
[lignore Pump Error (] Pay At Pump Only [IPrepay Only
B Preset Postpay B Preset Prepay B Stacking
O view Buzzer off Commercial Clinstant Auto Approval

—Multi Product Settings

Allow Multiple Products | Configure Fueling Orders

Position Select the fueling point.

Duplicate Fueling | Select a group of fueling positions from the Position list
Position to mark for duplication. Select the position from the
Duplicate Fueling Position drop-down menu to set the
position to be duplicated. Click Duplicate.

Allow Access Select to allow the pump to be accessed by the terminal.

Default MOP Select Cash, Credit, or Check as the default MOP for this
pump.

Default Service Select Self, Full, or Mini as the default service level.
Level
Blend Type Type of the blend to use in fueling positions. Select

None, MECH, ELEC, VARI, SC82, or FIX of the blend
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type.

Slow Flow Offset

Determines the point at which the pump will slow the
fuel as it approaches a preset amount (2 - 9999). Enter
the slow flow amount without leading zeros.

Hose Product
Settings -

Hose 1 Product
Hose 2 Product
Hose 3 Product
Hose 4 Product
Hose 5 Product
Hose 6 Product

Hose 7 Product

Assign a fuel product to be dispensed from each hose for
each pump that has been set up. One to seven hoses can
be defined for each pump. Assign ‘NONE' to hoses that do
not exist or are not used.

Fueling Limit
Settings:

Currency Limit

Volume Limit

Minimum PPU

Auto Collect

Enter the maximum amount that the pump dispenses in
one sale (0.00 - 999.99).

Enter the maximum volume that the pump dispenses in
one sale (0.00 - 999.999).

This is the minimum Price Per Unit that the dispenser will
be allowed to drop to (typically due to a discount).

Select to disable Auto Collect or to allow an employee

outside to collect cash or any type of MOP payment
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directly from the customer at the pump.

None: Disabled. Payments are only collected inside at
the terminal.

Cash: Only cash payments may be collected at this pump.

All: Any type of MOP payment may be collected at this
pump.

Options

Preset Prepay Select to allow preset/prepay fuel sales at the pump.

The default value is checked.

Preset Postpay Select to allow preset/postpay sales at the pump.

The default value is checked.

Stacking Select to allow one fuel sale to remain uncollected while
a second fuel sale is dispensed and completed.

The default value is checked.

First In First Out Select to ensure that the first sale that becomes due on
this pump is cashed out first.

(If not selected, either sale may be cashed out first.)

Note: “Stacking” must also be selected.

Full Service Preset | Select to allow a customer or attendant to preset an
amount outside at the DCR before fueling.

Handle Up Calling | Select to make the pump call for approval to dispense
fuel when the customer lifts the handle.
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Select to allow automatic approval for dispensing.

If not selected, the pump must be approved by the
cashier by pressing the [APPROVE] key.

Note: The first sale must be cashed out before another
sale can be autoapproved.

Note: Select this parameter if using Autocollect.

Auto Disapproval

Select to disapprove a dispenser if it remains inactive for|
the period of time set in “Delay Autodisapproval” on Fuell
> Site Parameters > Fuel Site Parameters.

(If not selected, the pump remains approved until
manually changed.)

Note: In DCR transactions, the pump disapproves after a
maximum of three minutes regardless of this setting or
that of “Delay Autodisapproval.” Prepaid sales never
time out.

DCR In Dispenser

Select if the dispenser has a card reader.

View Buzzer Off

In a postpay situation, the customer lifts the handle,
leaves the nozzle off the pump, and comes inside to pay.
Select to allow the [VIEW] key to stop the beeping at the
terminal.

Note: If not selected, the beeping continues until the
customer has paid.

Commercial

Select to convert a fueling position to commercial. Select
for each pump that needs to be enabled as commercial.

Note: Refer to the Fleet Cards feature reference
documentation for information on this feature. The
Feature Reference is available on Premier Portal.
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Ignore Pump Error | Select to allow a pump to resume service after an
authorization failure. The terminal continues to approve
the transaction on the pump without the cashier pressing
[APPROVE].
If not selected, a cashier must press [APPROVE] to start
the next transaction on the pump after an authorization
failure.
For this feature to work, do the following:

= Select “Autoapproval.”

= Set “Auto Collect” to ‘All.’

= Set “Default Service Level” to ‘Full.’

Pay At Pump Only | Select if customers are required to pay outside at the
DCR and may not pay inside.

If not selected, customers are able to pay outside at the
DCR as well as inside.

Prepay Only Select if only prepaid fuel sales are allowed.

If not selected, fuel sales can be paid for either before or
after the customer dispenses fuel.

Multi Product Note: Refer to the Fleet Cards feature reference
Settings documentation for information on this feature. The
Feature Reference is available on Premier Portal.

To enable a fueling position to dispense multiple
Allow Multiple products in a in single transaction, the pump should be
Products enabled for multi-grade fueling.

Click Configure Fueling Orders to configure the order in

Configure Fueling | which the multi-grade fuel products appear on DCR menu
Order and on the fuel selection menu during preauthorization of
the card.
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The Host Product Settings section in the Fuel
Configuration form only allows Primary Products to be
assigned to hoses.

Fueling Orders form helps configure primary and
secondary products dispensing order.

Fueling Orders
Fueling Orders
Dispense Order Prompt Order
i
4 4 150f5 » ¥
Ok | | Cancel

Configure the order in which the products are to be
presented to the customer to choose.

If you assign two products to the same prompt order, it
will allow either or both.

The example below would prompt “UNLD1, UNLD2 or
Both”, then “UNLD3 Y/N”, and finally “UNLD4, UNLD5, or
Both”.

Fuel Blend types

Fuel Blend types will display the available blending types in the POS system.

Fuel Manager

Fuel Service Levels | FuelMOPs | Fuel Tanks SVRI:USNRSY AW Fuel Praducts | Fueling Positions

Fuel Blend Types Names

Fuel Blend Type 1
NONE

EuclBlendidypes oo
IMECH

Fuel Blend Type 3

e

EolBlondiiyperd 0 e e e e
VARI

FoiBlondiypes o e 0l

FIX

Fuel Blend Type 6

sC82

NOTE: The information on this tab is vi

iew only and can not be changed

This option is for viewing only, no configuration is allowed.
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Fuel MOPs

Fuel MOPs displays the available fuel method of payments defined in the POS system.

Fuel Manager

Fuel MOPs

Fuel MOP Names

Fuel MOP
CASH

Fuel MOP
CRED

NOTE: The information on this tab is view only and can not be changed

This option is for viewing only, no configuration is allowed.
Fuel Service Levels
Fuel Service Levels displays the available levels of service for the site.

Fuel Manager

Fuel Service Levels

Fuel Service Level Names

Fuel Service Level
SELF

Fuel Service Level
FULL

Fuel Service Level
MINI

NOTE: The information on this tab is view only and can not be changed

This option is for viewing only, no configuration is allowed.
Reporting

Refer to the Reports topic for Fuel and DCR reports.
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Overview

A fuel sale can be part of any sales transaction allowed either inside at the terminal

or outside at the Dispenser Card Reader (DCR).

Using Fuel Sales
The following are the Fuel Sales functions:

Prepay Fuel Sale by Amount

« Prepay Fuel Sale by Volume

e Prepay Fuel Sale with Merchandise

e Fuel Prepay Move

o Preset Fuel Sale by Dollar Amount

o Preset Fuel Sale by Volume

o Rest In Gas

o Postpay Fuel Sale

o Postpay Fuel Tax Exemption or Addition

¢ Manual Fuel Sale

o Fuel Discount with Fuel Disc Key

o Clear Reserve and Place in Idle

e Pump Test

e Fuel Ticket Print

o DCR Ticket Print

o Fuel Convert

e Approve One Calling Pump
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« Approve All Calling Pumps

e Disapprove a Pump

o Restarting a Stopped Pump

o Stop/Disapprove

e Stop One Pump

o Stop All Pumps

o View Fuel Sales

o View Due Fuel Sales

o View Pump Status

e Other Fuel

Fuel Control Buttons

The icons on the buttons for stop pump, help requested, calling pump and drive-off
blink. The amounts with + sign are for customers owing money and amounts with -
sign are for money owed to customer. The following fuel buttons represent a pump's
status:

Icon Description Icon Description

Idle Pump Reserved Pump
Pump Calling Offline Pump
Pump Ready Fueling
Stacked Postpay Sale Sale Amount

Authorizing: Customer has swiped

card at DCR Stopped Pump

Authorised Credit Card/DCR Sale:
DCR ready to dispense

Network Message or
Help Requested

Fueling: DCR fuel

Prepaid Sale .
sale in progress
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Colored Text on Fuel Buttons
Colored text on fuel buttons represents the following:

e Red - Critical events happening at the pump. Watch pump and take
immediate action.

. - Watch pump and take action.

e Green - Normal events happening at the pump. Watch pump; no
action required.

o Black and Gray - Light and dark themes; no action required by the
cashier.

Note: To access [OTHER FUEL] functions in Ruby2, a soft key needs to be
programmed. Refer to store manager to program soft keys.

Prepay Fuel Sale by Amount
The customer pays amount for the fuel before dispensing. The fuel is entered
for a specific dollar amount. The sale must be tendered before the system
approves the pump. The pump stops when the dollar amount is reached or when
the tank is full.
1. Press [PREPAY] and key pump number
2. Press [ENTER]
3. Key <amount> and select MOP to continue or tender the transaction
Or
1. Key <pump number> and press [PREPAY]
2. Key <amount> and select MOP to continue or tender the transaction
Prepay Fuel Sale by Volume
The customer specifies the fuel product and volume and then pays for the fuel
before dispensing. The sale must be tendered before the system approves the

pump. The pump stops when the specified volume is reached.

1. Press [PREPAY] and key pump number
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N

. Press [ENTER] and then press [QTY]
3. Key the volume including two decimal points and press [ENTER]

4. In the Fuel Products list, select the fuel product and tender the
transaction

Or
1. Key <pump number> and press [PREPAY]
2. Press [QTY]
3. Key the volume including two decimal points and press [ENTER]

4. In the Fuel Products list, select the fuel product and tender the
transaction

Prepay Fuel Sale with Merchandise

The network pre-authorizes a card for a fuel purchase and just charges the
customer for the amount actually dispensed.

—

. Key <pump number> and press [PREPAY]

2. Key <amount>

w

. Touch [CREDIT] and swipe the card through the card reader

>

If prompted with the fuel products list, touch the product

Fuel Prepay Move

This function moves a preset or prepay fuel sale that has not been dispensed from
the original pump number to a new pump number.

To perform this function there must be an undispensed prepay on the selected
pump for the move.

1. Press [OTHER FUEL] and then select Fueling Point Move
2. In the overlay, enter the pump number to move from
3. In the overlay, enter the pump number to move to

The prepay transaction moves to the chosen pump number.
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Fuel Preset

A preset fuel sale occurs when the Preset Fuel function is used to approve a fuel
sale for a specific dollar amount or volume. If the approval is by volume, specify
the fuel product. The pump automatically stops dispensing when the dollar
amount or volume is reached or the tank is full. The sale is paid after the fuel is
dispensed.

Preset Fuel Sale by Dollar Amount

A preset fuel sale by dollar amount occurs when the Preset Fuel function is used
to approve a fuel sale for a specific dollar amount. The pump automatically
stops dispensing when the specified dollar amount is reached.

1.

2.

Press [FUEL PRESET] and key <pump number> and touch [OK]

Key <amount> and touch [OK] to authorize pump for fueling up to the
preset dollar amount.

. Touch <pump number> to add the sale into the transaction and press

method of payment (MOP)

Preset Fuel Sale by Volume

A preset fuel sale by volume occurs when the Preset Fuel function is used to
approve a fuel sale for a specific volume and specify the fuel product. The pump
automatically stops dispensing when the volume is reached, or the tank is full.
The sale is paid after the fuel is dispensed.

1.

2.

Press [FUEL PRESET], key <pump number>, and touch [OK]

Press [QTY] and key volume of the fuel to be dispensed (including two
decimal places) and touch [OK]

If prompted with the Fuel Products list, touch the fuel product
The customer dispenses fuel up to the preset volume
Touch <pump number> to add the sale into the transaction

Press method of payment (MOP)
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Rest in Gas

This feature allows a customer to make instore purchases, present cash for
payment and request that the clerk put the “Rest In Gas.” The system
calculates the change due and uses that amount to prepay the pump.

—

. Ring up merchandise
2. Key <amount>
3. Press [REST IN GAS]. The system prompts for pump number

4. Key <pump number> and press [ENTER] for the system to set prepay for
the calculated amount on the selected pump

Postpay Fuel Sale

In a postpay fuel sale, the sale comes due inside after the customer dispenses
fuel.

Note: If fueling point has uncollected sales or stacked sale, in Step 1, a
separate fuel detail overlay will be displayed, touch the appropriate fuel sale
box to bring the sale into transaction.

1. Touch the appropriate fuel icon or press <pump number> and [FUEL] to
bring sale into the transaction and press [TOTAL]

2. Tender the sale and touch the correct method of payment (MOP)
Postpay Fuel Tax Exemption or Addition
This function allows the ability to add a fuel tax to a fuel type that is displaying
a “tax free” price at the pump. The automatic adjustment is available only for
postpay fuel sales or allows the cashier to remove taxes, or portions of a tax,
from a fuel sale.
Note: Available for postpay fuel sales only.

1. Touch pump number and Fuel Tax Exemption or Fuel Tax Addition

2. In the Fuel Tax Exemption or Addition list, touch the correct exemption
or addition

Fuel Tax Exemption and Fuel Tax Addition can be accessed in one or the
following ways:
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= Press softkey
= Use Other Fuel Functions
=  Touch pump number and then the line item

Manual Fuel Sale

Use the [MANUAL FUEL] key to manually enter a fuel sale into the system. This is
typically used for the dispensers that are not connected to the system.

1. Key fuel sale price and touch [MANUAL FUEL]
2. Key <pump number> and press [ENTER]

3. In the Fuel Products list, touch the name of the fuel product or key
<fuel product number> and press [ENTER]

Fuel Discount with Fuel Disc Key

The Fuel Discount with Fuel Discount key discounts fuel purchases by a fixed
dollar amount per gallon. The cashier can indicate the number of gallons/liters
to be discounted or the discount can be applied to the whole fuel amount.

Note: Fuel discounts can be used in postpay fuel sales. Fuel dispensed at a POP
discount rate is not eligible to receive a discount using the [FUEL DISC] key.

1. Touch <pump number> and the discount is applied to the total fuel
dispensed: Touch or press [FUEL DISC]

2. Key number of gallons to which discount should be applied or press
[ENTER] to apply discount to total volume dispensed

Clear Reserve and Place in Idle

The Clear Reserve function removes the “Reserved” state from a prepay pump.

This may happen when fuel communications are temporarily interrupted and
then re-established.

In a prepaid fuel sale, clear that is in the “Reserved” state that does not have to
be dispensed.

1. Touch <pump number> and press [PREPAY]

2. Press [STOP] and [OK] to change prepay fuel sale status to Due Sale or
Refund
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3. To clear pump:
1. Touch <pump number> and press [TOTAL]

2. Touch the method of payment (MOP) originally used for
prepay transaction

Clear Reserve Using Clear Reserve Button

1. Select pump number from the fuel panel

2. Select ‘CLEAR RESERVE’ button
Pump Test

Note: The pump test applies to fuel sales only.

The Pump Test is a payment type that accepts postpay fuel sales only. The fuel
is dispensed normally and then tendered with the “Pump Test” MOP.

A receipt prints with the words "PUMP TEST" at the bottom
1. Touch <pump number> and press [TOTAL]

2. Touch [PUMP TEST] or press [OTHER MOP] and then touch Pump Test in
Other MOP list

Fuel Ticket Print

This function reprints postpay fuel transaction receipts.
1. Press [TICKET PRINT]
2. Choose a transaction to print

To search for transaction receipts containing fuel, follow these steps:
1. Press [TICKET PRINT]
2. In the overlay, press [ADVANCED OPTIONS]
3. In the Advanced Options - Multi Select Allowed menu, select Fuel Only

4. Press [SHOW LIST] to display a list of Filtered by Fuel Only
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5. Choose a transaction to print
DCR Ticket Print
Reprints DCR and completed prepay transaction receipts.
1. Key the pump number
2. Press [VIEW]
3. Touch [Reprint DCR Tran]
4. Choose a transaction to print

Fuel Convert

If a customer dispenses fuel at one price level but wants to pay in the other
price level, then use Fuel Convert function to switch.

1. Touch the pump number

2. Select the transaction to be converted by touching the desired current
or stacked sale.

3. Touch [Fuel Convert]

4. If the customer wants to purchase merchandise, key the item(s)

5. Enter the customer’s method of payment
Approve One Calling Pump
1. Select the pump number.
2. Press [APPROVE].
Approve All Calling Pumps
Press [APPROVE].

Whether a fueling point can be approved before a customer can dispense fuel
depends on the following operating conditions:
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= Automatic Approval: If “Autoapproval” is enabled for a specific pump
number, the pump does not need to be approved before a customer can
dispense fuel.

= Approve Specific Pump: In all cases, a specific pump can be approved if
the pump number is keyed before [APPROVE]. Two messages display
briefly:

nn APPROVING

nn APPROVED

= Approve All Pumps: If enabled, all fueling points requesting approval can
be approved at the same time by pressing the [APPROVE] key. If not
enabled, a specific pump can still be approved by keying the pump
number before pressing [APPROVE]. Two messages display briefly:

APPROVING CALLING PUMPS
CALLING PUMPS APPROVED

Note: If a pump is approved while the cash drawer is open, the change for that
transaction continues to display. The journal records pump approvals.
Disapprove a Pump
Disapprove a pump that is approved but has not started dispensing.
Select the pump number and press [STOP].
Restarting a Stopped Pump
1. Select the pump number.

2. Press [APPROVE].

A pump can be restarted if the system is set up to allow a pump restart or if the
pump is stopped from the POS ([STOP] key) and one of the following is true:

= The transaction at the pump has not ended.

= The pump is a Dresser®/Wayne® brand.
The following two messages display briefly when approving a pump that has timed-
out or been stopped (also called re-approving or restarting) (‘nn’= the pump

number):

nn RESTARTING
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nn RESTARTED
Stop/Disapprove
The [STOP] key does one of the following:
= Stops fuel dispensing at a specific pump or all pumps.

= Disapproves one pump or all approved pumps that have not started
dispensing.

The following two messages display briefly if a pump is stopped (‘nn’= pump
number):

nn STOPPING

nn STOPPED
The following two messages display briefly when all pumps are stopped:

STOPPING ALL PUMPS
ALL PUMPS STOPPED

Stop One Pump
1. Select the pump number.
2. Press [STOP].
Stop All Pumps
Press [STOP].

View Fuel Sales

The View function displays the status of the current fuel sales. The information
that displays depends on the pump manufacturer. Some pumps send information as
the fuel is dispensed. Other pumps send information only after dispensing is

finished, and display only the fueling point, current/stacked indicator, and pump
status while fuel is being dispensed.

There are two types of view: due sales and fuel sales.
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View Due Fuel Sales

1.

Press [VIEW]. All fuel sales that are due appear.

2. Press [EXIT].

The pump number, status (‘C’ = current, ‘S’ = stacked), and dollar
amount due display. Up to eight sales are listed. If there are more than
eight sales, a down arrow in the bottom left corner of the display
indicates there are more. Press [VIEW] to see the rest of the sales.

If no sales are due, “NO DUE SALES” displays until another sales function
is run.

View Pump Status

Check the fuel sale state or the pump state of the current or second (stacked)

sale.
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AUTHORIZED The pump is approved, but dispensing has not started.

. Key the pump number.

Press [VIEW]. The > points at the current sale.

. Press [VIEW] again. The > points at the stacked sale.

Press [VIEW] again. The pump status and detailed fuel sale information
for the current sale appears.

Press [VIEW] again. The pump status and detailed fuel sale information
for the stacked sale appears.

Press [VIEW] to repeat the cycle (steps 2 through 5).

CALLING The customer has lifted the handle and is requesting
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approval to dispense fuel.

FUELING Fuel is being dispensed.

IDLE The pump is not in use.

LOW PAPER The receipt paper in the dispenser card reader is low.

OFFLINE The pump controller is not communicating with the
dispenser.

RESERVED The pump is being prepaid and is locked until the
transaction is complete.

STOPPED A cashier has stopped the pump by pressing [STOP].

BUSY The pump is in use (but not necessarily actively
fueling).

DUE The customer has finished dispensing and the sale or
refund is due.

HOLD This sale has already been included in a transaction on
another Ruby terminal or on the current ticket.

SOLD This fuel sale has already been collected.
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Other Fuel

The Other Fuel function is a soft key and contains a menu of the following
functions:

Fueling Point Move

Convert Fuel MOP

Fuel Discount

Fuel Preset

Manual POP Discount

Fuel Tax Exemption

Fuel Tax Addition

Fueling Point Move
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This function moves a preset or prepay fuel sale that has not been dispensed
from the original pump number to a new pump number.

The following message prints on the journal (‘n1’ = the original pump; ‘n2’=the
pump to which the sale moves):

FP MOVE FROM PUMP# n1 TO PUMP# n2

1.

2.

3.

Touch [FP MOVE]
Enter the current pump number and select OK
Enter the new pump number and select OK

Or

. Press [OTHER FUEL]
. Select the Move Fuel Point function

. Key the current pump number

Key the new pump number and then select OK
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Convert Fuel MOP

The Fuel Convert function switches the price level of the fuel line item from
cash to credit or credit to cash.

The final price for the fuel in the transaction will be based on the new price
level.

1. Touch the pump number

2. Select the transaction to be converted by touching the desired current
or stacked sale

3. Press [Other Fuel] and select Convert Fuel MOP
4. If the customer wants to purchase merchandise, add the item(s)
5. Tender and complete the sale
Fuel Discount
The Fuel Discount function discounts fuel purchases by a fixed dollar amount per
gallon. The cashier indicates the number of gallons/liters to be discounted or
the discount may apply to the whole fuel amount.

Fuel discounts can be used in preset or postpay fuel sales.

The Fuel Discount function may be set up as either a separate [FUEL DISC] key
or as a menu choice under the [OTHER FUEL] key.

1. Bring the fuel sale up on the display
2. Do one of the following:

o If the discount applies to part of the fuel dispensed, key the
amount (gallons/liters) and press [FUEL DISC] key

« If the discount applies to the whole amount of fuel dispensed,
just press [FUEL DISC]

Or
1. Press [OTHER FUEL], press Fuel Discount, and then press [ENTER]

2. Do one of the following:
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« If the discount applies to part of the fuel dispensed, key the
amount (gallons/liters) and press [ENTER]

o If the discount applies to the entire amount of fuel dispensed,
press [ENTER]

Fuel Preset
A preset fuel sale occurs when the Preset Fuel function is used to approve a fuel
sale for a specific dollar amount or volume. If the approval is by volume, specify
the fuel product. The pump automatically stops dispensing when the dollar
amount or volume is reached, or the tank is full. The sale is paid after the fuel is
dispensed.

Preset Fuel Sale by Dollar Amount

1. Press [OTHER FUEL], press Preset Fuel function, and then press
[ENTER]

2. Key the pump number and press [ENTER]
3. Key the dollar amount
4. Press [ENTER] or the method of payment
OR
1. Key the pump number and press [FUEL PRESET]

2. Key the dollar amount and then press [ENTER] or the method of
payment

The customer dispenses fuel before paying.
Preset Fuel Sale by Volume
1. Press [OTHER FUEL] and then press Preset Fuel function
2. Press [ENTER] and key the pump number and then press [ENTER]

3. Press [QTY] and key the volume of fuel to be dispensed (including two
decimal places)

4. Press [ENTER] or the method of payment and press the fuel product to
be purchased and then press [ENTER]
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OR
1. Key the pump number, press [FUEL PRESET], and then press [QTY]
2. Key the volume of fuel to be dispensed (including two decimal places)

3. Press [ENTER] or the method of payment and then press the fuel
product to be purchased and then press [ENTER]

Manual POP Discount

This is an option that can provide either a coupon or free POP code (with Basic +
Code program type). The cashier has the option of offering the award to
customers at their discretion; perhaps to an especially loyal customer or to a
customer who has experienced some perceived inconvenience.

1. Touch [OTHER FUEL]

2. In the Other Fuel Functions menu, select [Manual POP Discount]

3. In POP Award menu, touch [Generate Code] or [Generate Coupon]

4. The code or coupon prints

Fuel Tax Exemption

This function allows the ability to exempt a fuel tax to a fuel type that is
displaying a “tax free” price at the pump.

Note: The automatic adjustment is only available for postpay fuel sales.
1. Key the pump number, press [FUEL], and then press [OTHER FUEL]
2. Press Fuel Tax Exemption and press [ENTER]
3. Select the fuel tax exemption from the menu
4. Press [ENTER]
Fuel Tax Addition

This function allows the ability to add a fuel tax to a fuel type that is displaying
a “tax free” price at the pump.

Note: The automatic adjustment is only available for postpay fuel sales.
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1. Key the pump number, press [FUEL], and then press [OTHER FUEL]
2. Press Fuel Tax Addition and press [ENTER]
3. Select the fuel tax addition from the menu

4. Press [ENTER]

Configuring Fuel Sales

See the "Configuring Fuel Manager"” section in the Fuel Manager topic for configuration
details.

For Configuring Pump Test, see "Configuring MOP" section of the Methods of Payment
topic.

Reporting

See the Reports topic for various reports related to Fuel Sales.

Troubleshooting
E1274 FUEL PRICE NOT Entered a sale for a fuel product that does not
SETUP have a price set up in the system.

An invalid selection is made when a fuel tax
E1142 INVALID ENTRY exemption is attempted. The fuel tax menu re-
displays and the user can reenter the selection.

FUEL TAXES No fuel tax exemptions have been defined in the

E1259 UNDEFINED Fuel Tax Exemption File.

Fuel Price Sign Controller is not responding to

E5008 FPD SIGN OFFLINE
controller.

Communications between the controller and the
Fuel Price Sign Controller are working, but the
E5009 FPD POLL ERROR Fuel Price Sign Controller indicates that a sign
position is offline. There is a problem with a
particular sign or signs.
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Attempted to apply a fuel tax exemption on
E1260 EXEMPTIONOMUST discounted fuel. Apply the tax exemption first,
BE BEFORE % DISC ;
then apply the fuel discount.
Attempted to add a fuel tax using the Fuel Tax
E1266 ZBEIEJAX ALREADY Addition function and the fuel department for
that item already has a fuel tax assigned to it.
UL TaXNoT | A dSCountuang e (IS ey i ttenoted o
E1273 ALLOWED WITH % rue ption app
DISC a fuel tax exempt1op is attemptgd on an item
that already has a discount applied.
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Loyalty Sales (EPS)

Overview

Loyalty programs come in all shapes and sizes. They can offer on-the-spot discounts or
future savings through incentives as coupons or points toward future purchases.

EPS loyalty sales allow the processing and redemption of loyalty transactions, both
inside at the POS and outside at the dispenser card readers (DCR). These loyalty
transactions are processed through the electronic payment system (EPS).

The EPS Loyalty Front End Processor (FEP) functionality include using the PCATS POS-
Loyalty Host Specification, Price-per-unit Discounting, Transactions-level Discounting,
and Item Level Discounting.

Note: Refer to the Loyalty Sales feature reference documentation for

information on this feature. The Feature Reference is available on Premier
Portal.
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Maintenance

Overview

This section contains general system and terminal functions and settings. The system
will display functions based on the security level of the user.

Using Maintenance

Navigate to CSR Func > Maintenance from the POS (While in Sales, CSR Func can be
located on the right-hand side bottom corner of the screen on Topaz and bottom of
the screen on Ruby2) to access the following Maintenance functions:

e Adjust Volume

o Adjust Brightness

o System Messages

o« Device Configuration

Adjust Volume
1. Touch [Adjust Volume]
2. Touch the number for the correct volume [0 - 10]
3. A chime sounds to indicate the volume
4. Touch [OK] to save the volume

Adjust Brightness
1. Touch [Adjust Brightness]
2. Touch the number for the correct brightness [0 - 10]
3. The brightness changes when a number is touched
4. Touch [OK] to save the brightness

System Messages
1. Touch [System Messages]
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2. The System Messages list displays

3. Touch down arrow to scroll and review the messages

Device Configuration Menu
1. Touch [Device Configuration]

2. Touch the appropriate entry or key the entry number of the device to
configure

3. Press [ENTER]

Configuring Maintenance

Use Initial Setup to update general terminal information and maintain the system
software and hardware.

Configuration under “Maintenance” is limited to Site Registration, a function that can
also be performed at the POS. Additional functions not available through the POS are
included here.

Registration

The Registration form presents information that must be supplied to the Verifone
Technical Support Center in order to obtain a Registration Key. Call the Verifone
Technical Support Center at (888) 777-3536. The Support Center will process the
registration while you are on the phone.

Note: Registration is only done once, at the time of installation. Registration is

required any time site information for key components changes like application,
version, etc.
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Maintenance - Registration

Registration Info

REGISTRATICHN IMFORMATICHN LISTING a
Begistration Status: NOT REGISTERED

FEATURE (REF#)
BASE SYSTEM (GemBeg 2.0)
Zpp MName: BP
App Version: 1.00.02
Shifts: 03 (61)
0/5 Version: 3.2.11
Flash Disk Size: 8
DRAM Size: O
EID: 000660006962 (50}
Installed by: 5C
Site Phone Nbr:
Postal Code:
Feature card: (HCHNE)

FCW: 0O (813) W
SC RFS v1l.02.00 [421)
Registration Key Register ' Print Registration Info |

Functions

Field/Button Allowable Value/Function

Enter the Registration Key supplied by the Verifone

Registration Key echnical Support Center.

Maintenance Configuration

The Maintenance Configuration form is used to reset the Fuel and Register running
totals, and to enter the telephone and postal code information for the site.

Totalizers

Use after installing new software. Before installing new software, close all cashiers
and run the next period report. Enter the totals so that they are not lost.

For example, if the software is reinstalled at midnight, run the Close Daily report just

before the installation. Do not perform any transactions until after the software is
installed and the running totals are entered.
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Malntenance Conflguratlon

Fuel Totahzers Reglster Totahzers Telephone&Postai Code ;

Fueling Point [ LE
~Operation Type

© Clear © Update from Dispenser Totals © Manual Entry

All Count Dollars Volume

[Hose #1 |1 | 5.00 | 14460 |
[lHose 22 [0 | looo | Jo.000 |
[Hose #3 0 | lo.00 | lo.ooo |
[Hose #4 |1 | 5.02 s 0
[Hose#5 2 | 160.00 | [12.109 |
[lHose #6 1 | [10.00 | 1633 |

Malntenance Conflguratlon

Fuei Totahzers Reglster Totahzers ‘. Teiephone& Postal Code

Register [9__ Cif[{]
o Operation Type

© Clear = ©) Manual Entry

[Tl An Sales Grand
[Clshift |70.02 | [70.02

Functions

Field/Button Allowable Value/Function

Fuel Totalizers - Select the fueling point for which you want to set the running
Fueling Point otals.
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|Hose #n Enter the dollar and volume totals for each hose on the fueling
point.

Register Totalizers - [Select the register for which you want to set totals.
Register

Sales / Grand Enter the Sales and Grand totals for each period. The periods
that display depend on your setup.

Note: Setting totalizers after an upgrade is optional.
Telephone & Postal Code

Use to enter the telephone number (area code first) and postal code for the site.
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Overview

Manual discount unlike automatic discount requires specific actions by the cashier.
Examples include any discount using a discount key or entering a discount amount.

Using Manual Discounts

Use the following Manual Discount functions to give:

= Fixed Discount

= Percent Discount

=  Amount Discount

Note: To access [Disc] function on Ruby2, a soft key needs to be programmed. Refer
to store manager to program soft keys.

Fixed Discount

1. After entering the product, press [DISC]

The system applies the discount to the line item
Percent Discount

1. After entering the product, key the percent discount including two
decimal places, for example: [1][0][0][0] = 10% Discount

2. Press [DISC %]
The system applies the discount percentage to the line item.
Amount Discount

1. After entering the product, key the dollars and cents discount, for
example: [1][0] = 0.10 discount

2. Press [DISC]

The system applies the discount amount to the line item.
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Manual Discounts

Store Operations >

The security level 1 - 9, an
employee must have in order
to use the [DISC] key and

Configuration

Discount Sales > Sales 0-9 approve discounts.
Security Level . )
Configuration
0 - Discounts do not require a
security check.
Percent -The discount is
calculated as a percentage of
the price and then subtracted
Store Operations > from the price of the item.
. Percent,
Discount Type | Sales > Sales Amount
Configuration Amount -The discount is
directly subtracted as a dollar
amount from the price of the
item.
. Percent or amount (set in
. . Store Operations > s -
Fixed Discount . Discount Type”) is
Sales > Sales Numeric . :
Rate Confisuration automatically applied when
g the [DISC] key is pressed.
Automatically enter discounts
(set in “Discount Type” as a
percent or amount) for the
Is Fixed Store Operations > amount entered in “Fixed
Discount Sales > Sales Yes, No | Discount Rate” when the
Configuration [DISC] key is pressed. If not
selected, all discounts must
be entered as individual
amounts.
Maximum discount (either
. Store Operations > percent or dollar as set in
Maximum 0.00 - s '
) Sales > Sales Discount Type”) that can be
Discount 99.99

applied to an item when using
the [DISC] key.
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Minimum discount (either
- Store Operations > percent or dollar as set in
Minimum 0.00 - s M
. Sales > Sales Discount Type”) that can be
Discount . ) 99.99 . . .
Configuration applied to an item when using
the [DISC] key.
Reporting
deMO ITEMS Sample Memo Items showing number and
amount of discounts.
Aggregate discount totals appear in
Memo Item section of the following
Discounts 6 7.41 reports:

e Cashier Report
e Summary Report

Discount totals by Department are
represented in the Department Report.

Report Details

e DISCOUNTS: Number of times and total amount of discounts. This includes
discounts from:

o

Use of the [DISC], [DISC%], and [DISC AMT] keys

Combo, mix ’n match, fuel, and promotional discounts

Troubleshooting

DISCOUNT TOO The discount entered is less than the set
E1121 .

SMALL minimum amount.

DISCOUNT TOO The discount entered is more than the set
E1122 .

LARGE maximum amount.
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A discount using the [DISC] key is attempted on
FUEL TAX NOT 0 an item that has a fuel tax exemption applied or
E1273 ALLOWED WITH % . i
DISC a fuel tax exemption is attempted on an item

that already has a discount applied.
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Overview

A menu is a group of PLUs displayed at the same time. There are several types of
menus:

« Ruby: Displays 6 items in an overlay menu and menu clears after 1 selection.

o Expanded: (also known as single-select) displays items in a 4x4 grid and menu
clears after 1 selection.

e Multi-Select:displays items in a 4x4 grid and remains displayed until you touch
the “Done” button.

o Parked Menu: displays each menu item on individual buttons of the parked
menu panel so that a single touch adds the item to the transaction. The menu
remains displayed through multiple transactions until clerk selects another
menu configured as “parked”.

e Menu Chain: The menu name appears on the POS screen and when selected by
the cashier, leads to the other menus in the chain.

Using Menus
Ruby Menu

1. Touch or press the appropriate [MENU KEY]

2. From the overlay, touch the desired item or key entry number and press
[ENTER] to add item to the transaction.

Expanded Menu
1. Touch or press the appropriate [MENU KEY]

2. Touch the desired item or key entry number and press [ENTER] to add
item to the transaction.

Multi-Select Menu
1. Touch or press the appropriate [MENU KEY]
2. Touch the desired item or key entry number and press [ENTER]
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3. Repeat step 2 to sell additional items
4. Touch [DONE]
Parked Menu
1. Touch or press an appropriate [MENU KEY] configured as parked.
2. Touch the appropriate button from the parked menu panel to add item
to transaction (all buttons in the parked menu pane will be the same

color.

3. When items from another parked menu are desired, touch the
appropriate [MENU KEY] and continue sales

Menu Chain
1. Touch or press the appropriate [MENU KEY]
2. Do one of the following:

1. Touch the desired item or key entry number and press [ENTER] to
go to next menu type

2. Touch Next to go to next menu type
3. Repeat step 2 to sell additional items

4. Touch [Dismiss], to come out of the menu chain
Configuring Menus

Menu Key Configuration

Use Store Operations > Menu Key to configure menu keys.

The Menu Key Configuration form allows you to add PLU items to menus.

Note: Menus designated as parked or expanded may have up to 50 menu items.

Other menus may have one to six items.
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Menu Key Configuration | save | Cancel |
[pelete
Menu Key Menu ltems
Select Menu {1 . .

Type |Menu Chain .

Parked [ |

Add

| Modity |

Remove |

Menu Key Configuration | save | cancal |

[ pelete
Menu Key Menu ltems

Select Menu I‘I .
Type [T~ |

Parked [ ]

PLU ] [ |

| Remove |

Select an open menu key number. (Up to 100 maximum

Select Menu
menu keys.)

Delete Select to delete the selected menu key.

Displays the name of the menu selected by number. (The

Name name may be edited.)

Select from the following:

Type
Ruby Menu -Six items (PLUs) per menu are allowed.
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Expanded Menu - Items display on the expanded menu of
the Topaz screen. Up to 50 items per menu are allowed.

Multi-Select Menu - The menu stays open on the Topaz
screen, allowing multiple selections.

Menu Chain - The menu appears on the POS screen (or as a
key) and when selected by the cashier, leads to the other
menus in the chain.

Parked

Select to allow the menu items to display on the parked
menu panel of the POS screen. (This option is not available
for Menu Chain Types.)

Order Menu

Available when Menu Chain type is selected.

After a rule is created for fast food on the POS, the PLUs
that are added can become part of an Order Menu so that
the transaction produces a receipt like an iOrder receipt.

To use this feature, do the following:
1. Create a rule (see “Rule Manager > Fast Food

Orders on POS”) and enter the PLUs to be evaluated
as part of the rule.

2. Open Menu Keys Configuration form and select the
menu and select Menu Chain as the type.

3. Select the menu from the menu drop-down list.
Click Add. The menu is added to the Menu Items list.

4. Repeat to add more menus to the menu chain. Click
Save.

Note: Refer to the Food Service Order User Reference
for more information on this feature. The Feature
Reference is available on Premier Portal.

Add

Click Add to add the PLU that was entered or the menu
that was selected from the drop-down list to the Menu
Items list.
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Use to exchange an item in the Menu Items list for another
PLU or menu.

1. In the Menu Items list, double click the PLU or menu
to be replaced. The selected item appears above

Modify the Add button.

2. Enter another PLU or select another menu from the
drop-down list and click Modify. The selected item
replaces the original in the Menu Items list.

Click Remove to delete the selected PLU or menu from the
Remove

Menu Items list.
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Messages and Troubleshooting

General Messages

This section contains general messages that may appear on the Operator Display but

are not numbered.

If more than one message occurs at a time, the messages take turns displaying briefly.
Messages are listed in alphabetical order. Information contained in parentheses is a
variable and changes depending on the circumstances.

(#) RECEIPT(S) PENDING

The indicated number of transactions (#) are
suspended.

ACCEPTED

The entry made for either the Set Store Telephone
Number or Set Store Postal Code function was
accepted into the system.

CARD IN READER

A customer left a card in a DCR.

CARDSCAN 0 LOADED

(Schlumberger) Broadcast loading of all DCRs
(CARDSCANSs) has concluded. The ‘0’ means ‘all.’

CASSETTE FULL

A cash acceptor cassette is full and needs to be
emptied before this message clears.

COMBO#nn INVALID!

The cashier attempted to sell a combo that does not
exist.

COMM FAILURE

Check the phone cord connections (Dial) or PES
connections (VSAT); retry contacting the network; if
communication failures are consistent and repeated
and you have verified the connections, contact the
Verifone Technical Support Center.

DEBIT MODULE NOT
PRESENT

Debit is not available at a DCR.

DROP (method of
payment)

The cash drawer contains more than the maximum
allowed for the method of payment indicated. Make
a large enough safe drop to reduce the amount in
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the drawer to below the maximum allowed.

FUEL COMMS ERROR The POS lost communication with the fuel controller
through which it controls the dispensers. Check the
connections. If the connections are good and
communication cannot be reestablished, contact the
Verifone Technical Support Center.

GSM OFFLINE Check the connections to and from the Gilbarco
Security Module (GSM). If connections are good but
the GSM is still offline, contact the Verifone
Technical Support Center.

HOST UNAVAILABLE Check the phone cord connections (Dial) or PES
connections (VSAT); retry contacting the network; if
communication failures are consistent and repeated
and you have verified the connections, contact the
Verifone Technical Support Center.

INVALID CHARACTERS Either the telephone number was not entered
correctly in the Set Store Telephone Number
function or the postal code was not entered
correctly in the Set Store Postal Code function. Use
0 - 9 only. Do not use separators.

Invalid input The PLU/modifier combination entered for the car
wash key does not exist. Define this department in
the PLU File first or choose another department.

INVALID TIME OF The time for the original transaction was entered
TRANSACTION incorrectly for a Fleet card refund.
KEYPAD ERROR: rp1 Return PIN Failure: Invalid master key type or range.

Call the Verifone Technical Support Center. The
helpdesk should contact a servicer.

KEYPAD ERROR: rp2 Return PIN Failure: Key not loaded. Call the
Verifone Technical Support Center. The helpdesk
should contact a servicer.

KEYPAD ERROR: rp3 Return PIN Termination: [CANCEL] key pressed. No
action required. The transaction times out and
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returns to idle.

KEYPAD ERROR:

rp4

Return PIN Termination: [CLEAR] key pressed twice.
No action required. The transaction times out and
returns to idle.

KEYPAD ERROR:

rp5

Return PIN Termination: Delay between entering pin
numbers is too long. No action required. The
transaction times out and returns to idle.

KEYPAD ERROR:

rpé

Return PIN Failure: Incompatible with encryption
mode. Call the Verifone Technical Support Center.
The help desk should contact a servicer.

KEYPAD ERROR:

rp7

Return PIN Termination: First key time out expired.
No action required. The transaction times out and
returns to idle.

KEYPAD ERROR:

rs1

Return String Failure: Invalid display buffer or
display range. Call the Verifone Technical Support
Center. The help desk should contact engineering.

KEYPAD ERROR:

rs2

Return String: Undefined error. Call the Verifone
Technical Support Center. The help desk should
contact engineering.

KEYPAD ERROR:

rs3

Return String Termination: [CANCEL] key pressed.
No action required. The transaction times out and
returns to idle.

KEYPAD ERROR:

rs4

Return String Termination: [CLEAR] key pressed
twice. No action required. The transaction times out
and returns to idle.

KEYPAD ERROR:

rsb

Return String Termination: Delay between entering
pin numbers is too long. No action required. The
transaction times out and returns to idle.

KEYPAD ERROR:

rsé

Return String: Undefined error. Call the Verifone
Technical Support Center. The help desk should
contact engineering.
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KEYPAD ERROR: rs7 Return String Termination: First key time out
expired. No action required. The transaction times
out and returns to idle.

LOADING 0 CARDSCAN (Schlumberger) Broadcast loading of all DCRs
(CARDSCANSs) has begun. The ‘0’ means ‘all.’

The network has sent mail to the terminal. Use the
Mail function in Network Manager mode to read your
mail.

MAIL PENDING or MAIL
WAITING

Max number exceeded You tried to perform either a pay out or a pay in and
have reached the maximum number of times
allowed for this period, which is 25.

MONEY ORDER PRINTER | The POS is not communicating with the money order
UNAVAILABLE. EXITING printer. Check the communications link between the

PAY OUT two machines.

NETWORK SUSPENDED The controller is retrieving a network suspended
TRANSACTION transaction from a workstation.

NO CAR WASH COMM The server and car wash controller are not

communicating. Check that the controller is plugged
in and connected to the correct COM port.

There are no cashier reports available for printing.

NO CASHIER REPORT This occurs in the Print Cashier Report function in

AVAILABLE Reports mode.

NO CHANGES MADE The [ENTER]key was pressed before data was
entered in the Registration Information function.

NO COMM DSR The POS has detected a loss of connection to the

ISDN, VSAT, or T3POS network hardware.

NO SALES SINCE LAST No sales have occurred since the last Close Period
SHIFT, OK(Y/N)? report was run. This occurs in Close Shift, Daily,
Monthly, and Yearly report functions in Reports
mode.
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PDL UPDATE PENDING The Parameter Download has been requested, but
the parameters have not been updated. After the
Close Daily, the parameters can update.

PRINTER COVER OPEN The printer cover is not completely closed. Close the
cover.

RECEIPT BLOCKED The POS cannot communicate with the receipt
printer. Make sure that the printer is online and that
all connections are securely in place.

RECEIPT PAPER LOW The paper in the receipt printer is getting low. Add

new paper.
Refused No voice auth A voice authorization number for the tendered
phone number PRESS credit card was not provided during the parameter

ENTER KEY TO CONTINUE | download. The customer must use a different
method of payment.

SUSPENDED TRANSACTION | A transaction is currently suspended.

SYSTEM NOT REGISTERED | The application has not been registered within eight
hours of installation.

The network does not recognize the credit card. See
UNKNOWN CARD SEE CC | the store’s credit card guide for information on card
GUIDE/ACCEPT CARD? acceptance or denial.

Numbered Messages

This section contains numbered messages. Messages are grouped by related
functional area and listed in ascending order. There are four types of messages:

o Most of the messages appear on the first line of the Operator Display.
Many appear momentarily then disappear.

e Messages that have “Alarm Line Only” at the beginning of the
description appear on the bottom line of the Operator Display. Someone
such as a manager or servicer, must take some action to clear the
message.

e Messages that have “DCR Message” at the beginning of the description
display on the DCR and do not display on the POS.
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E1101 | INVALID CASHIER # The cashier number entered is incorrect. Re-
key the number.
E1102 | INVALID PASSWORD The .passworc.l entered is incorrect. Re-key
the information,
E1103 | INVALID DRAWER # Entered a drawer number that has not been
set up. Key the drawer number again.
E1104 | MOP INVALID/NOT Used an MOP soft key that no longer exists.
ALLOWED Choose another MOP.
E1105 | LAN UNAVAILABLE, The POS cannot process a hetwork
CHECK CABLE transaction. Check for loose connections on
the back of the POS.
E1106 | USE VOID LINE/VOID Attempted to use [ERROR CORR] to remove
TICKET more than the last item from the current
transaction. Use [VOID LINE] to remove
additional items from the transaction or
[VOID TICKET] to remove the entire ticket.
E1107 | INVALID KEY PRESSED The wrong key was pressed during a
transaction. Wait for the error to clear and
press the correct key.
E1108 | INVALID QUANTITY The quantity entered is less than minimum or
greater than the maximum allowed.
E1109 | PRESET NOT USED The soft key has not been defined or the PLU
no longer exists.
E1110 | PLU TOO LONG PLU entered has too many digits. Key the
correct PLU.
E1111 | INVALID PLU Etg entered does not exist. Key the correct
E1112 | ART. NOT FOR SALE Article not for sale.
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No refund is allowed on this PLU or in this

E1113 |[NO REFUND ALLOWED
department.
E1114 | INVALID BARCODE Barcode .is not recognized for this
transaction.
The department entered in Department
Setup function in Car Wash Manager mode
E1115 | INVALID DEPARTMENT does not exist. Define the department in the
Department File or choose another
department.
The dollar amount entered is larger than the
E1116 | AMOUNT TOO LARGE maximum allowed for this department or
MOP.
E1118 ESEIS_PLIT TENDER ON Only one MOP allowed for fuel purchases.
E1119 | OPER. NOT ALLOWED The attempted operation is not allowed.
E1120 DO NOT OVERRIDE MOP | Cannot override the minimum or maximum
AMOUNT allowable amount for an MOP.
E1121 | DISCOUNT TOO SMALL The.discount entered is less than the set
minimum amount.
E1122 | DISCOUNT TOO LARGE The Fiiscount entered is more than the set
maximum amount.
E1123 INVALID NUMBER OF Fuel discount is not valid for the gallons
GALLONS (LITERS) (liters) entered.
E1124 | PAYROLL RECORD FULL |Print a Payroll Report.
INVALID CHOICE, TRY The item number entered is not available on
E1125
AGAIN the menu.
E1126 | MUST CLOCK OUT FIRST

Employee attempted to clock in but has not
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clocked out yet.

E1127

MUST CLOCK IN FIRST

Employee attempted to clock out, but had
not clocked in yet.

E1128

FINISH TRANSACTION

The sale MUST BE completed because no
more line items can be added to the
transaction.

E1129

NO FUEL DEPARTMENT

Fuel department needs to be set up.

E1130

MOP CONFLICT

Customer dispensed fuel at one MOP price
level and attempted to pay with an MOP
associated with a different price level when
the “Ignore MOP conflict” parameter is set to
‘N’ in Fuel Manager > DCR Configuration.

E1131

AMOUNT TOO SMALL

The dollar amount entered is less than the
minimum set up for the department or MOP.

E1132

SUB-TOTAL REQUIRED

Must press [TOTAL]before choosing an MOP.

E1134

PENDING TRANSACTION

Cannot complete function because a
transaction is pending.

E1135

DROP MONEY FIRST

The amount of money in the drawer exceeds
the limit set in the MOP File function.
Perform a Safe Drop.

E1136

INVALID CATEGORY NR

‘NR’ = number - The item entered does not
have a valid category. Enter a valid category
number.

E1137

NO FEE/CHARGES DEPT.

Fee/Charges department must be set up.

E1138

INVALID MOP AMOUNT

The dollar amount entered is not allowed by
the selected MOP. This can occur if a dollar
amount is entered and credit selected

because credit only takes the balance of the
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sale.

MOP may not require an amount or the

E1139 INVALID AMOUNT amount entered is less than the minimum or
ENTERED more than the maximum amount allowed for

the MOP.

E1140 | AMOUNT REQUIRED A dollar amount must be entered.

The customer cannot purchase this item
because either (1) the date of birth entered

E1141 | PURCH. NOT ALLOWED for the ID check does not meet the age

requirements or (2) a Blue Law restriction
has been set up for this item or department
at this time on this day.

An invalid selection is made when a fuel tax

E1142 | INVALID ENTRY exemptlon is attempted. The fuel tax menu

redisplays and the user can re-enter the
selection.

E1143 INVALID DATE, CHECK Dates MUST BE entered as six digits in the
FORMAT format MMDDYY (month/day/year).

E1144 | INVALID MODIFIER The modifier.e.ntered is incorrect. Select

another modifier.

E1145 | CASH ONLY ALLOWED Only cash is allowed in this transaction.

E1150 REFUND NOT ALLOWED | A credit card purchase cannot be refunded in
ON CREDIT SALE cash.

E1151 TICKET TOTALS ZERO - | Although the total on the ticket is zero, press
Press CASH [CASH]to complete the transaction.
NEGATIVE CHECK .

E1152 AMOUNT NOT ALLOWED A check cannot have a negative amount.

E1153 | TOTAL OVER LIMIT The transaction amount is more than the

network allows on this card. Credit card
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parameters may require an update from a
parameter download.

Appears if the View Pending Transactions

NO PENDING L
E1155 TRANSACTIONS function is selected. and there are no
suspended transactions.
Attempted to do a ticket reprint or ticket
recall on a DCR/ fuel transaction and the POS
E1156 | INVALID RECEIPT INFO found the ticket data invalid. Call servicer
for assistance.
Sale cannot be suspended. Perhaps the
E1157 | UNABLE TO SUSPEND maximum number of suspended sales have
been exceeded.
The DCR has a stacked sale and the cashier
attempted to reprint the receipt for sale #1.
E1158 | REPRINT NOT POSSIBLE |Because the POS keeps only the last DCR
transaction, a receipt for the first sale
cannot be reprinted.
INVALID RECEIPT No fuel receipts available for printing at this
E1159
NUMBER pump.
Too many transactions are suspended. Only
MAXIMUM PENDING d .
E1160 TRANS. EXCEEDED gir:]:eecredlt transaction can be suspended at a
E1161 | NO SAVED RECEIPTS No receipts are available for printing.
Attempted to close a shift while a network
E1162 EEEBILg §IER-IATII-\ILSE transaction is suspended. Settle the pending
’ transaction and then close the shift.
E1163 | NO CHANGE ALLOWED | “Change Allowed” is set to ‘No’ for this MOP.
E1164 | REFUND NOT ALLOWED | “Refund Allowed” is set to ‘No’.
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Attempted to use a function that is not

SUPPORTED available or not enabled.
E1166 INVALID FUEL The fuel transaction no longer exists in the
TRANSACTION system.
E1167 | SOFT KEY NOT DEFINED ;’R: soft key is not defined in the Soft Key
E1168 | SALE REQUIRED The attempted function requires an item to
be sold.
E1169 | INVALID KEY SEQUENCE The order of keystrokes pressed is invalid.
Try another sequence.
CARWASH QTY SALE NOT .
E1170 ALLOWED Car washes can be sold only one at a time.
A key for this car wash item must be defined.
E1171 NO CAR WASH KEY Set up a car wash PLU in Car Wash Manager >
DEFINED FOR PLU
Car Wash Key Setup.
Attempted to sell a car wash that does not
E1172 CAR WASH KEY NOT exist on the car wash controller. Call the
PROGRAMMED .
servicer to set up the car wash controller.
The POS and car wash controller are not
communicating. The car wash code is not
E1173 | CAR WASH COMM ERROR received frqm the cpntroller. If thg
noncommunication just started or just
ended, it may take a minute for the alarm to
turn on or off.
The workstation is not communicating with
E1175 | LAN COMMS ERROR the controller. Check the LAN connections.
Selected MOP is not configured for cashback.
E1176 MOP NOT ALLOWED Either cancel the cashback or use another

WITH CASHBACK

MOP.
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E1178

CAR WASH PARM FILE
READ ERROR

A car wash code is requested from the device
and an error is detected while trying to read
the car wash file. Call servicer.

E1181

SAFE DROP NOT
ALLOWED FOR MOP

The MOP used disables Safe Drop in the MOP
File.

E1186

INVALID PUMP NUMBER

The pump number has not been entered
correctly or does not exist. Check that the
number is correct and re-enter it.

E1187

NETWORK SUSPENDED
TRANSACTION

Attempted to recall a network transaction
from a different POS than the one on which
the transaction was suspended. Use the same
POS to recall the transaction.

E1188

MOP APPLIED BEFORE

A special discount has already been applied
to the transaction; only one special discount
is allowed.

E1189

NO ELIGIBLE ITEM

A special discount cannot be applied because
no items in the transaction are set up to
receive a special discount.

E1190

MUST BE FIRST MOP

The special discount MOP must be entered
first. Use [ERROR CORR] to remove the other
MOPs, then apply the special discount MOP.

E1192

REFILL COIN DISP

The number of coins in the dispenser are
running low. Refill the dispenser within four
transactions of the appearance of this
message or the coin dispenser becomes
unavailable.

E1193

CHECK COIN DISP

The coin dispenser is unavailable because of
a communication error or because the coins
have run out.

E1194

NOT ENOUGH MONEY IN

The POS does not have sufficient funds in the
cash drawer for the MOP entered for a safe
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DRAWER drop amount.
E1195 NOT ALLOWED FOR AMT | $0.00 is not allowed for a safe drop amount.
0.00 Specify an amount more than $0.00.
A Blue Law restriction is set up for this item
E1196 |BLUE LAW RESTRICTION | or department, preventing its sale during a
certain time of the day.
This item does not have a unit price assigned
E1197 | INVALID PRICE to it in the PLU File function in Manager
mode.
[VOID LINE] cannot be used in this
E1200 | USE VOID TICKET transaction. Use [VOID TICKET].
E1201 NO AT-FOR SALES W/ At-for pricing cannot be used for items that
FRACTIONAL QTY can be sold in fractional quantities.
. The [OTHER MOP]key is pressed and there are
E1202 | No MOPs available no MOPs assigned. Choose another MOP.
One of the following occurred: The maximum
number of batches per day is reached. The
£1203 TERMINAL FULL, CLOSE | maximum number of transactions in a batch
DAY is reached. The batch is set to close with the
Close Daily. Perform a Close Daily to reset
the batches.
The maximum number of transactions in a
E1204 -SI-IEFI_AAI.INAL FULL, CLOSE batch is reached and the close period is set
to Close Shift. Perform a Close Shift.
The POS stored as many clock in/outs as it
E1206 | PAYROLL RECORD FULL can hold. Run the Payroll Report function.
1207 INVALID CHOICE, TRY A number other than 1 or 2 is entered. When

AGAIN

clocking in or out enter the correct value.
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E1208 | MUST CLOCK OUT FIRST | Must clock out before trying to clock in.
E1209 | MUST CLOCK IN FIRST Must clock in before trying to clock out.
The POS is not communicating with the car
E1210 CAR WASH DOWN. CODE | wash controller but can still provide a car
AVAILABLE wash code. The code is valid for a specified
time.
The POS is not communicating with the car
E1211 CAR WASH CODE wash controller and no car wash code is
UNAVAILABLE available. The servicer should investigate the
problem.
E1212 NO DCR RECEIPT Attempted to print a DCR receipt inside and
AVAILABLE there are none available.
E1213 MANUAL CREDIT NOT The Manual Credit MOP is not allowed in this
ALLOWED transaction. Choose another MOP.
Non-fuel items are not allowed in the same
E1214 ONLY FUEL ALLOWED ON| transaction as a credit fuel prepay when the
PREPAY CREDIT “Enable Fast Credit” parameter is set to ‘Y’
in Manager > Sales Config.
Communication with the receipt printer is
E1215 RECEIPT PRINTER not established in Sales mode. Check the
UNAVAILABLE connections on the back of the POS and make
sure the printer is online.
The driver's license reader failed to read the
E1216 | LICENSE TRACK 2 EMPTY magnetic §trlpe 1nformat1.on. Run Fhe ID
check again or enter the information
manually.
Driver’s license was swiped/scanned and
LICENSE NOT . )
E1217 SUPPORTED format is not recognized. Manually enter the
information.
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Driver’s license swiped/scanned has expired.

E1218 | LICENSE EXPIRED Manually enter the information.
The driver’s license just swiped/scanned has
E1219 LICENSE EXPIRATION expiration date information errors. Run the
DATE ERROR ID check again or enter the information
manually.
The driver’s license just swiped/scanned has
E1220 LICENSE BIRTH DATE invalid birth date information. Run the ID
INVALID check again or enter the information
manually.
An unknown error occurred while trying to
E1222 UNEXPECTED EASYID process a driver’s license. Enter the
ERROR : .
information manually.
£1223 SCANNER NOT PDF417 | The scanned driver’s license data is not in
DATA the proper format. Enter the data manually.
The scanner did not successfully read any
E1234 | SCANNER DATA EMPTY data from’thg driver’s l!cense. Try to scan
the driver’s license again or enter the
information manually.
The money order just sold cannot be printed
MONEY ORDER PRINTER | because the POS is unable to communicate
E1235 | UNAVAILABLE. with the money order printer. The money
CONTINUE Y/N? order must be entered and printed locally on
the money order terminal.
An MOP, with the “Allow Money Order
E1237 NO MONEY ORDER Purchase” parameter set to ‘N’, was used. To
PURCHASE FOR MOP
purchase a money order. select another MOP.
Attempted to sell more money orders on the
F1238 TOO MANY MONEY current ticket than allowed. End the current

ORDERS IN SALE

transaction. Start a new transaction for the
rest of the money orders.
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A money order pay out was attempted and
MONEY ORDER PRINTER | the POS was unable to communicate with the
E1239 | UNAVAILABLE EXITING | money order printer. The money order pay
PAY OUT out must be entered and printed locally on
the money order terminal.
Attempted to sell a combo that was outside
the established effective time period. The
E1240 | COMBO#xx DISABLED combo cannot be sold until the time period is
updated in Manager mode. The items can be
sold separately at no discount.
The combo is no longer defined. The combo
cannot be sold until it is redefined in
E1241 | COMBO#xx INVALID Manager mode. The items can be sold
separately at no discount.
The POS could not find track 2 data on the
E1242 | GET TRK 2 ERROR driver’s license just swiped. Enter the
information manually.
The POS could not read track 2 data on the
E1243 | TRK 2 READ FAIL driver’s license just swiped. Enter the
information manually.
i POP Code provided and rejected - code does
E1244 POP CODE REJECT not meet requirements of internally defined
INVALID CODE .
algorithm.
POP Code provided and rejected as expired
E1245 POP CODE REJECT - code based on when code was generated and
EXPIRED CODE the configuration setting of “number of days
POP Code valid” in Sales Config.
1246 POP CODE REJECT - POP Code provided and rejected - same code
PREV REDEEMED has been flagged as previously redeemed.
E1247 POP CODE REJECT - POP Code provided and rejected because a
INVALID DISC discount has already been applied to the fuel
purchase. (POP cannot apply to an already
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discounted fuel purchase.)

INVALID ENTRY -

Attempted to configure a PLU for a POP

E1248 CONFIGURED FOR DEAL gggfunt that was already configured for
1249 SPLIT TENDER NOT Attempted to split a transaction between two
ALLOWED or more MOPs, which is not allowed.

E1250 ONLY FUEL PRODUCTS | An MOP that allows only fuel products to be
ARE ALLOWED purchased has been chosen.
E1251 ONLY POST PAY FUEL IS | An MOP that allows only post pay fuel
ALLOWED products has been chosen.
Attempted to log on to SALES while another
E1253 OPERATOR #<999> 15 cashier is logged on to that register. Security
ACTIVE s
override is not allowed.
E1254 MEMBER ID CARD Membership card scanned for POP discount is
REJECTED not valid.
OPERATOR#<nnn>IS Attempted to log on to SALES while another
E1255 | ACTIVE LOGIN cashier is logged on to that register. Security
OVERRIDE? [Y/N] allows override.
INSUFFICENT AMT. NEED | Prepaid card does not have sufficient funds
E1256
SX. XX for the purchase.
Part of the Auto-Refund feature. A credit
card was used to pay for the initial prepay
E1257 | MUST PRESS CREDIT transaction and cashier tries to refund the
underrun amount to any MOP other than
credit.
In an automatic Prepay Underrun, no
E1258 NO MERCHANDISE WITH merchandise is permitted to be in the same

PREPAY UNDERRUN

transaction when the MOP is credit-based.
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E1259 | FUEL TAXES UNDEFINED No fuel tax exempthns hqve been defined in
the Fuel Tax Exemption File.
Attempted to apply a fuel tax exemption on
E1260 EXEMPTIOO N MUST BE discounted fuel. Apply the tax exemption
BEFORE % DISC . .
first, then apply the fuel discount.
) Displays when the Member ID card is
E1261 MEMBER 1D REJECT presented and a discount has already been
ALREADY APPLIED : .
applied to the transaction.
£1262 BIRTHDATE ENTRY Requires a valid DOB entry. The [ENTER] key
REQUIRED cannot be used to bypass this operation.
Attempted to continue the transaction
ITEM REJECT - X .
E1263 .~ | Without responding to the ID check prompt
BIRTHDATE ENTRY REQD with a valid DOB entry.
) Attempted to continue the transaction
E1264 ITEM REJEC.T CASHIER without responding to the POS. The error
ENTRY REQD .
message requires a response.
. Attempted to apply a POP Discount at the
E1265 (POP Discount Message) POS when a POP Discount has already been
ALREADY APPLIED .
applied at the DCR.
Attempted to add a fuel tax using the Fuel
E1266 FUEL TAX ALREADY Tax Addition function and the fuel
ADDED department for that item already has a fuel
tax assigned to it.
INVALID STATE .
E1267 ABBREVIATION A wrong state abbreviation was entered.
£1268 CANNOT CYCLE Attempted to loop through modifiers by
THROUGH MODIFIERS pressing the modify key.
E1269 | CASH DRAWER OPEN gﬁzllvcei:jawer is left open longer than the time
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Reached the maximum number of prepaid

E1270 cards that can be activated/recharged on
REACHED one ticket. Start a new ticket.
E1271 CASHBACK AMOUNT Cashback request exceeds the limit set on
EXCEEDS LIMIT the POS or by the network.
E1272 ONE LINE ITEM PER FUEL | A network sale has more than one line item
GRADE of the same fuel grade.
A discount using the [DISC] key is attempted
on an item that has a fuel tax exemption
E1273 FUEL IAX NOT ALLOWED applied or a fuel tax exemption is attempted
WITH % DISC : }
on an item that already has a discount
applied.
E1274 | FUEL PRICE NOT SETUP Entered a salg for a fue! product that does
not have a price set up in the POS.
E1275 CHECK SCAN CONTAINS | A scanned check contains an unreadable
ERRORS element. Retry.
E1277 PREPAID CARD NOT The prepaid card function is not supported or
ALLOWED enabled.
E1279 |SECURITY CODE INVALID | Entered invalid security code. Retry.
E1280 | INVALID ZIP CODE Zip code entered is invalid. Check the zip
code and re-enter.
E1281 | INVALID ZIP LENGTH Zip code entry is less than five digits.
Zip code entry failed either because the code
E1282 |[INVALID ZIP ENTERED entered is invalid, or the number of retries
has been exceeded.
£1283 SUSPEND WITH FUEL Attempted to suspend a transaction with a

INVALID

prepaid fuel sale, which is not allowed.
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1284 EXCEEDS SITE SALE The purchase amount is greater than the
MAXIMUM maximum allowed by the network.
1285 GIFT CARD AMOUNT TOO| The amount being applied to the card is
HIGH higher than the maximum amount allowed.
1286 GIFT CARD AMOUNT TOO| The amount being applied to the card is
LOW lower than the minimum amount allowed.
1287 GIFT CARD CANNOT BE | The Gift Card is not set up for activations
ACTIVATED /recharges.
1288 COMM OFFLINE: NO GIFT | Attempted to activate/recharge a Gift Card
CARD FUNC when the network is offline.
E1289 NON GIFT CARD ITEM ON| Gift card functionality is not valid for at least
TICKET one item in the transaction.
E1290 CARD IS NOT A GIFT Attempted to activate/recharge a non-Gift
CARD Card.
E1291 MANUAL ENTRY NOT Manual entry is not allowed for this Gift
ALLOWED Card.
£1292 TOO MANY GIFT CARDS | Attempted to activate/recharge more Gift
ON TICKET Cards than the network allows.
£1293 GIFT CARD ALREADY Attempted to activate/recharge a Gift Card
SWIPED that is already in the transaction.
Attempted to perform safe drop using
E1294 |NO MOP CONFIGURED | (yriieR MOP] key, but there are no MOPs
FOR SAFE DROP X
configured to allow safe drop.
Attempted to use a menu assigned to
E1295 | MENU NOT DEFINED softkey, but menu is not defined in Menu
File.
E1296 X . .
NO MULTIPLE PPG DISC | Only one price per gallon discount is allowed
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per sale.

FUNC NOT VALID AFTER

Attempted to enter disallowed functions
after a loyalty card has been swiped
(assuming a discount is given). For example,

CORRECTED

E1297 void line or error correct are not allowed
LOYALTY after a loyalty packet has been sent. You
must either void the ticket or complete the
sale.
E1298 INVALID SAFE DROP Entered an invalid number when prompted
TICKET NUMBER for the original safe drop ticket number.
Attempted a safe drop correction on a safe
E1300 SAFE DROP ALREADY drop that has already been corrected. Only

one correction is allowed.

Attempted to stop printing the Close Yearly
E2001 ABORT PRINTING NOT report. Printing this report cannot be
ALLOWED
aborted.
The Print Cashier Report function has been
E2002 NO CASHIER REPORT selected and there is no data to print.
AVAILABLE ;
Choose another report or function.
Attempted to close or print a period report
£2003 NOT AVAILABLE ON THIS | or a flash report from a workstation
REGISTER terminal. These reports can be printed only
from a controller terminal.
One of the following operations was
E2004 | INVALID INPUT performed:
e Aninvalid cashier number was
entered or an invalid key was
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pressed when trying to close a
cashier.

e An invalid number was entered to
list the PLU or department data.

« Aninvalid choice was entered
when prompted to print a current
or close a Payroll Report.

e An invalid cashier number was
input for the Payroll Report. Enter
the correct information.

E2005

CASHIER NOT OPEN

Attempted to run the Close Cashier Totals
function in Reports mode and the specified
cashier has not logged in.

E2006

INVALID EMPLOYEE
NUMBER

Logged in with an invalid ID and attempted
to use the Close Cashier functions. Re-enter
the correct number.

E2007

INVALID CASHIER
REPORT AMOUNT

Entered 0.00 for an MOP amount when
printing a Cashier Report and the “Allow
$0.00 Entry” parameter is set to ‘N’ in the
MOP File. Re-enter the information.

E2008

NO REPORTS AVAILABLE

The selected period report has not been
closed yet. Run the close period report first.
This occurs in the Print Shift, Daily, and
Monthly report functions in Reports mode.

E2009

ACCESS DENIED

Attempted to print a report or close a period
with a security level lower than that set in
Manager > Security Control > Report
Functions. Get a password from the
Verifone Technical Support Center.

E2010

UNABLE TO OPEN TANK
MONITOR PORT

Selected the Tank Monitor Report for
printing but the appropriate COM port could
not be opened. Check for loose connections
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in the back of the POS.

E2011

NO RESPONSE FROM
TANK MONITOR

Selected Tank Monitor Report for printing
but the POS did not receive a response from
the TLS. A servicer should check the
communications between the TLS and the
server.

E2012

ERR CLSING MO PRD

The period could not be closed on the money
order device. See the money order terminal
documentation for instructions.

E2014

DUE SALES PENDING

The AEOD begins with due sales on the
register and “Wait for no due sales” is
enabled.

E2015

FUEL PUMPS NOT IDLE

The AEOD begins with fuel pumps in use and
“Fuel idle wait time (minutes)” is not equal
to zero.

When the password was changed either no
E3001 PASSWORD NOT password was entered or the original
CHANGED password was entered incorrectly. Correctly
enter the information.
E3003 | RECORD ALREADY EXISTS Attempted to add a new record to a file and
the record already exists.
In the Manager mode, an incorrect key was
E3004 |INVALID INPUT pressed or value entered. Enter the correct
value or press the correct key.
E3005 | ACCESS DENIED Attempted to enter the System Config
function but did not have the proper
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security level.

E3006

BAD RECORD NUMBER

The selected record number does not exist.
Choose another record number.

E3007

BAD WRITE TO FILE

The file record could not be changed.
Review the site’s procedures or consult with
the servicer.

E3008

BAD DELETE

The file record could not be deleted. Review
the site’s procedures or consult with the
servicer.

E3009

BAD ADD

A new file record could not be added.
Review the site’s procedures or consult with
the servicer.

E3010

NOT ALLOWED TO
MODIFY

Attempted to modify a file record that
cannot be changed. The record is for display
purposes only.

E3011

ERROR CANCELING
PRINTER JOBS

The Flush Printer Queue function was chosen
and the specified printer could not be
cancelled. Check for loose connections in
the back of the POS.

E3012

IOCFG.DAT NOT FOUND

The Display 1/0 Configuration, File
Information, or Version Information function
was chosen and the I0Cfg.dat file could not
be found. Have the servicer investigate this
error.

E3013

INVALID FILE NUMBER

An invalid file number was specified when in
the Create Files function. Specify the
correct file number.

E3014

CREATION FAILED

Attempted to recreate a file using the
Create Files function and the file could not
be recreated. Check the procedure and
follow correctly.
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<printer name> ENABLE
FAILED

Messages and Troubleshooting

The Enable Printer function was chosen and
the printer could not be enabled. Check the
printer and connections in the back of the
POS.

E3016

<printer name> DISABLE
FAILED

The Enable Printer function was chosen and
the printer could not be disabled. Check the
printer and connections in the back of the
POS.

E3017

DEVICE NOT AVAILABLE

The file system device chosen in the Start
Debugger function is not available. Check for
loose connections in the back of the POS.

E3018

NON-COMPATIBLE LDM

Attempted to start a load module and the
LDM file specified was not compatible with
other LDMs in the system. This message also
displays when either the Start Debugger or
Execute Load Module function is chosen. The
servicer should investigate.

E3019

READ-ONLY FILE SYSTEM

Attempted to start a load module and the
medium that holds the LDM file is read-only.

E3022

OUT OF MEMORY

Attempted to start a load module and the
medium that holds the LDM file does not
have enough memory. If this continues to
happen call the servicer.

E3023

RESOURCE IS BUSY

Attempted to start a load module that is
already in use.

E3024

NOT ENOUGH MEMORY

Attempted to start a load module and the
medium that holds the LDM file does not
have enough memory. If this continues to
happen call the servicer.

E3025

CHECKSUM ERROR

Attempted to start a load module and a
checksum test fails. The servicer should
investigate.
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Attempted to start a load module and its
E3026 |INVALID LDM HEADER header is invalid. The servicer should
investigate.
O LoMD woDuLEs | AUETRLEG 9 rt s oad madie e
E3027 |FOUND ON THIS FILE P . . . y
LDMs. The servicer should investigate and
SYSTEM : .
reinstall the application, if necessary.
Attempted to start a load module but it
E3028 |FILE NOT FOUND cannot be found on the medium specified.
The servicer should investigate.
ok s Attempted to start a load module and an
E3029 Fa1led!j*5 rror Number unknown error was encountered. The
<error #> . . .
servicer should investigate.
The Reset Soft Key File function was chosen
£3030 SOFT KEY FILE RESET and the soft key file could not be reset. Try
ERROR the action again. If this continues to happen
call the servicer.
The Reset Modem function could not be
reset. Check for loose connections on the
E3032 | MODEM RESET FAILED back of the POS. Call the servicer if
connections are good.
The car wash parameters have not been set
£3033 ERROR IN CARWASH up correctly and the Discount Type prompt
SETUP displays in the PLU Promotion File function.
Check the car wash parameters.
E3037 | INVALID KEY PRESS The original Cprintf file ;oulq not pe
accessed. Have the servicer investigate.
The Copy Cprintf File function was chosen
E3048 COULD NOT COPY ALL OF and the entire file could not be copied. Have
THE FILE A .
the servicer investigate.
E3049 The Copy Cprintf File function was chosen
COULD NOT OPEN but the destination file could not be opened.
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CPRINTF FILE COPY Have the servicer investigate.
Attempted to set up a menu soft key but no
E3050 NO MENUS HAVE BEEN menus are defined. Set up menus in the
DEFINED X .
Menu File function.
Attempted to perform an action that is
E3051 NOT AVAILABLE ON THIS allowed only on the controller. Move to a
REGISTER . .
controller station to perform the action.
£3052 ITEM ALREADY EXISTS IN | The PLU entered has already been assigned
ANOTHER MIX. to a mix. Enter another PLU.

E5001

INVALID INPUT

Entered an invalid value. Wait for the
prompt to clear and enter the correct
information.

E5002

INVALID DCR NUMBER

Attempted to disable or download to a DCR
and entered an invalid DCR number. Enter
the correct value between 1 and 32.

E5003

NO PUMPS DEFINED

Attempted to set up dispenser hoses before
the pumps were set up. Set up the pumps
and then set up the dispenser hoses.

E5004

ERROR PRODUCT INIT

The Tokheim dispenser could not be
initialized. Servicer should investigate.

E5005

ERROR GRADE INIT

The dispenser’s grade configuration could
not be performed. Dresser/Wayne dispensers,
only. The servicer should investigate a setup
problem.

E5006

ERROR BLEND INIT

The dispenser’s blend configuration could
not be performed. Allied and Gilbarco
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dispensers only. The servicer should
investigate a setup problem

FPD ERROR <variable

A Fuel Price Sign Controller error (described
in <variable text>) has occurred. The error

ES007 text> may relate to the controller or an individual
sign.

E5008 | FPD SIGN OFFLINE Fuel Price Sign Controller is not responding.
Communications between the server and the
Fuel Price Sign Controller are working, but

E5009 |FPD POLL ERROR the Fuel Price Sign Controller indicates that

a sign position is offline. There is a problem
with a particular sign or signs.

E4003

INVALID CAR WASH
DEPARTMENT

A car wash department in the Car Wash
function has been specified and the number
entered has no department setup. Check the
department number and re-enter the
information.

E4004

INVALID DAY

Displays if the system call to gmtime returns
an invalid day. Have the servicer
investigate.

E4005
Either
may
appear

INVALID INPUT

Entered an invalid value. Wait for the
prompt to clear and enter the correct
information.

ERROR DISABLING CAR
WASH

An attempt was made to disable the car
wash but was unsuccessful. Check the
connections. Call the servicer if the
connections are good.
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ERROR ENABLING CAR
WASH
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An attempt was made to enable the car
wash but was unsuccessful. Check the
connections. Call the servicer if the
connections are good.

E4007

PLU ALREADY USED

Attempted to assign a PLU to a car wash but
it has already been assigned. Assign another
PLU.

E4008

NO OPEN PLUS ALLOWED

Attempted to assign an open PLU to a car
wash. This is not allowed. Assign another
PLU.

E4009

UNABLE TO READ CAR
WASH FILE

Attempted to assign a PLU to a car wash but
the car wash key file cannot be read. Have
the servicer investigate.

E4010

ONLY CAR WASH ITEMS
ALLOWED

Attempted to assign a PLU to a car wash
when the PLU has not been assigned to a car
wash department. Assign the PLU to a car
wash department then assign the PLU to a
car wash.

E4011

C/W PORT CONFLICT

Alarm Line Only: Another device has been
assigned to the car wash port. Check for
correct port assignments.

E4012

CAR WASH
COMMUNICATION ERROR

Alarm Line Only: The POS was unable to
communicate with the car wash device. The
servicer should investigate.

E6001

RECORD ALREADY EXISTS

Attempted to add a new record to a file and
the record already exists.
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E6002 | BAD RECORD NUMBER The record number selected does not exist.
Try another record number.
The file record could not be changed.
E6003 | BAD WRITE TO FILE Review the site’s procedures or consult with
the servicer.
The file record could not be deleted. Review
E6004 | BAD DELETE the site’s procedures or consult with the
servicer.
The new file record could not be added.
E6005 |BAD ADD Review the site’s procedures or consult with
the servicer.
HIDDEN INFORMATION 1S
6006 NOT SET UP PRESS [EXIT]| Security does not allow access. Call the
AND CALL THE HELP Verifone Technical Support Center.
DESK
Attempted to change the merchant ID,
E6007 MUST END DAY BEFORE | batch, or sequence number and a batch was
CHANGING FILE open. Perform a Close Daily then make the
changes.
E6008 NOT AVAILABLE ON THIS | Attempted to access a field that cannot be
REGISTER changed on this POS.
Communication with the host has been lost
after good initial connection. Check
E6009 | COMM FAILED conpeci.:lons. and make sure that no other
device is using the same phone line. If
problems continue, have the servicer
investigate the error.
Modem is not responding. Check the
E6010 | MODEM ERROR connections. If they are good, have the
servicer investigate the error.
E6011 | NO COMM WITH HOST No carrier was detected within the required
amount of time. Try again later. If the
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problems continue, have the servicer
investigate the error.

E6012

NO DIAL TONE

Phone line voltage detected but no dial
tone. Check the phone connection or have
the servicer investigate the error.

E6013

WAIT LINE BUSY

Host phone number received a busy signal.
Wait and try again. Check the phone
connection or have the servicer investigate
the error.

E6014

NO ANSWER

Host phone number rang but host did not
answer. Check the phone connection or have
the servicer investigate the error.

E6015

LINE UNAVAILABLE

No phone line voltage detected. Check the
phone connection or have the servicer
investigate the error.

E6016

NO COMM DSR

No DSR signal detected from VSAT device.
Check the cable connections or have the
servicer investigate the error.

E6017

NO MODEM

No DSR from modem device. Have the
servicer investigate the error.

E6018

MODEM RESET FAILURE

Modem failure during reset sequence. Have
the servicer investigate the error.

E6019

MODEM NOT RESET

Modem did not reset. Have the servicer
investigate the error
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E6701

MTEC COMMS ERROR

The POS could not communicate with the
Mannatec device. Check the connections. If
they are good, have the servicer investigate
the error.

E6702

MODEM ERROR

The Mannatec modem is not responding.
Check the connections. If they are good,
have the servicer investigate the error.

E6703

NO COMM WITH HOST

No carrier was detected within the required
amount of time. Try again later. If the
problems continue, have the servicer
investigate the error.

E6704

NO DIAL TONE

The Mannatec modem did not detect a dial
tone. Check the phone connection or have
the servicer investigate the error.

E6705

WAIT LINE BUSY

The Mannatec modem line is busy. Wait and
try again. Check the phone connection or
have the servicer investigate the error.

E6706

NO ANSWER

The Mannatec network did not answer the
phone. Check the phone connection or have
the servicer investigate the error.

E6707

LINE UNAVAILABLE

The Mannatec modem could not detect the
phone line. Check the phone connection or
have the servicer investigate the error.

E6708

MODEM RESET FAILED

The Mannatec modem could not be reset.
Have the servicer investigate the error.

E6709

MODEM NOT RESET

The Mannatec modem was not reset. Have
the servicer investigate the error.

E6710

UNKNOWN NTWRK
RESPONSE

The Mannatec device is returning an
unrecognized error or response. Have the
proprietary card provider investigate the
error.
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E6711 PIN TRIES EXCEEDED The number of PIN tries has been exceeded.

E6712 REJECT Transaction was rejected.

The odometer reading was invalid. Enter the

E6713 ODOMETER INVALID .
correct odometer reading.

E6714 DRIVER ID INVALID A driver’s ID was determined to be invalid.
E6715 VEHICLE ID INVALID A vehicle’s ID was determined to be invalid.
E6716 INVALID USER ID - PLEASE | The netwqu returned a user ID error. The
RETRY customer is allowed to re-enter the user ID.
E6717 LICENSE INVALID The license was determined to be invalid.

The job number was determined to be

E6718 JOB NUMBER INVALID . .
invalid.

Misc data entry was determined to be

E6719 DATA INVALID . )
invalid.

The department number was determined to

E6720 DEPARTMENT INVALID . )
be invalid.

E6721 USER ID TRIES EXCEEDED The number of user ID tries has been

exceeded.
E6722 INVALID PRODUCT FOR The customer tried to purchase a restricted
CARD TYPE item.

CHECK <printer name> At startup, the POS could not access the specified
E7001 PRINTER DISABLE printer. Check for loose connections on the back
PRINTER? (Y/N) of the POS.
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<printer name> PRINTER | At startup, the POS could not access the specified
E7002 | BLOCKED DISABLE printer. Check for loose connections on the back
PRINTER? (Y/N) of the POS.
At startup, the POS detected that a printer was
£7003 PRINTER MECH FAILURE | experiencing a mechanical failure. Have the
DISABLE PRINTER? (Y/N) |servicer investigate the error. If this stops sales
from being run, see “Troubleshooting.”
At startup, the POS could not communicate with
the specified printer. Check the connections. If
E7004 PRINTER COMMS ERROR they are good, have the servicer investigate the
DISABLE PRINTER? (Y/N) : .
error. If this stops sales from being run, see
“Troubleshooting.”
The printer is not available. Check the
connections. Make certain that the correct printer
E7005 | PRINTER UNAVAILABLE was installed in the software. Call your servicer if
the problem cannot be corrected. If this stops
sales from being run, see “Troubleshooting.”
E7006 | INVALID INPUT An invalid value was entered. Wait for the prompt
to clear then enter the correct information.
Journal Only: Prints when an item is sold and the
E7007 PLU TOT FILE FULL - PLU total file does not have room to store the
RECORD LOST information. Close the current period. This makes
room in the PLU File.
Journal Only: Printed when an item is sold and
) the department total file no longer has room to
E7008 EEEJSJ L%I‘.-SE' FULL store the information about the sale of the item.
Close the current period. This makes room in the
department file.
Journal Only: Printed when an item is sold and
) the category total file no longer has room to store
E7009 CAT TOT FILE FULL the information about the sale of the item. Close
RECORD LOST . . .
the current period. This makes room in the
category file.
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Journal Only: Printed when an item is sold using
price override, PLU not found, or is not scannable
£7010 PLU EXCEPT FILE FULL - |and the PLU exception file no longer has room to
RECORD LOST store the information about the sale of the item.
Close the current period. This makes room in the
PLU exception file.
The safe drop prints on the journal, but cannot be
E7011 SAFE DROP FILE FULL - saved because it exceeds the maximum safe drops
RECORD LOST that can be stored. To make room, close the
current period.
User does not have a high enough security level to
E7012 | ACCESS DENIED access a menu item or a Verifone password is
needed. Have someone with a higher security
level access these menu items.
A security level that is less than 0 or greater than
E7013 | INVALID SECURITY LEVEL |9 was entered. Wait for the prompt to clear then
enter the proper security level.
The controller was trying to download a file to a
LAN COMMS ERROR .
workstation and the LAN cable was not
E7014 BH(Z i;ing DOWNLD connected. Check for loose connections on the
back of the POS.
. An error occurred downloading a file from the
7020 ﬁilTétEeTsoatDeé\/[\/YI\lle] : file controller to the workstation. Check the journal
name> for more detail and see the site’s procedures for
handling this situation.
E'?‘IYENDLE;[Z[E;;Q@ The controller was trying to download a file to a
E7021 DOESNT EXIST SALES workstation and the file could not be found. See
ABORTED the site’s procedures for handling this situation.
E7024 | INVALID INPUT Entered an invalid date or time. Enter the
information in the proper format.
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. _¢1. | Attempted to create a file using the Create Files
E7025 FAEEXEREATE ERROR: <file function and the file could not be created. See
the site’s procedures for handling this situation.
A number less than 1 or greater than 12 was
E7026 |BAD MONTH entered for a month. Enter the correct
information.
E7027 |BAD YEAR An invalid year was entered. Re-key the year.
A number less than 1 or greater than the
E7028 | BAD DAY maximum for the specified month (and year for
leap years) was entered for a day. Enter the
correct information.
A number less than 0 or greater than 59 was
E7029 | BAD SECONDS entered for seconds. Enter the correct
information.
A number less than 0 or greater than 59 was
E7030 | BAD MINUTES entered for minutes. Enter the correct
information.
A number less than 0 or greater than 23 was
E7031 BAD HOUR entered for hours. Enter the correct information.
Alarm Line Only: The Backup Print Log function
was chosen. This alarm displays until the
E7032 | HLP DSK UPLD CPRNT Cprintf.bak file is removed from the system by
the Verifone Technical Support Center.
CRT ERR <return At startup, one of the ‘.dat’ files could not be
E7033 |code>,<error code>:<file |opened. See the site’s procedures for handling
media>/<file name> this situation.
Entered a number for the maximum number of
E7035 NEEDS TO BE HIGHER saved transactions that was lower than the
THAN #PENDING maximum number of pending transactions. Enter
the correct information.
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NEEDS TO BE LOWER
THAN #SAVED

Messages and Troubleshooting

The number entered was greater than the
maximum number of pending or saved
transactions. Re-enter the information.

E7037

VALUE BETWEEN 1 AND 50

A number less than 1 or greater than 50 was
entered for either the number of saved or the
number of pending transactions. Enter the proper
value.

E7040

M. O. CHECKS LOW

Alarm Line Only: The printer is running out of
money order checks and needs to be reloaded
soon. The appearance of this message is set with
the “Money Order Low check Limit” parameter in
Manager > Configuration > Sales Configuration.
Refill the printer with money order checks.

E7041

M. O. COMM ERROR

Alarm Line Only: Communications have been lost
between the POS and the money order terminals.
Check connections between the two devices. This
message clears when communication is re-
established and a money order transaction is
successfully sent to the terminal.

E7042

MONEY ORDER AMOUNT
TOO LARGE

A money order was sold for more than is allowed
by the money order terminal. Change the
maximum money order amount or sell two
separate money orders totalling the necessary
amount.

E7043

TLS COMMS ERROR

Alarm Line Only: The POS cannot establish
communications with the TLS controller. Have the
servicer investigate the error.

E7044

TLS PORT ERROR

Alarm Line Only: A problem occurred opening the
TLS COM port. Have the servicer investigate the
error.

E7045

ERROR TANK INVENT

Alarm Line Only: The POS was unable to receive
inventory data from the TLS controller. Have the
servicer investigate the error.
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E7047 | INVALID TAG VERSION Keyfob version is not compatible with software.
£7048 CANNOT PASSWORD User has attempted to password a tag that is not
PROTECT THIS TAG activated for payment.
7049 CANNOT DEACTIVATE User has presented a Dealer tag to the deactivate
DEALER TAG function on the POS and this is not permitted.
User attempted to configure a PLU that does not
E7050 | PLUNOT FOUND exist for one of the CRM programs.
E7052 NEGATIVE DEPARTMENT | User attempted to configure a negative
NOT ALLOWED department for loyalty.
E7053 PLU CANNOT ALSO BE IN A| CRM programs do not operate with PLU items also
MIX configured for Mix ‘n Match.
E7054 PLU CANNOT ALSO BE IN A| CRM programs do not operate with PLU items also
COMBO configured for combo.
E7055 PLU ALREADY A PART OF | User has to enter a single PLU number more than
EPC once in the EPC configuration file.
E7056 | DEPARTMENT NOT FOUND User has attempted to configure an invalid
department for the Loyalty program.
E7057 DEPARTMENT ALREADY User has attempted to configure the same
PART OF LOYALTY department more than once in the Loyalty file.
Alarm Line Only: A TLS connected to the POS
E7059 | TANK n LOW PRODUCT indicates that tank has gone below the low-fuel
limit.
E7060 | TANK DELIVERY Alarm Line iny: TLS has detected that a delivery
is being received by the tank.
Alarm Line Only: An error occurred during an
E7061 ERROR TANK CLEAR attempt to clear the status of a tank.
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E7062

VALUE BETWEEN 2 AND 50

Applies to the number of saved transactions.

ES001 | NO BATCH AVAILABLE Attempted to print a batch detail report and
there are no batches to print.
E8002 INVALID RESTRIC. CODE! Entered an invalid Voyager restriction code. Enter
TRY AGAIN a valid code.

The sale amount is greater than the amount
allowed for the credit transaction. Override the

E8003 m;%%tg\:\lprlﬁfucg?s /(I:\IR;EDIT error. A split tender transaction can be set up with

) part of the amount paid with a different tender

type.

E8004 PRODUCT NOT ALLOWED An item purchased is not allowed by the credit

WITH THIS CARD card. Use an alternate MOP.

The customer has unsuccessfully entered PIN data

E8005 |NUMBER OF TRIES EXCEEDED|more than the number of times allowed. Have the
customer select another MOP or credit card.

E8006 |ODOMETER INVALID The Qdometer reading for a Donlen card was
invalid. Enter the correct odometer reading.
An invalid credit card expiration date has been

E8007 |BAD DATE entered. Enter the expiration date information in a
four-digit format (mmyy).

ES010  IINVALID DATE An invaligi dgte was entered. Enter date
information in the proper format.

ES011  IINVALID BATCH NUMBER An invalid batch number was entered. Enter a
number between 1 and 99.
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Less than 13 digits were entered for a credit card
number when doing manual credit. Enter the
correct card number.

E8012 |ACCOUNT NUMBER ERROR

Errors E8013 through E8030 may be followed by one of the following messages. TOTAL
TOO LARGE, OR NEGATIVE FUEL AMT TOO LARGE, OR NEGATIVE NON_FUEL AMT TOO
LARGE, OR NEGATIVE INVALID PRODUCT FOR CARD TYPE MISSING AUTH CODE REJECT
DUPLICATE TRANSACTION DO NOT ACCEPT

TERMINAL DISABLED (See  [The terminal is not allowed on the network. Have

E8013 messages above) the servicer investigate the error.

BAD CARD - <auth. code>
E8014 |(See messages before
E8013)

The credit card was denied. Use another MOP or
credit card.

INVALID CARD - <auth.
E8015 |code> (See messages before
E8013)

The account or credit card was invalid. Use
another MOP or credit card.

EXP CARD - <auth. code>

E8016 |(See messages before The credit card has expired. Use another MOP or

credit card.

E8013)

INVALID DATA - <auth. The data the POS sent to the network had a format
E8017 |code> (See messages before lerror and could not be reconciled. Have the

E8013) servicer investigate the error.

DUPLICATE TRANSACTION - [The POS has sent two authorization requests for
E8018 |<auth. code> (See messages [the same transaction. Have the servicer
before E8013) investigate the error.

HOST UNAVAILABLE - <auth.
E8019 |code> (See messages before
E8013)

The POS cannot establish communications with the
network. Try the connection again at a later time.

NO RESPONSE FROM HOST - [The POS has successfully connected to the network
E8020 |<auth. code> (See messages |put did not receive a response for its request. See
before E8013) the site’s procedures for handling this situation.
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HOST FAIL - <auth. code> [The network indicates that it is down and unable
E8021 |(See messages before to process the POS request. See the site’s
E8013) procedures for handling this situation.
PHONE LINE DOWN - <auth. The POS cannot detect a phone connection. See
E8022 |code> (See messages before oy . . ;
the site’s procedures for handling this situation.
E8013)
DISCONNECT - <auth. code> [The POS detects that the network terminated the
E8023 |(See messages before connection. See site’s procedures for handling this
E£8013) situation.
HOST COMM DENIED - <auth.|The POS detected a network communication
E8024 |code> (See messages before [failure. See the site’s procedures for handling this
E8013) situation.
TOTAL OVER LIMIT - <auth. The transaction exceeds the card's credit limit.
E8025 |code> (See messages before .
Choose another MOP or credit card.
E8013)
The POS has detected one of the following
conditions:
DEBIT NETWORK A debit card network error
E8026 UNAVAILABLE - <auth. An inquiry balance not available
code> (See messages before
F8013) An unexpected interchange response
See the site’s procedures for handling these
situations.
E8027 DRIVER ID INVALID (See A driver’s ID was determined to be invalid.
messages before E8013)
INV VEHICLE (See messages 1y . . .
E8028 before E8013) A vehicle’s ID was determined to be invalid.
E8029 |PIN ERROR - PLEASE RETRY |DCR message: Displayed when the network returns
(See messages before a PIN encryption error. The customer must re-
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E8013) enter the PIN.
PIN ERROR <handling code> |A DCR message displayed on the POS when the
(See messages before network returns a PIN encryption error. The
E£8013) customer must re-enter the PIN.
TRANSACTION DENIED - The transaction is denied for a reason other than
E8030 |<auth. code> (See messages [those described in the previous error messages
before E8013) above. See procedures for handling this situation.
The customer tried to purchase nonfuel products
E8031 gégglf‘gl:sows ONLY FUEL with a credit card that allows fuel purchases only.
Ask the customer for another MOP.
The approval number entered for a voice
E8032 INVALID WEX APPROVAL authorization is not valid. Re-enter the approval
NUMBER . e
number in a six-digit format.
The customer tried to purchase an item that is not
E8036 INVALID PRODUCT OR CARD fallowed by the credit card being used or incorrect
INFO entered data was entered (vehicle number, driver
ID, odometer, etc.).
The customer tried to purchase more than three
E8037 Eﬁ\‘/ﬁ? HAS THREE PRODUCT products with a credit card that allows purchase of
only three.
The customer tried to purchase more than one fuel
CARD HAS ONE FUEL X )
E8038 PRODUCT LIMIT product with a credit card that allows the
purchase of only one.
The customer tried to purchase more than two
E8039 CARD HAS TWO PRODUCT products with a credit card that allows the
LIMIT PLUS TAX
purchase of only two.
The customer tried to purchase more than two fuel
CARD HAS TWO FUEL . )
E8040 PRODUCT LIMIT products with a credit card that allows the
purchase of only two.
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E8041

CARD HAS FOUR PRODUCT
LIMIT

The customer tried to purchase more than four
products with a credit card that allows the
purchase of only four.

E8042

DATA ERROR <auth code>

The data the POS sent to the network had a format
error that could not be reconciled. Have the
servicer investigate the error.

E8043

LIMIT REJCT <auth code>

The network denied the transaction because the
amount or products exceeds the card’s limits. Ask
the customer for another MOP.

E8044

INV ACCOUNT <auth. code>

The network returns a response that the account
or card is invalid. Ask the customer for another
MOP.

E8045

INV FUEL TYPE

The customer tried to purchase a fuel type that
was not allowed by the credit card being used. Ask
the customer for another MOP.

E8046

FLT NO AUTH <auth. code>

The customer tried to purchase a non-fuel product
that is not allowed by the credit card being used
(Fleet card). Ask the customer for another MOP.

E8047

INVALID PIN - PLEASE RETRY

DCR message: The network returned a PIN error.
The customer is allowed to re-enter the PIN.

PIN REJECT <auth code>

A DCR message displayed on the POS when the
network returns a PIN error. The customer must
re-enter the PIN.

E8048

INV FLEET FUNC

The customer tried to perform a fleet function not
allowed by the card being used. Ask the customer
for another MOP.

E8049

INV PRODUCT <auth code>

The network rejected the card because the
product cannot be purchased with this credit card.

E8050

INDOOR PAYMENT

The customer must pay inside.
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An unrecognized response was received from the
E8051 |HOST ERROR network. See the site’s procedures for handling
this situation.
The DCR system is unable to process the
E8052  INETWORK REJECT transaction. Ask the customer for another MOP.
E8053 |BK CD RJCT <auth. code> The network rejected the credit card. Ask the
customer for another MOP.
E8054 |RETRIES XCDED The customgr has unsuccessfully tried to enter PIN
data more times than allowed.
E8055 INVALID USER ID - PLEASE The customer has tried to enter an invalid user ID.
RETRY
E8056 INVALID USER ID - TRIES The customer has unsuccessfully tried to enter
EXCEEDED user ID data more times than allowed.
E8057 |INV DRIVER The driver’s ID was invalid.
E8058 |FREQUENT USER Demgl QUe to credit card velocity security
restrictions.
E8059 |CARD ENTRY ABORTED f:ard entry or expiration date entry was
interrupted. Retry.
Customer attempted to purchase a fuel type not
E8060 |INVALID FUEL SELECTED allowed on the credit card. Ask the customer for
another MOP.
Customer attempted to use a card that had an
E8061 |CHARGE TO INVALID invalid or empty value at the “ENTER CHARGE TO”
prompt on the PINpad.
PRE-AUTH NOT ALLOWED .
E8062 FOR EBT CARDS Cannot pre-authorize EBT cards.
E8063 .
SEQUENCE NUMBER MUST BE|A manually entered EBT card sequence number is
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3 DIGITS not valid.
E8064 |EBT UNAVAILABLE Network is unable to get authorization from EBT
host. Retry.
UNABLE TO READ CHECK A check was sent through the Magnetic Ink
E8065 |[<ENTER> TO TRY AGAIN; Character Recognition reader, but the POS was
<EXIT> TO CANCEL unable to obtain the information from the reader.
E8066 IUNABLE TO PROCESS CHECK Two additional attempts to' process the check
through the reader have failed.
E8067 CHECK AUTHORIZATION Network is unable to get authorization from the
UNAVAILABLE check vendor.
The check is not accepted because the customer
E8068 |DECLINED VELOCITY has written too many checks in the designated
time period.
E8069 MUST SETUP EBT MERCHANT |Attempted to use EBT before entering a valid
ID FIRST eight-digit EBT Merchant ID.
E8070 |HUB INVALID Hubometer entry is invalid for this fleet card.
E8071 ([TRAILER ID INVALID Trailer ID is invalid for this fleet card.

Alarm Line Only: The POS printer is offline.

E9001 PRINTER OFFLINE Check the connections or press the online button
on the printer to correct.
Alarm Line Only: The POS and the printer are not
E9002 | PRINTER COMMS ERR connected. Check connections on the back of the

POS and the printer.
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E9003

PRINTER COVER OPEN

Alarm Line Only: The printer cover is open. Close
the printer cover to resume operation.

E9004

PRINTER MECH FAIL

Alarm Line Only: The printer has experienced a
mechanical failure. Call the servicer. See
“Troubleshooting,” if this prohibits sales.

E9005

DUP STATION ID <dup.
station ID>

Alarm Line Only: The LAN has detected more
than one POS with the same station ID on the
LAN. Call the servicer to investigate.

E9006

LAN IO CONFIG ERR

Alarm Line Only: The LAN LDM could not access
the locfg.dat. See the site’s procedures for
handling this situation.

E9007

LAN DRVR ERR (<error #>)

Alarm Line Only: The LAN device driver could not
be opened. Have the servicer investigate the
error.

E9008

LAN <device name> ERR
(<error #>)

Alarm Line Only: The LAN device driver could not
be opened. Have the servicer investigate the
error.

E9009

NO SYS KEY FOUND

Alarm Line Only: The application’s version
number could not be extracted from the
Appcfg.dat file.

E9010

LAN COMMS ERROR

Alarm Line Only: The workstation and controller
could not communicate. Check LAN connections
or one of the POS may be down.

E9011

LAN COMMS BLOCKED

Alarm Line Only: LAN communications are
blocked. Have the servicer investigate the error.

E9012

TERM %d LAN BLCKD

Alarm Line Only: LAN communications are
blocked. Have the servicer investigate the error.

E9013

<printer name> DISABLED

Alarm Line Only: The named printer has been
disabled.
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) Alarm Line Only: The named printer is blocked.
E9014 | <printer name> BLOCKED Check the position of the paper rolls.
. Alarm Line Only: The amount of paper in the
E9015 Egcvnter name> PAPER named printer is low. Refill the paper in the
named printer.
E9016 | RECEIPT UNAUTH The pn:nter cqnnected to the POS is not an
authorized printer.
The TCP interface on the register or server failed
E9018 | TCP ERROR to start. Call the Verifone Technical Support
Center.
03 DO NOT ACCEPT The POS received a deplal return code f.rom the
network when processing a Donlen credit card.
Troubleshooting

This section contains general situations that may occur and the steps to take to
change them.
In some cases, the manager may need to perform procedures restricted to certain
security levels.
Troubleshooting procedures are divided by function.

o« Car Wash
o Fuel Sales

o Installation Information

e Printer
e Product Sales
o Workstation

Car Wash

Code Does Not Print

If a car wash code does not print on the receipt and the “CAR WASH CODE
UNAVAILABLE” message was not displayed, check the following items:

The car wash department number is set up in the Department Setup function
in Car Wash Manager mode.
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The car wash item is set up in the Car Wash Key Setup function in Car Wash
Manager mode.

Fuel Sales
Cannot Clear a Fuel Sale

If a fuel sale cannot be cleared from the POS, check the status of the pump using the
[VIEW] key. If the pump status is “HOLD,” then the sale may already be on the ticket,
or it may be on another POS at the site. If the sale cannot be found and removed
using standard transaction methods, call the Verifone Technical Support Center. The
representative can provide a one-time password to access the Clear Pumps on Hold
function in Fuel Manager mode.

Installation Information

Retrieving Installation Information

Troubleshooting the system may require contacting an agent at the Verifone
Technical Support Center who asks for the system’s installation information.
The Print Installation Information function lists:
Registration Information
Application Configuration
Software Configuration
Hardware Configuration
|70 Configurations

e System Upgrades since the original application was installed
Print Installation Information function appears in maintenance menu.

Printer

Printer Communication Errors

If the printer is not printing, is offline, or has lost communication with the POS, check
the following items:
e Make sure the printer is online.
For example, if the printer was recently opened to check or replace the
tape, put the printer back online by pressing the [ON LINE] or [Ready]
button.
e Make sure all cables between the POS and the printer are secure.
e If there is a multi-station printer, reset the printer.
1. Open the cover of the printer.
2. Locate the reset button inside, to the right. It is labeled “RESET.”
3. Press the reset button briefly with a pencil or pen.
4. Close the cover.
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5. Press [ON LINE].
e If there is an Epson TM-U950 printer, reset the printer.
1. Locate the black reset button on the back of the printer, located
on the blue connector.

2. Press and release the reset button.
3. Press [ON LINE].

Product Sales

PLU Not Found

The “PLU Not Found” message could occur in the following cases:
e After keying a number, pressed [ENTER] instead of pressing a department or
MOP. Press [ERROR CORR] to correct the entry.
e Keyed a PLU number that should exist but does not:
- If a PLU number is keyed incorrectly, key it again and press [ENTER].
- If a PLU number is valid but has not been defined in the POS, key the
price of the item and press [ENTER]. PLUs entered this way are reported
in the PLU Exception Report.
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Overview

Method of Payment (also known as "MOP") are used to complete transactions. Methods
of Payment identify the amount and type of payment to the system and based on that
payment type, allows the system to apply the appropriate MOP-specific rules and
restrictions.

As a result, MOP behavior on your system may vary due to its specific configuration
settings (minimum amounts, whether the amount must be entered, etc).

Using Methods of Payment
Examples of MOP include:

o Cash Payment

e Check Payment

e Credit Card Payment

+ Debit Card Payment

¢ In-House Payment

o Lottery Ticket Cash-In

o Lotto Ticket Cash-In

e Food Stamps Payment - Electronic

« Coupon Payment/Redemption (Standard)

e Coupon Payment/Redemption (Non Tax)

Drive Off
In general, completion of a transaction follows this process:
1. Press [TOTAL] (if required)

2. Key <amount> (if required)
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3. Key the appropriate MOP

4. If total amount tendered < amount due, system apples the payment,
recalculates the remaining amount due and displays to customer and
clerk

5. If total amount tendered >= amount due, system applies the payment,

completes the transaction and calculates any change that may be due
back to the customer

Cash Payment
1. Press [TOTAL] if required
2. Key <amount tendered> if required
3. Touch or press [CASH]

Note: Several quick keys may have been configured on your workstation to
save keystrokes when accepting CASH payment.

The quick keys include:

= Next Dollar: Assumes the next dollar amount (customer presents
$17 for a sale totaling $16.54)

= Exact Change: Assumes amount presented = amount due

= $1, $5, $10, $20, $50: Assumes customer presented the indicated
bill denomination

Check Payment
1. Press [TOTAL] if required
2. Key the face value of the check
3. Touch [CHECK]
Note: Change can only be given if the MOP is configured to allow change.
Credit Card Payment

1. Press [TOTAL] if required
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2. Touch or press [CREDIT]

3. Follow directions on the screen

4. On completion, present receipt for signature if prompted
Debit Card Payment

1. Press [TOTAL] if required

2. Touch or press [DEBIT]

3. If cashback is configured, additional prompts are displayed

4. Follow directions on the screen
In-House Payment

1. Press [TOTAL] if required

2. Touch or press [IN-HOUSE]

3. If a list of In-House accounts are displayed, select the appropriate In-
House account number from the list or enter the account number

Lottery Ticket Cash-In
1. Key the dollar amount of the winning ticket
2. Touch [LOTTERY]

Note: When configured for "Allow without Sale”, permits for cash in
without purchase.

Note: Typically used for cashing in winning scratch out tickets.
Lotto Ticket Cash-In
1. Key the dollar amount of the winning ticket
2. Touch [LOTTO]

Note: When configured for "Allow without Sale”, permits for cash in
without purchase.
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Note: Typically used for cashing in winning online tickets.

Food Stamps Payment - Electronic (EBT Food Stamps, EBT Cash
Benefits, Manual EBT CB)

Create EBT MOPs EBT_FS, EBT and Manual _EBT_CB using the inbuild EBT MOP
Codes. Refer to the Methods of Payment chapter in this manual for more
information.

1. Press [TOTAL]
2. Press [Credit]

After MOP entries are configured as EBT Food Stamp and/or EBT Cash Benefits,
pressing the Credit button allows a cashier to accept the EBT card without asking the
customer if they are using an EBT card. When the card is read by the PIN pad and
identified by the EPS, EPS reports back to the POS which MOP type it is (credit, debit,
EBT food stamp, EBT cash).

Follow the instructions on PIN pad to complete the transactions.
Considerations

e Used with EBT Cards and paper coupons that can be used only to purchase food
stamp eligible items. With paper coupons, a maximum of $.99 can be given back as
cash change. Any change tendered over $1 must be in Food Stamps change.

e EBT Cash Benefit allows purchase of non-food stamp eligible items.

e Food Stamps MOP must be entered after any discounts have been applied and
before any other MOP.

e Tax is not applied to the amount paid for by food stamps. The tax amount that
prints on the receipt displays the tax amount after the tax credit has been
deducted. The tax credit amount the customer did not have to pay also prints on
the receipt.

e If food stamps are tendered for less than the eligible amount and the food-stamp
items are taxable, a “Tax Credit” appears on the receipt. The credit is the
difference between the total tax due on the items and the tax charged on the
taxable items not paid for with food stamps. For example, if an amount of $16.17
is qualified for payment with food stamps, of which 10.55 is taxable at a tax rate
of 7%, then $0.74 tax is due on the $10.55. If the customer tenders $10.00 in food
stamps leaving a balance of $6.17, of which $0.55 is taxable. The Tax Credit is
$0.70 (7% of $10.00) and the tax the customer owes is $0.04 (7% of $0.55).
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Descr gty amount
MILE 2 .58 Non-taxable FS item
T HOT DG CMEO 3 5.97 Taxable FS item
T HAM/CHEESE 2 4.58 Taxable FS5 item
Sub Total 16.132
Sub Total FS 16.13
Tax 0.04 7% tax on 5$0.55
TOTAL 16.17 | mor=t a
FOOD STAMP S 10.00 FS tendered
JCRSH 5 7.00 Cash tendered
Tax Credit FS 0.70 7% tax on $10.00
Change § -0.83

Go to Tax Report from Flash Reports to get information on Taxable Sales and Non-Tax
Sales.

FiLASH
Shi ft REPORI
10/21/18 11:59:40 PM
STORE# AB123 REGISTER# 101 daypart# 001
CASHIER #01 CORPORATE
OPEN daypart 10/21/18 11:25:49 PM
CLOSE daypart PENDING

TAX REPORT

NAME TAX-RATE ACT-RATE
TAXABLE-SALES TAXES
NON-TAX SALES

TEST 25.000% 25.025%
9.99 2.50
8397
REFUND TAXES 0.00
SALES TAXES 2.50
[OTAL SALES TAX 2.50

From Verifone’s Site Report Navigator access the End of Day Report. This Report has
Tax Forgiven Amount section under Cash Controls and gives information on taxes that
were credited back due to EBT/Foodstamps/Non-tax Coupons.
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Cash Controls
Type Count Amount
Total MOP 10 $50.60
Tax Amount
TEST1(15.000) $0.60
TEST(25.000) $0.00
Total $0.60
Tax Exempt Amount
TEST1(15.000) $0.00
TEST(25.000) $8.50
Total $8.50
Tax Forgiven Amount
TEST1(15.000) $0.00
TEST(25.000) $3.00
Total $3.00
Over/Short - CASH
Total ECR $0.00

Coupon Payment/Redemption (Standard)
1. Press [TOTAL]

2. Scan the coupon or key the dollar amount of the coupon and touch
[COUPON]

Note: Coupons must be scanned only at the end of the transaction. Tax
due is not reduced because of applying this coupon.

Coupon Payment/Redemption (Non-Tax)

1. Press [TOTAL]

2. Scan the coupon or key the dollar amount of the coupon and touch
[COUPON]

Note: Coupons must be scanned only at the end of the transaction. Tax due
may be reduced because of applying this coupon.

Drive Off

—

. Select the unpaid fuel transaction
2. Press [TOTAL] if required
3. Touch [DRIVE OFF]

4. Write a description of the vehicle and any additional information on the
receipt and save it according to store policy

340



Commander Site Controller User Reference

Configuring Methods of Payment

Payment Management

Use Store Operations > Payment > MOP to configure MOPs.

wor =
[T peleta

Select MOP Name MOP Code
- o %0-chsr B
002 - CHECK, _ | Minimum Amount Maximum Amount
003 - CREDIT 2 oo1 0.00
004 - DEBIT
005 - MAN CRED Limit #Aaditional Receipts
006 - IN-HOUSE 0.00 o
007 - MAN DEBIT Tender Code Tender Sub Code
008 - FOODSTAMP R N
009 - LOTTERY generic generic
010 - DRIVE OFF — Options
011 - COUPON
012 - MOBILE "I Force Safe Drop Open Drawer On Sale
013 ) )
014 "I Tender Amount Required [¥] Cashier Report Prompt
015 [l Allow Zero Entry [C] Aliow Without Sale
0e [¥] Allow Refund Allow Change
g: ; V] Allow Safe Drop [ Atiow Money Order Purchase
019 "I Force Ticket Print
020 =

Name Enter the name of the MOP. This name appears on receipts

and reports.
Delete Click to delete the selected MOP.
MOP Code Select the MOP code that determines how the MOP should

function within the system. The MOP codes are predefined as
detailed below and may vary based on the network
configuration:

0 - Cash (The first MOP name that uses this code should be
Cash.)

1 - Credit: Use for credit cards sent through a credit card
network. In some reports, this MOP may appear as
“CHARGES” or by card name.

2 - Debit: Use for debit cards sent through a credit card
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network. Do not select the “Tender amount required”. In
reports, this MOP appears as a “DEBIT” item.

3 - Manual Credit: Use for credit cards not sent through a
credit card network. A voice authorization, imprinting, or
other procedure may be required to process the card. The
“Tender amount required” parameter should not be enabled.

4 - Manual Debit: Use for debit cards not sent through a
credit or debit card network. A voice authorization,
imprinting, or other procedure may be required to process
the card. The “Tender amount required” parameter should
not be enabled.

5 - Lotto: Use for winning lotto tickets tendered as MOPs.
6 - Check: Use for checks. If customers are not permitted to
write checks for more than the amount of purchase, do not

enable “Change allowed”.

7 - Tax_Coupon: Use for product coupons as MOPs. The
“Change allowed” parameter should not be enabled.

8 - §1 Cash (Automatically expects a one-dollar bill as
payment and calculates change based on that. The
applicable amount is expected for codes 9 through 12.)

9 - $5 Cash

10 - $10 Cash

11 - $20 Cash

12 - $50 Cash

13 - Food Stamp: Use for paper food stamps only. Amounts
must be entered as whole dollars for this MOP. The “Change
allowed” parameter should be enabled. The “Tender amount
required” parameter should be disabled.

14 - Drive Off: Use to set up an MOP for clearing fuel sales

for customers that drive off without paying for dispensed
fuel. The “Change allowed” parameter should be disabled.
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15 - Special Discount: A special discount works as an MOP.
This is a percentage based discount applied against PLUs and
department sales configured as Special Discount eligible. The
cashier determines when to apply it. The Dept File and PLU
File functions have “Special Discount [Y/N]” parameters
which enable the discount for specific departments or PLUs.
The “Special Discount (P)” parameter sets the percentage
rate of the discount. These amounts do not appear with
promotions in the “DISCOUNTS” item in the Summary Report.

16 - Manual FS: Electronic, non-paper food stamps. Amounts
for this MOP can be entered as dollars and cents. This is
usually used with food stamp transactions performed with a
standalone EBT terminal. The “Tender amount required”
parameter and the “Allowed without sale” parameter should
be disabled.

17 - Lottery: Use for scratch-off lottery tickets tendered as
MOPs.

18 - In-House: Store credit extended to local customers and
set up outside the network and the POS. The POS provides
receipts for transactions and reports sales on the Cashier and
Summary reports.

“Enter Account Number” displays when the [In House] key is
used for a transaction. An alpha-numeric account number,
up to ten digits, MUST be entered.

When the customer comes in to pay on the account, press
[Pay In], at which time you are prompted “House Account?
[Y/N].” Enter ‘Y’ and the prompt, “Enter Amount” displays.

After entering an amount and pressing [ENTER], the prompt,
“Enter House Acct#” displays.

19 - Pump Test: The Pump Test MOP closes out a sale where
the store pumps a test amount of fuel into a container and it
is rung up as a sale. When the fuel is returned to the tank,
the sale is actually treated as a No Sale. Pump Test MOP can
only be used on post-pay fuel sales.

20 - EBT Food Stamp: Electronic, non-paper food stamps.
Amounts for this MOP can be entered as dollars and cents.
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The “Tender amount required” parameter and the “Allowed
without sale” parameter should be disabled.

21 - EBT Cash Benefit: Electronic, non-paper cash benefit.
Amounts for this MOP can be entered as dollars and cents.
The “Tender amount required” parameter and the “Allowed
without sale” parameter should be disabled.

22 - Manual EBT CB: Manual non-paper cash benefit. Amounts
for this MOP can be entered as dollars and cents. This is
usually used with food stamp transactions performed with a
standalone EBT terminal. The “Tender amount required”
parameter and the “Allowed without sale” parameter should
be disabled.

Note: EBT Food Stamp and EBT Cash Benefit MOPs are
used when EBT is processed through
commander/Viper/EPS (e.g. WINCOR in case of Shell).
The primary FEP (or a separate FEP in future) on
Viper authorize the EBT transactions for POS.

When Commander/Viper/EPS (e.g. WINCOR in case of
Shell) does not process EBT transactions, the site will
process the transactions through a standalone EBT
terminal and then tender the transactions in VFI POS
using the Manual EBT CB or Manual FS MOPs. These
MOPs follow the same rules as their electronic
counterpart.

Unlike Credit/Debit, it is possible to enter an amount
for EBT transactions and request a specific amount
from the host for the EBT purchase. In case of FS (EBT
FS or Manual FS), POS validates that this amount
meets the food stamp eligible items in the
transaction.

23 - ECheck: Standalone electronic check processing. The
balance of the ticket amount is sent to the host for approval.

24 - Stored Value Card: Stored Value Card is a prepaid MOP.

25 - Manual Entry: With this MOP is selected, account
number is manually entered and is processed similar to
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credit cards.

26 - Force Post: This MOP is used for entering transactions
that were processed when the host was offline.

27 - Post Entry

28 - Mobile: Used for mobile payment. See the Mobile
payment feature document for more information.

29- Unattended Refund

30 - Non-Tax Coupon: Use for product coupons as MOPs. Tax
due may be reduced because of applying this coupon.

31 - Fuel_Voucher: Used for fuel vouchers (paper) only. The
parameter "Allow Change" should be disabled.

32 - Tax_Exempt_Voucher: When applied, the MOP will
reduce the amount due based on which taxes are configured
to be exempt. Multiple types of tax exemption can be
configured, and the appropriate prompts will be presented
to the cashier based on the configuration.

33 - Fleet_Check: Fleet Checks can be exchanged for cash or
be used as MOP in a transaction. The parameters “Allow
Without Sale”, “Allow Change” and “Allow Refund” should
be enabled.

Note: Refer to the Fleet Cards feature reference
documentation for information on this feature. The
Feature Reference is available on Premier Portal.

Min. Amount Enter the minimum amount accepted for this MOP (0.00 -
9999.99.

If MOP Code = Special Discount, the percentage discount is
entered here. For 10%, enter 10.00

Max. Amount Enter the maximum amount accepted for this MOP (0.00 -
9999.99).
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Enter the amount of this MOP that alerts the cashier to make
a safe drop (0.00 - 9999.99).

0.00 — This MOP does not require a safe drop.
Note: The setting for “Force Safe Drop” determines if a safe

drop reminder is displayed or if a safe drop is required once
the calculated drawer total for this MOP reaches this Limit.

#Additional
Receipts

If additional receipts are required for this MOP, select the
number of receipts.

Note: Force Ticket Print must be selected to make this
parameter available.

Tender Code

Used to assign the NACS tender code to Verifone MOPs. Helps
to create the NAXML POS Journal from the transaction log
without manually looking up or mapping the tenders. The
recommended value is the default values for each MOP.
Inorder to select a new value from the list or enter a new
value other than from the list, delete the default value first.

Tender Sub
Code

Used to assign the NACS tender sub code to Verifone MOPs.
Helps to create the NAXML POS Journal from the transaction
log without manually looking up or mapping the tenders. The
recommended value is the default values for each MOP.
Inorder to select a new value from the list or enter a new
value other than from the list, delete the default value first.

Force Safe Drop

Select (if the Limit value is not 0.00) to display a safe drop
message. A safe drop must occur before additional sales
transactions can be performed using that payment type.

Open Drawer on
Sale

Select to open the cash drawer when a transaction includes
this payment type.

Tender Amount
Required

Requires clerk to enter the amount before selecting this
MOP.

Cashier Report
Prompt

Prompts cashier to enter the actual (counted) drawer
amount for this MOP when printing cashier report.
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Allow Zero Allows zero entry response when entering actual (counted)
Entry drawer amount for this MOP when printing cashier report.
Allow Without Permits acceptance without purchase. Examples: Cashing in
Sale a winning lotto ticket or permitting a check to be cashed

without purchase.

Allow Refund

Permits Refund transaction to be tendered to this MOP.

Allow Change

Allows change from this MOP to be given to customer when
they present amount > amount due. Example: If checks can
be written for more than amount of purchase.

Allow Safe Drop

Allows a safe drop for this MOP.

Allow Money
Order Purchase

Permits purchase of money order with this MOP

Force Ticket
Print

Forces receipt to be printed for any transaction that includes
this MOP.

Reporting
MOP SALES
CARD BASED
CREDIT 2 50.76 Sample MOP
SALES and MOP
CASH CANCEL/REFUNDS
in Cashier
DOLLAR 18 165.90 |RePOrt:
ARGENTINA 1 7.87
MOP totals are
DRIVE OFF 1 50.00 represented in
Summary and
INHOUSE 1 10.00 Cashier
Reports.
PUMP TEST 1 1.00
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TOTAL MOP SALES 275.53
MOP CANCEL/REFUNDS

CASH 2 2.74

TOTAL MOP CANCEL/REFUNDS (2.74)

MOP SALES: Summary of sales by method of payment (MOP).

Note: If a foreign currency has been set up in the Currency File that
currency appears in the CASH section.

MOP CANCEL/REFUNDS: Summary of cancelled or refunded transactions. The
total is displayed in parentheses because the number is negative.

Troubleshooting

E1104 MOP INVALID/NOT | Used an MOP that no longer exists. Choose
ALLOWED another MOP.
E1116 AMOUNT TOO The dollar amount entered is larger than the
LARGE maximum allowed for this department or MOP.
NO SPLIT TENDER
E1118 ON FUEL Only one MOP allowed for fuel purchase.
E1120 DO NOT OVERRIDE | Cannot override the minimum or maximum
MOP AMOUNT allowable amount for an MOP.
Customer dispensed fuel at one MOP price level
E1130 MOP CONFLICT and attempted to pay with an MOP associated
with a different price level.
E1131 AMOUNT TOO The dollar amount entered is less than the
SMALL minimum set up for the MOP.
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SUB-TOTAL .
E1132 REQUIRED Must press [TOTAL] before choosing an MOP.
The amount of money in the drawer exceeds the
E1135 DROP MONEY FIRST | limit set in the MOP File function. Perform a Safe
Drop.
The dollar amount entered is not allowed by the
£1138 INVALID MOP selected MOP. This can occur if a dollar amount is
AMOUNT entered and credit selected because credit only
takes the balance of the sale.
MOP may not require an amount or the amount
E1139 :E'\:\IYI.'?EI}\!EDAMOUNT entered is less than the minimum or more than
t